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1 Introduction

1.1 About the Guide

This section provides a brief description of the scope, the audience, the references, the
organization of the user guide and conventions incorporated into the user guide. The topics in this
section are organized as follows:

Scope of the guide

Intended Audience

Documentation Accessibility

Access to Oracle Support

Related Information Sources

1.2 Scope of the Guide

The Oracle Financial Services Data Governance for European Central Reporting User Guide explains
the concepts of the Oracle Financial Services Data Governance for European Central Reporting
(DGECR) and provides step-by-step instructions for navigating through the application.

1.3 Intended Audience

Welcome to release 8.0.7.0.0 of the Oracle Financial Services Data Governance for European Central
Reporting User Guide. This manual is intended for the following audience:

Business Analysts and supervisors in financial institutions

1.4 Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program
website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

1.5 Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

1.6 Related Information Sources

For more information, refer to the following documents in OHC Documentation Library:

Oracle Financial Services Data Management Installation Manual Release 8.0.7.0.0 (QHC)

Oracle Financial Services Analytical Applications Reconciliation Framework User Guide, Release
8.0.7.0.0 (GHQ)

Oracle Financial Services Data Foundation Installation Guide 8.0.7.0.0 (OHC)

OFSAA DOCUMENT TITLE | 10


../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#scope
../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#audience
../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#doc_accessibility
../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#access_support
../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#Related_info_source
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
https://docs.oracle.com/cd/E93133_01/install.htm
https://docs.oracle.com/cd/E93133_01/homepage.htm
https://docs.oracle.com/cd/E92917_01/install.htm

e Oracle Financial Services Analytical Applications Infrastructure User Guide, Release 8.0.7.0.0
(OHCQO)Introduction to Oracle Financial Services Data Governance for European Central Reporting

This chapter provides a brief overview of the BCBS 239 Principles and Oracle Financial Services Data
Governance for European Central Reporting (DGECR).

This chapter includes the following topics:

e Basel Committee on Banking Supervision (BCBS) 239

e Oracle Financial Services Analytical Applications Solution for BCBS 239 Regulations

e Overview of Data Governance for European Central Reporting

e Important Features of Data Governance for European Central Reporting

1.7 Overview of the Basel Committee on Banking Supervision
(BCBS) 239

The Basel Committee on Banking Supervision (BCBS) 239: Principles for Effective Risk Data
Aggregation and Risk Reporting are also known as the 14 principles. These principles were developed
because many banks lack "the ability to aggregate risk exposures and identify concentrations quickly
and accurately at the bank group level, across business lines, and between legal entities." The BCBS
239 framework is intended to strengthen the risk data aggregation and reporting practices of the banks.
BCBS 239 is designed to drive more timely information and better strategic planning and reduce the
impact of losses.

1.8 Oracle Financial Services Analytical Applications Solution for
BCBS 239 Regulations

The Oracle Financial Services Analytics Applications (OFSAA) unified platform creates a foundation to
address the regulatory requirements and successful BCBS 239 compliance by providing a common
data infrastructure that:

e Builds a single source of truth

e Enables effective data usage

e Supports comprehensive and consolidated reporting
The following table describes the 14 principles of BCBS 239:

BCBS 239 Principles Answered by Respective OFSAA Components

BCBS 239 Principle Description OFSA Application Catering
to the Principle

BCBS Principle Category: Overarching Governance and Infrastructure
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Principle 1: Governance

Identification, assessment,
and management of data
quality risks to be a part of a
bank’s risk management
framework.

Risk data aggregation and
risk reporting practices must
be fully documented and
validated, extended to new
initiatives, unaffected by the
organization structure.

Awareness of the limitations
of full risk data aggregation.

This principle is addressed by
Data Quality Framework and
OFS Model Risk
Management.

Principle 2: Data Architecture
and IT Infrastructure

Integrated data taxonomies
and architecture across the
group.

Establish roles and
responsibilities to ensure
adequate controls.

This principle is addressed by
OFS Data Foundation, OFS
Analytical Applications
Infrastructure and OFS
Enterprise Modeling
Framework.

BCBS Principle Category: Risk Data Aggregation Capabilities

Principle 3: Accuracy and
Integrity

Ensure that the risk data
aggregation is accurate and
reliable with adequate
controls, data reconciliation,
and single source of data for
each risk type.

Documentation of risk data
aggregation process.

Establish escalation channels
and action plans.

This principle is addressed by
OFS Analytical Applications
Infrastructure, OFS
Enterprise Modeling
Framework, OFS
Reconciliation Framework,
OFS Data Foundation, and
OFS Operational Risk.

Principle 4: Completeness

Capture all material risk data
by the relevant dimensions.

Any exceptions to
completeness should be
identified and documented.

Consistent risk data
aggregation capabilities.

This principle is addressed by
OFS Data Foundation, OFS
Analytical Applications
Infrastructure, OFS
Enterprise Modeling
Framework, and all OFS
Applications.

Principle 5: Timeliness

Generate aggregated data as
per the desired frequency.

This principle is addressed by
OFS Analytical Applications
Infrastructure, OFS
Applications and Exadata
Benchmarks.

BCBS 239 Principle

Description

OFSA Application Catering
to the Principle
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Principle 6: Adaptability

Flexibility to meet ad-hoc
requests especially during
stress.

Incorporate changes related
to internal and external
business factors and
regulatory framework.

Generate sub-sets of data
based on specific
dimensions.

This principle is addressed by
all OFS Applications with
OFS Data Foundation, OFS
Analytical Applications
Infrastructure, OFS
Enterprise Modeling
Framework.

BCBS Principle Category: Risk Reporting Practices

Principle 7: Accuracy

Reports should be reconciled
with risk data, validations to
be applied to the output and
exception reports to be
displayed.

Establish the reliability of
approximations such as
output from models,
scenarios, and stress tests.

This principle is addressed by
all the standalone OFS BI
analytics applications, and
dashboards of all the OFS
applications.

Principle 8:
Comprehensiveness

Cover all material risks,
including credit, market,
operational and liquidity risks,
capital adequacy, stress
testing.

Exposure and position data,
concentrations, limits, risk
appetite.

This principle is addressed by
all the standalone OFS BI
analytics applications, and
dashboards of all the OFS
applications.

Principle 9: Clarity and
Usefulness

Reports should contain risk
data, analysis, interpretation
and qualitative information.

Customized to suit individual
requirements.

This principle is addressed by
all the standalone OFS BI
analytics application, and
dashboards of all the OFS
applications, and Oracle
Business Intelligence
Enterprise Edition (OBIEE).

Principle 10: Frequency

Produce reports at the
desired frequency.

Timely availability of reports
under stress conditions.

This principle is addressed by
all the OFS BI analytics
application, OFS applications
which compute metrics, and
OFS Enterprise Modeling
Framework.
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Principle 11: Distribution

Make reports available to
relevant stakeholders in a
timely manner while
maintaining confidentiality.

This principle is addressed by
all the standalone OFS BI
analytics application, and
dashboards of all the OFS
applications, and Oracle
Business Intelligence
Enterprise Edition (OBIEE).

BCBS Principle Category: Su

pervisory Review, Tools and Cooperation

BCBS 239 Principle

Description

OFSA Application Catering
to the Principle

Principle 12: Review

Supervisors should:

Review banks compliance
with principles 1 to 11.

Examine the results of
internal and external audits.

Test bank’s data aggregation
and reporting capabilities
under normal and stress
conditions.

This principle is addressed by
OFS Data Governance for
European Central Reporting.

Principle 13: Remedial
Actions and Supervisory
Measures

Use of multiple tools for:
Required remedial action
Increased scrutiny
Independent review
Capital add-ons

This principle is addressed by
OFS Data Governance for
European Central Reporting.

Principle 14: Home/Host
cooperation

Supervisors of relevant
jurisdictions should cooperate
with each other.

Information and experience
sharing through bilateral or
multilateral dialogue.

1.9 Overview of Data Governance for European Central Reporting

Data Governance for European Central Reporting (DGECR) operationalizes the data governance
process. The OFSAA DGECR enables financial institutions to map multiple data sources to a standard
common business glossary.

Additionally, DGECR enables you to:

Identify all critical data elements.

Track and monitor the data elements from their source to the eventual usage in reporting.

Manage Regulatory submissions.

Establish a governance process around the data elements and reporting process to offer greater
visibility and increased confidence in the organization for the board of directors and regulators.
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e Consolidate and collaborate across the enterprise providing a truly unified enterprise data
management process.

The content provided to DGECR helps the customer to have access to over 20,000 business terms and
definitions that form a part of the Metadata Glossary.

1.10 Important Features of Data Governance for European Central
Reporting
The following are the key features of DGECR:
e Provides a business glossary for standardization.

o Defines operational and quality controls on every data element and monitors the effectiveness of
controls.

e Monitors all key metrics, trends, and variances on data elements.
o Defines, maintains, and tracks regulatory report submissions.

e Completes data quality dashboards.
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2 Components of Data Governance for European Central
Reporting

The following are the components of DGECR:

Business Glossary: It maintains the business glossary for standardization along with the
Business Terms.

Critical Data Elements: It classifies the Business Terms as critical data elements with approval
and review workflows.

Controls: It defines the operational and quality controls on every data element and monitors the
effectiveness of the control.

Key Indicators: It monitors all the key metrics, trends of the metrics, variances, and so on for the
data elements.

Issues and Actions: It defines the issues and remediation action plans to resolve issues.

Process Monitoring: It defines, maintains, and tracks the regulatory report submissions which
includes all the runs required for the submission.

Metadata Report Extract: It enables you to view the complete lineage and relationship between
metadata.

Adjustment Framework: It defines the process of an automated application configuration in
cases where a Data Quality failure occurred at the staging level.
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3 DGECR Application and Common Functionalities

This chapter details how to log into the DGECR application and explains the common features that are
found across the modules of the DGECR application. It describes the organization of the user interface
and provides step-by-step instructions for navigating through the application.

To avoid repetition, the common functionalities used in different modules of DGECR are explained
under the Common Functionalities section, by taking the Glossary as an example.

This chapter has the following sections:
Logaing in to OFS DGECR Application

Common Functionalities

Data Governance for European Central Reporting Common Screen Elements

Managing Data Governance for European Central Reporting

3.1 Logging in to the DGECR Application

Once the application is installed and configured, you can access DGECR through the web browser.
1. Access the DGECR application by using the Log in credentials (User ID and password).

The built-in security system ensures that you are permitted to access the window and actions
based on the authorization only.

| ORACLE Financial Services Analytical Applications

Language US-English B
User ID

Password
Version 806.10

Copyright © 1993, 2018 Oracle andfor fts affiliates. All rights reserved

2. After logging into the application, the following window appears:
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= ORACLE Financial Services Analytical Applications

APPLICATIONS

Data Governance for
European Central
Reporting

Data Governance for European
Central Reporting

Financial Services
Analytical Applications
Reconciliation
Framework

Framework for General Ledger
Recongiliation

Financial Services Data
Foundation

Application for Finandial Services
Data Foundation

OB

Financial Services Data
Governance for US
Regulatory Reporting
Financial Services Data
Governance for US Regulatory
Reporting

US-English

OFSAD + B

Copyright © 1993, 2018 Oracle and/or its affiliates. Al rights reserved

3. Click the Data Governance for European Central Reporting option.

The DGECR window appears.

# Home —

Navigation List

Common Tasks

Data Governance for European Centra...

= ORACLE pata Governance for European Central Reporting

3.2 Common Functionalities

It is possible to modify, view, delete, and find dependencies of a Glossary, Control, Key Indicator, Issue,

and so on. The following sections explain how this is done by taking the example of a Glossary.

Note: To access the Glossary:

1. Onthe DGECR window, select Data Governance for European Central Reporting.

The Data Governance for European Central Reporting page appears.

2. Inthe upper-left corner of the page, select Standards & Policies, and then select Glossary.

The Glossary workspace appears.

3.2.1 Viewing a Glossary

You can view a Glossary at any given point. To view an existing Glossary, perform the following steps:

1. Inthe ID column, click the ID of the Glossary whose details you want to view.

The Glossary Details section appears, displaying the details of the selected Glossary.

3.2.2 Deleting a Glossary

To delete an existing Glossary, perform the following steps:
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1. Select the check box next to the Glossary name that you want to delete.

Delete icon.

In the tool bar, click the
A dialogue message appears, asking you to confirm deleting the record.
2. Click OK.

The Glossary record is deleted.

3.2.3 Exporting a Glossary

Refer to the section on Exporting Records for details.

3.2.4 Searching and Filtering

The Search and Filter section in the user interface helps you to find the required information. You can
enter the closest matching keywords to search and filter the results by ID and name in the ID and Name
fields. Refer to section Managing Search and List page for details.

3.3 Data Governance for European Central Reporting Common
Screen Elements

This section describes the common screen elements of DGECR.

The following tables lists the various icons and buttons in the DGECR user interface:

Icon/Button Name Description

This Icon displays at the top right corner of a
Help Help page. Click this button to display information
related to the page.

This button displays in all Search bars and
» Go Go performs the search function. Click this
button to search the selected search criteria.

Click this button to clear the search fields to

2 Clear Clear Search |~ °

When values displayed in the column of a
matrix is lengthy, only the first few
characters are displayed. Click this button to
wrap the text in all columns of a matrix.

Wrap

When values displayed in the columns of a
matrix are expanded, click this button to
display full details of the text in all columns
of a matrix.

|v|

Unwrap

\When values displayed in a particular
column or row are lengthy, only the first few
e Expand characters are displayed followed by the
Expand button, indicating that more text is
available. Click this button to expand the

OFSAA DOCUMENT TITLE | 19


../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/ofs_ug_dgs_8.0.htm#50556977_BABCJCHC
../../../../DM/DGS/DGR/nhdcruz/AppData/Roaming/Microsoft/Word/ofs_ug_dgs_8.0.htm#50556977_BABCJCHC

column or row for the complete text to view.

When values displayed in a particular
column or row are expanded, click the

Lﬁ]
Collapse Collapse button in that column or row to
contract the displayed text.
This button displays at the lower left corner
: . of the Details page. Click this button to view
View More View More additional details of a record such as
Documents, Workflow History, and so on.
B Hide Hide Click this button to hide additional details of
a record.
This button is present in some sections of
+ Expand the Details page. Click this button to expand
a section and display the fields.
Click this button to collapse a section, which
- Collapse is already expanded. All fields in the section
are hidden.
.~ Click this button to display the calendar. You
i Calendar can select a date from the calendar.
This button displays on actionable sections
of the Ul which do not display any pre-
) Clear Clear populated data. Click this button to clear the
data entered.
Save Draft Click this button to save a draft version of a
Save Draft record.
L add Add Click this button to add a new record.
Delete elete ick this button to delete record.
Delet Click this button to delet d
M pelink Delink Click this button to delink records.
(7 Edit Edit Click this button to edit the details of a
record.
Export Export Click this button to export a record.
Submit Submit Click this button to submit a record.
Cancel Cancel Click this button to cancel an action.
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H Approve

Click this button to approve a record.

B Reject

Click this button to reject a record.

B Link Link

Click this button to link records

Close Close

Click this button to close a page or window.

=] Difference

Click this button to view the difference

3.4 Managing OFSDGECR

This section describes how to manage the Oracle Financial Services Data Governance for European
Central Reporting application. This applies to users across all modules of the application. Some of the
functionalities may be specific to the rights owned by a user.

This section discusses the following topics:

Managing an Inbox

Managing the Issues & Actions Page

Managing the Details Page

3.4.1 Managing an Inbox

The Inbox page displays all the tasks and notifications of the logged in user. The task IDs are hyperlinks
that enable you to view the contents of the task or notification. You can click the task ID to view its
details and take action, if required.

This section covers following topics:

Searching for a Task in the Inbox

Reassigning Tasks

ORACLE' Data Governance for European Central Reporting

£ mbox standards & Policies Controls @ Key Indicators Process Monitoring

[l ssves & actions

OFSAD | Thursday, August 30,2018 @ oFssa (2 anout &l Logeut

& ~dmin

Inbox Help
B Search & Clear search oriteria | > Perform search
Task Name From Due Date < -
Entity Type > SelectAll ~  staws? Open -

| Tasks | Hotifications  Reassigned Tasks
B Tasks (17) =
#bs Reassign | [E unwrap 1013 2R
S| ] TaskiD  Task Name Entity Name Entity Type Entity Status Due Date Overdue By Status Received On  Completed On  Flag

[ 824 1336253-Acton Created BBL Action Adtion Not Applicable b Open ene2e

[[] 920  1336213-Task Created BBL Test Issue Not Applicable 321;5'0153'30 Open 321;5'01%'?

0O 8% 1334109-Action Created Esc CONTEST Action Not Applicable 321395'052'22 8 Open fgﬁ"ﬁlﬁg 9 |z

[ 897 1334065-Task Created Esc CONTRACT TEST Issue Not Applicable 321395'_0157'22 8 Open 331:;%%2 q

O 879 1025445-Action Created Esc Action0817 Action Not Applicable fgg“@’m 12 Open ngﬂ:’gE =

] srs 102536 Task Created ES—EW \Usgsﬁuaeﬁlﬁn Control Assessment | TS fgwgzr.nﬁsg—m P — 331253%103 a

B 867 1025344-Task Created ﬁjs,:1 ‘DS;;;AI; Control Assessment Issue Not Applicable 351231'255—15 12 Open 331;370135—105 q

[] sr7  1025359-TaskCreated ﬁfﬂ ‘Us;ﬁ“;ﬁ:; CEIRI SIS e Not Applicable 221;'“52'13 12 Open 331;3'"1:'!'3 q

B g9 1025347-Task Created ‘ED5,51 \Dsgssuaedlﬁn Control Assessment lssue Not Applicable 321;1—255-13 12 Open ig‘\;ﬁ-ﬁ:—éﬁ q

) 885 1025341-TaskCreated SN Mot Applicable DD P open SFEE q

£ ar3 1025353 TaskCreated ‘EDsi \nszsﬁuaesizn Control Assessment | Not Applicable sngeﬂr_nsaa—m I open 321;3701:—55 q

B 8 1025350-Task Created is_c1 \ﬂsqsﬁuqedlqn Control Assessment EEE Not Applicable 351731%37—1B 12 Open 33175;011—;B q .
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3411

There are four tabs in the Inbox of any user:

Open Tasks

This tab displays tasks received by the user which are yet to be completed.
Completed Tasks

This tab displays tasks which have been performed or completed by the user.
Notifications

This tab displays notifications sent to the user for information.

Reassigned Tasks

This tab displays tasks which were not performed by the actual receiver and are reassigned to a
different user.

Searching for a Task in the Inbox

The Inbox page allows you to filter the tasks and notifications that you want to view and analyze. This
search is based on limited set of search criteria and helps to retrieve the relevant tasks and notifications
of the Inbox.

To search the Inbox, perform the following steps:

w

Log in to OFSDGECR by using your credentials.
4. In the upper-left corner of the page, click Inbox.
The Inbox workspace appears with the Task tab displayed by default.
5. Inthe Search sub-section, click the (+) icon.
6. Enter a value in any of the fields.

The following table provides the list of the search criteria in the Search sub-section:

Fields Description Fields Description

Task Name Enter the name of the task.

From Enter the name of the user from which task was generated

Due Date Select a condition from the drop-down list with the following
options:

Select a date from the calendar.

Entity Type Refers to a specific module in Data Governance
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3.4.1.2

Status Select a status from the drop-down list:
Open
Completed

Click the T Perform search icon. The records meeting the criteria are displayed in the respective
tabs.

If no records match the search criteria, the following message appears: No records found for the
selected search criteria.

Reassigning Tasks

By using this feature you can reassign certain tasks to a different user that is mapped to the same role
as the logged in user.

To reassign a task, perform the following steps:

8.

10.

Log in to OFSDGECR.

The OFSDGECR home page appears.

In the upper-left corner of the page, click Inbox.

The Inbox workspace appears with the Task tab displayed by default.

Select the check box next to the task that you want to reassign and in the upper-left corner of the
Tasks sub-section, click the e Reassign jcop

The Reassign Task window appears.

|

@ 10.184.156.31:5020/0OF5AA800/s0lution/GRC/reassignTask.jsp?taskld=901&infodom=DMINFOS&Sc B ﬁ‘ =

Role DGS Issue Owner Re- Assign To* |E]

Click the E] icon.

The Hierarchy Browser window appears.

Select the appropriate user and click OK.

The Re-assign Task window appears.
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11. Click Submit.
A confirmation message appears notifying you that the operation was successful.
12. Click OK, and then click Back to return to the Inbox workspace.

The task has been moved to the Reassigned Tasks tab.

3.4.2 Managing the Issues & Actions Page

This section provides details about the components of the Search and List page, and describes how to
manage them.

This section includes the following topics:

e Components of the Issues & Actions

e Managing Pagination

e Exporting Records

3421 Components of the Issues & Actions Page

The Issues & Actions page displays the summary of all records and is sorted by the Last Modified
Date by default. It displays the total number of records, page number, and the total number of pages in
the search result.

The Issues & Actions page contains the following components:

OFsAD | Friday, August 24,2018 M orsis [ spowt S Logout

ORACLE’ Data Governance for European Central Reporting

3 mbox Standards & Policies Controls Qt Key Indicators Process Monitoring |i| Issues & Actions & Admin

Issues Help *
Search O clear ®Go
oY) Name @
Issue Category @ B Companent @ X Criticality @ B
Creator @ X Owner @
Target Date @ B BX Last Modified From ) B X Last Modified To ) BX
Status @
Issues (464)
[@ create ssue Delete Issue Close Issue = Reapen Issue Transfer Ownership & Bxport 7=
©» Name Component Issue Cateqory Actions Creator Owner TargetDate  Status Last Modified
1334311 TEST 1) Control Data Accuracy 22 1 OFSAD ) oFsaD 2/ 31-Aug-2018  Open 21-Aug-2018
5 CONTRACT TEST 12 Control Data Availability 2 1 OFSAD 2! ofsep (2) 30-Sep-2018  Open 21-Aug-2018
3 Issue in KI Assessment ID- 1333582 12 Key Indicators Data Authoriza... 22 O OFSAD =) oFsaD 22 27-Aug-2018 New 20-Aug-2018
Issue in KI Assessment ID- 1333589 ) Key Indicators Data Authoriza... 22 0 OFSAD &) oFsaD ) 27-Aug-2018 New 20-Aug-2018
Tssue in KI Assessment ID- 1333502 (22) Key Indicators Data Authoriza.. B2 O OFSAD &) oFsaD () 27-Aug-2018  New 20-Aug-2018

©Oracle. Al rights reserved

Masthead
The mast head appears at the top of the page and contains the application menus.
Navigation Path

The Issues section and the Actions section contain a navigation path to display the route taken to
reach the current page. Click any component of the navigation path to view the respective screen.

Issues == |ssue Details

Actions > Action Details

Search Bar
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This section allows you to search and view the details of records.
List Header

The header contains the title and displays the total number of records. The header also provides
pagination with forward and backward arrows for advancing page by page or to the first or last page.

Action Buttons

Action buttons are the tool bar buttons that enable you to perform various actions such as create,
delete, close, export, and so on. These buttons are enabled or disabled based on the access rights
provided to the user and the operations that can be performed on the selected record.

The actions buttons differ from module to module. Refer to the respective chapters for more detalils.
Check Boxes

Check boxes are provided at the beginning of each row in the Issues & Actions page. You can select
one or more check boxes depending upon the action you take.

Column Headings

Column headings provide labels that depict the kind of information displayed in the columns. The list of
records can be sorted from the column headings.

To sort the records, perform the following steps:
1. Navigate to the Issues & Actions page.
2. Right-click any column heading.

A list of sorting options are displayed.

+= Sort Ascending

+= Sort Descending

Clear Sort

4%

i Field Chooser

[E Transpose

3. Select the required sorting option.
The records are sorted as per the selected sorting option.

4. Right-click any column heading, and then select Clear Sort to clear the applied sorting option.

The following are the different sorting options:
Sort Ascending

On selecting this option, the records are sorted in ascending order if the data is numeric. In case of text,
the data is sorted in an alphabetical order. If the selected column is a date column, then the data is
sorted in a chronological order.

Sort Descending

On selecting this option, the records are sorted in descending order if the data is numeric. In case of
text , the data is sorted in reverse alphabetical order. If the selected column is a date column, then the
data is sorted in a reverse chronological order.

Clear Sort
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On selecting this option, the applied sorting is removed and the records are displayed in their original
order.

Group by Tree

On selecting this option, the records are listed in a tree structure under various values in the column.
You can click Close to close the grouping and view the normal List page.

The Group by Tree option is enabled only for columns which have predefined values from dim tables. They are not
enabled for columns for which the data is captured in the front end by the Business User. Also, these options are
not available for columns with distinct values like Name, Amount and so on.

Field Chooser

This option allows you to enable or disable fields in a grid. The changes made are applicable for future
sessions of the logged in user alone and can be modified whenever necessary.

To sort by Field Chooser, perform the following steps:
1. Right-click any column heading.
A list of sorting options are displayed.
2. Click Field Chooser.
The Field Chooser window appears where the columns displayed are selected by default.

" Ficld Chooser - Mozilla Firefox !@élg

(i) 10.184.156.31:5020/0F - O W

| ] AutoFit P
[l Columns Control Width
D E|:|
Compeanent 120
Issue. Category 130
TI| ' 1] |T )
(0].4 Cancel Save

3. Select the fields that you want to display.

You can increase or decrease the width of a column by modifying the Control Width value. To
change the position of the columns, select a column and click . or ¥ |

4. Click OK.
The Field Chooser window is closed and the selected columns are displayed.
Or
Click Save.
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3.4.2.2

3.4.2.3

The Field Chooser window is closed and the selected columns are displayed. The changes are
saved for the logged in user.

Transpose

This option allows you to convert columns into rows. On clicking this option, the column headings are
arranged vertically, the records are displayed horizontally, and the record details are displayed vertically
corresponding to each column. You can click Close to close the transposed view.

Managing Pagination

This feature helps manage a large number of records in a single grid. A limit is defined in each grid as to
how many records will be displayed at a time. If it is defined that only <x> number of records will be
displayed in a single page of the grid at a time, the rest of the records will be displayed in the
subsequent pages. These pages can be viewed by using pagination options.

Page 1 of19

Click to view the records on the next page.
Click to view the records on the previous page.

Click to view the records on the last page.

Click to return to the first page when you are on any other page.

Exporting Records

The Issues & Actions page allows you to export the listed records to a Microsoft Excel spreadsheet. If
any search criteria is applied, the values exported are restricted only to the search result.

To export the records, perform the following steps:

5. Navigate to the Issues & Actions page.

6. Click the & export icon.

The Export window appears.
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Export Details

Select Form Data/ Grid Data:  Form Data E|

— il
@ Export - Properties - Maozilla Firefox ' o]
_—

(7 10.184.156.31:5020/0FSAAS00/e % =

Include Mapper Information: [

Include Search Information :  [C]

Document Type :  Waord E|

Template : General Word TemplateE|

Display Form MName @ @ Yes () Mo

Export Cancel

7. Select the required options from the Export Details section.

Fields

Select Form Data/ Grid
Data

Description

Select Form Data or Grid Data from the drop-down list.

Include Mapper Information

Select this check box if you want to include mapper information in
the report.

Include Search Information

Select this check box if you want to include search information in the
report.

Document Type

Select Word, or Excel, or PDF from the drop-down list.

Template

Select General Word/Excel Template from the drop-down list.

Display Form Name

Select Yes if you want to display the form name or No if you do not
want to display the form name.

8. Click Export.

The Opening <FormExport.doc> window appears.
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Opening FormExport.doc “_—‘ I&

You have chosen to open:

Iﬂ-ﬂ FormExport.doc

which is: Microsoft Word 97 - 2003 Decurnent
from: http://10.184,156.31:5020

What should Firefox do with this file?

1 Save File

[ Do this automatically for files like this from now on.

e

9. Click Open with and then select OK.

M

A Word file/ Excel spreadsheet appears, which consists of a compiled list of all records.

3.4.3 Managing the Details Page

This section covers the components of the Details page, and describes how to manage them. The
details page components may vary from module to module.

This section includes the following topics:

e Components of the Details Page

e Managing Linkages

¢ Managing Documents

3.43.1 Components of the Details Page

The following sections describe the components found in the Details page:

3.43.11 Field and Data Types

The Details page of all modules has the following types of fields:
e Text Box: This is an alphanumeric free-text field with a restriction of 300 characters.

e Text Area: This is an alphanumeric free-text field with a restriction of 3000 characters. The
number of characters allowed for these fields appears in a box that is non-editable. The count is
updated based on the actual number of characters entered in the Text Area.

e Hierarchy Browser: Some fields are provided with a hierarchy browser button, which displays a
list of values in a hierarchical format. You can select the relevant value from the list.

e Drop-down List: Some fields are provided with a drop-down button, which displays a list of values.
You can select the relevant value from the list.
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3.4.3.1.2

3.43.1.3

e Radio Buttons: Radio buttons are provided for fields where the user must select from two or more
options.

o Numeric Fields: These fields allow only numeric data to be entered. The different types of
numeric fields include:

= Number Field - You can enter up to 20 digits.
=  Amount Field - You can enter up to 20 digits and 8 decimals
» Percentage Field - You can enter up to 3 digits

o Date: These fields are provided with a calendar button that allows you to select a date. If you click
the Calendar button, a calendar of the current month appears with the current date highlighted.

< August E|> £ 2018 E|)

Sun  Mon  Tue Wed Thu Fri Sat

3 & 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 o 25

26 27 28 29 30 31

Close

e Mandatory Data Fields: Mandatory fields are fields which capture data that must be entered by
the user. All data fields that are marked with a blue asterisk (*) are mandatory data fields. Only
when all of these fields have been completed, an entity can be submitted by the user for further
steps in the workflow. For example, the Owner field is mandatory for submitting a record.

o However, some fields are mandatory based on the data captured. If such fields are not captured,
an alert message displays, asking to capture the relevant fields.

Contextual Help

Contextual help is offered at every field level in the User Interface screen, by providing a brief
description about the specific field. You can click to view the contextual help text. Contextual help
available for that field appears in a box for a few seconds and closes automatically.

Issue Category f* Motn Armmenee
Classification of the Issue.

Criticality* €) Medium

Tool Tip

You can refer to the Tool Tip to identify a task or action button. The Tool Tip displays when you place
the cursor over a button. In case of a button, it specifies the purpose of the button.
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Issues >> |ssue Details

2 Close Issue (i@ Transfer Ownership I& Show Data

| Show Data

3.4.3.2 Managing Linkages

OFSDGECR allows you to link and delink records of different modules. Linking and delinking can be
performed through the Actions section in the Details tab. The entities which can be linked vary from
module to module.

The following is the process of linking a control to an Issue. The same process can be followed for
linking any record to any entities applicable to a particular module of OFSDGECR.

3.4.3.2.1 Linking Records
To link a record to another record, perform the following steps:
1. Navigate to the Issues & Actions page of a module.
2. Inthe Issues section, in the ID column, select the required record.
The Details section appears.
3. Click the View More sub section.

The Actions sub section appears.

B Hide
Actions (1) & create Action Delete Action EHLink [Dpelink =
= D Name Owned  Criticality Activities  Owner Start Date Target Date Progress  Status Actual Cost Last Modified Date
1334422 TESTL ) Ves Medium [} OFSAD (2] 21-Aug-2018  30-Aug-2018 Open 21-Aug-2018
. BOd Link |
Select the check box next to the record that you want to link, and then select the icon.

The Search page appears.

4. Select one or more records from the list. You can also search the records by entering search
criteria in the search fields.

5. Click Link.
The message appears confirming that the records have been successfully linked.
6. Click OK.

The linked record is removed from the list.
7. Click Back to return to the Actions sub-section.

The linked record appears in the Actions sub-section.

3.4.3.2.2 Delinking Records
To delink a record, perform the following steps:
1. Navigate to the Issues & Actions page of a module.

2. Inthe Issues section, in the ID column, select the required record.
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The Details section appears.
3. Click the View More sub section.

The Actions sub section appears.

B Hide

Actions (1) @create Action  Delete Action  EMLink [ Delink =

E 1} Name Owned  Criticality ~ Activities  Owner Start Date Target Date  Progress Status Actual Cost  Last Modified Date

1334422 TESTL @) Yes Medium 9 OFSAD () 21-Aug2018  30-Aug-2018 Open 21-Aug-2018

; CDeli
Select the check box next to the record that you want to link, and then select the D

A message appears, asking you to confirm if you are sure that you want to de-link the records.
4. Click OK.
A message appears, confirming that the delink operation was successful.

5. Click OK. The record is removed from the Linkages section.

3.4.3.3 Managing Documents

This section covers following topics:

e Attaching a Document

e Deleting a Document

The Details page allows you to attach or delete documents related to the module. You can attach
documents in the following formats:

e Microsoft Word
e Microsoft Excel
e PDF

e Text

34331 Attaching a Document

To attach a document, perform the following steps:
1. Navigate to the Details section.
2. Click View More.
The Documents sub-section appears.
3. Click Attach Document(s).

The Attach Documents window appears.
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3.43.3.2

@ Attach Documents - Mozilla Fi E=SEEREC)

|GJ' 10.184.156.31:5020,/0F5AAB00/formsFramework/formsrenderer,/V RN ’i:r| =

-

Component” @) Issues

m

Type* @

Logical File Name | |

Choose a file* .
“ Browse... | No file selected. | @ Afttach File

' 1 b

4. Enter the required details in the Attach Documents window. The following table describes the
fields in the Attach Documents window:

Fields Description

Component Displays the component name for which the document is uploaded. This
is a non-editable field.

Type Select the type of file from the following options in the drop-down list:
Regulation

Policy

Documentation

Annexures

Logical File Name | Enter the Logical File Name. It is a text field which supports alpha-
numeric characters.

5. Click Browse to choose a file from your computer.

Click Attach File.

A message appears, confirming that the operation to attach a document was successful.
7. Click OK.

The document is attached and listed in the Documents sub-section.

Deleting a Document

The attached documents can be deleted. You can delete a document only if you have uploaded it.
Documents attached by one user cannot be deleted by others.

To delete a document, perform the following steps:
Navigate to the Details section.
2. Click View More.
The Documents sub-section appears.

3. Select the check box next to the document that you want to delete.
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Delete Document
The icon is enabled.

) Delete Document
Click the icon.

A message appears, asking you to confirm that you want to delete the selected record.
Click OK.

A message appears, confirming that the delete operation was successful.

Click OK.

The document is removed from the Documents section.
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4  Obtaining the Business Glossary

This chapter explains the process of obtaining the business glossary.
This chapter includes the following topics:

e About Business Glossary

e User Roles and Actions

e Business Glossary Workflow

e Creating a Business Glossary

e Importing a Business Glossary from Standard Glossary Providers

4.1 About the Business Glossary

The business glossary is a collection of business terms that provide definitions for common
terminologies and acronyms in business processes, accounting, finance, risk management and other
aspects of a financial organization. Primarily, a business glossary minimizes the misunderstanding and
confusion of business terminology and communications.

The benefits of a business glossary are:

e |t maximizes the understanding of the core business concepts and terminology of the
organization.

e It minimizes the misuse of data due to inaccurate understanding of the business concepts and
terms.

e It maximizes the accuracy of the results obtained as a result of search for business concepts, and
associated knowledge.

The OFSAA business glossary of comprises its entire ecosystem spanning risk, compliance,
performance and customer insight. It permits import and housing of other business glossaries into
OFSAA and also allows mapping of organization specific or industry standard glossaries to standard
OFSAA glossary.

The BIRD glossary is an initiative for European Banks. The BIRD glossary is not a regulation and
compliance to it is voluntary. The BIRD glossary enables banks to share granular data to regulators.
The regulators can use this data for producing various regulatory and compliance reports. The BIRD
glossary is mapped against OFSAA to enable OFSAA users of the FSDF data model to use business
terminology.

4.2 User Roles and Actions

All the users are required to be mapped to DGS EBA AUTHORIZER GROUP, DGS EBA
ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP, along with their respective individual
groups.

Following are the user roles and actions for the Glossary:

e Glossary Viewer: Permits the user to view the glossary. The user needs to be mapped to the
GLMVIEWERGRP group.

e Glossary Creator: Permits the user to create and maintain glossary objects. The user needs to
be mapped to the GLMCREATEGRP group.
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../../../nhdcruz/AppData/Roaming/Microsoft/Word/OFSDGS_V8.0.1.0.0%20User%20Guide.doc#About_business_glossary
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e Glossary Owner: A user with this role has all the permissions/rights that a creator has to his
specific glossary. The user is responsible for the glossary of the organization. Additionally, a user
with this role receives all the important ongoing notifications, emails, and so on regarding that
glossary. The user needs to be mapped to the GLMOWNERGRP group.

e Glossary Approver: Permits the user to approve/reject glossary objects. The user needs to be
mapped to the GLMAPPRGRP group.

4.3 Business Glossary Workflow

Mew glossary

l

Saved as draft

|

Pending approval

|

Active glossary

4.4 Creating a Business Glossary

While defining a Glossary, the fields that are displayed are explained in the Fields and their
Descriptions section.

You should have the Glossary Creator or Glossary Owner rights to create a glossary.

4.4.1 Fields and their Descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory

D Identification number assigned to the glossary. (auto-
generated).

Glossary Name Name of the glossary.

Glossary Definition A brief description of the glossary.

4.4.2 Procedure to Create a Glossary

To create a glossary, perform the following steps:
1. Inthe Standards and Policies tab, navigate to the Glossary menu.

The Glossary section appears.

s add

2. Click the icon.
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The Glossary Details page appears.

OFSAD | Friday, August 24,2018 @ OFsas

ORACLE’ Data Governance for European Central Reporting

4 mbox Standards & Palicies Controls Q{ Key Indicators Process Monitoring |-| Issues & Actions ‘ Admin

Glossary >> Glossary Detaile

Clossary Details
save Draft [ Cancel

Glossary Name p- 1335102

Glossary Definition

sbout 8l Logout

Hep  ©

Enter the glossary name and definition in the Glossary Name and Glossary Definition the

fields.
The status of the glossary is New.
Click Save Draft.

The status of the Glossary changes to Draft and a confirmation messages appears, confirming

that the operation was successful.

Click OK.

Click Edit to review and update the fields, and then click Submit.

A confirmation message appears, confirming that the update operation was successful.
Click OK.

The glossary is created and the Glossary status changes from Draft to Pending Approval.

4.5 Approving a Glossary

You should have Glossary Approver rights to approve/reject a glossary.

To approve a Glossary, perform the following steps:

1.

Navigate to the Glossary Details section.

The status of the Glossary appears as Pending Approval.

In the Reason for Approval/Rejection field, provide a reason.

Click Approve.

A confirmation message appears, confirming that the update operation was successful.

Click OK. The status of the Glossary changes to Active.

4.6 Rejecting a Glossary

You should have Glossary Approver rights to approve/reject a glossary.

1.

2
3
4,
5

To reject a Glossary, perform the following steps:

Navigate to the Glossary Details section.

The status of the Glossary appears as Pending Approval.

In the Reason for Approval/Rejection field, provide a reason.
Click Reject.
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6. A confirmation message appears, confirming that the update operation was successful.
7. Click OK.
8. The status of the glossary changes to Draft.

4.7 Exporting a Glossary

To export a Glossary, perform the following steps:
1. Navigate to the Glossary menu.

2. Select the check box next to the glossary that you want to export.

Click the EXport jeon to export the glossary.

The Export window appears.

@ Export - Properties - I'».-'In:::zillaLW_I e
G7 10.184.156.31:5020/0FSAAB00/: - @ & =
Export Details
Select Form Data/ Grid Data:  Form Data E|

Include Mapper Information ;[

Include Search Information :  [C]

B Document Type :  Waord E|
| Template : General Word TemplatEB
| Display Form Mame @ @ Yes () Mo

Export Cancel

In the Select Form Data/Grid Data drop-down list, select either Grid Data or Form Data.

4. Select the Include Mapper Information check box if you want to include information about the
Mapper.

5. Select the Include Search Information check box if you want to include search information.

6. Inthe Document Type drop-down list, select the document type as Word or Excel or PDF.

7. Inthe Template drop-down list, select the template type.

8. Inthe Display Form Name field, select, ‘Yes’ if you want to display a form name.

9. Click Export.

The Opening <FormExport.doc> window appears.
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You have chosen to open:

@ FormExport.doc

which is: Microsoft Word 97 - 2003 Decurnent
from: http://10.184,156.31:5020

What should Firefox do with this file?

R ——— o

i) Sawve File

Do this automatically for files like this from now on.

oK || — |

10. Click Open with and then select OK.
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5 Mapping the Business Terms
This chapter explains Business Terms and the process of mapping these Business Terms.
This chapter includes the following topics:

e About Business Terms

e User Roles and Actions

e Business Terms Workflow

e Creating a Business Term

e Usage term
e Mapping Business Terms

5.1 About Business Terms

Business terms are individual terms present in a glossary. It includes a definition and several attributes
that provide a complete description of the glossary.

Additionally, Business Terms provide associated knowledge, such as the user responsible for the term,
the associated metrics, correct usage of the term, related terms, list of possible values for the term, and
so on. OFSAA Glossary includes all the terms related to risk, performance, compliance, and insight pre-
packaged with all the relevant information in them.

Inbox  Standards & Policies  Controls  Key Indicators  Process Monitoring  Issues & Actions  Admin
Business Term Help
Activ
[ Business Term Term Usage
Name™* Mitigant Code ID" 994453

Definition The unique identifier of the mitigant. Mitigant is defined as an insirument that is used to negate the risk that arises due fo an
exposure with a counterparty. A mitigant can be collaterals like real estate property or other assets or personal or bank
guarantees or credit dervatives that a borrower offers a lender to secure a loan. If the borrower stops making the promised loan
payments, the lender can repossess of invoke the mitigant (o recover its losses. Because mitigant offers some security 1o the
lender in case the borrower fails to pay back the loan, loans that are secured by mitigant typically have lower interest rates than
unsecured loans. A lender’s claim to a borrower's mitigant is called a lien

Glossary” OFSAA Glossary

Annotate
Keywords

Subject Area* Collateral
Source* Internal Critical Data Element Yes

Domain* Code_Alphanumeric_Long

B Related Business Items[TLink | Delink

D Name Glossary

No Data Found
® Oracle. All rights reserve

5.2 User Roles and Actions

All users are required to be mapped to the DGS EBA AUTHORIZER GROUP, DGS EBA
ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP groups along with their respective
groups.

The following are the user roles and actions for Business Terms:

e Business Term Viewer: Permits the user to view the Business Terms. The user needs to be
mapped to the GLTVIEWERGRP group.

OFSAA DOCUMENT TITLE | 40



e Business Term Creator: Permits the user to create and maintain Business Terms. The user
needs to be mapped to the GLTCREATEGRP group.

e Business Term Owner: A user with this role has all the permissions/rights that a creator has to
his specific glossary. The user is responsible for the glossary of the organization. Additionally, a
user with this role receives all the important ongoing notifications, emails, and so on regarding
that glossary. The user needs to be mapped to the GLTOWNERGRP group.

e Business Term Approver: Permits the user to approve/reject Business Terms. The user needs
to be mapped to the GLTAPPRGRP group.

5.3 Business Terms Workflow

Mew Business Term

l

Saved as draft

|

Pending approval

|

Active Business Term

5.4 Creating a Business Term

The fields that are displayed while defining a Business Term are explained in the following table.

You should have Business Term Creator or Business Term Owner rights to create a glossary.

5.4.1 Fields and their descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory

D The identification number is automatically assigned to the
glossary term.

Name The name of the Business Term.

Definition A brief description of the Business Term.

Glossary Select a Glossary from the drop-down box.

Annotate PrO\_/ide a reference text for additional information on
Business Term.

Keywords Provide the keywords used to search the Business Term.

Subject Area Select a subject area from the drop-down box.

Source Select whether the source is Internal or External.

OFSAA DOCUMENT TITLE | 41



Fields Description

Fields marked in blue asterisk(*) are mandatory

Domain Select a the domain is Alphanumeric, Date or Numeric.

Critical Data Element ﬁgtlect whether the glossary term is a critical data element or

5.4.2 Creating a Business Term

1. Perform the following steps to create a Business Term:
2. Navigate to the Business Terms menu in the Standards and Policies tab.

3. Click Add. The Business Term page is displayed. The status of the Business Term is New.

. . OFSAD | Monday, August27, 2018 S orsas (B anout 8l Logout
ORACLE' Data Governance for European Central Reporting
9 mmbox Standards & Policies Controls 0* Key Indicators Process Monitoring |-| Issues & Actions ‘ Admin
Business Terms: Help
Search and Filter o 'O clear
1oY7) Term @
Subject Area @ B status @
Glossary @ B
Business Terms (8233) [gadq Delete B Export 5 Export to POF
E o} Term Critical Data Element  Subject Area Domain Source Status. Glossary
[ a72003 Zero Percent Risk Weiaht Flaa & Yes Account Flag Internal Active OFSAA Glossary
[ 472404 Prababilft of Default G ves Account Percent_Long Internal Adtive OFSAA Glossary
[ a72445 Loss Given Defautt 3 ves Account percent Long Internal Active OFSAA Glossary
£l 472405 Risk Weiahted Asset - Unexoected Loss B Ves Account Amount Internal Adtive OFsAA Glossary
R . OFSAD | Monday, August 27,2018 # OFsas about 8 Logout]
ORACLE" Data Governance for European Central Reporting
9 inbox Standards & Policies Controls OQ Key Indicators Process Monitoring |-| Issues & Actions ‘ Admin
Business Terms > Business Term Help
Status: Hew
BusinessTerm | TermUsage
Fsavenraft [ cancel =
Name* D 1335115
Definition
Glossary” -
Annotate
Keywords

5. Enter the required information in the fields.
Click Save Draft.

A confirmation message appears confirming that the operation of adding a businessterm was
successful.
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7. Click OK.

The status of the Business Term changes to Draft and the Related Business Items and List of
Values sub-sections appear.

8. Inthe Related Business Items sub-section, you can view the related Business Terms, and link
or delink the terms.

9. Inthe List of Values sub-section, you can select the list of values, and add or delete the values.

Additionally, in the upper-left corner in the Business Term tab, click the Edit icon to review

and update the fields.

Submit
10. In the upper-left corner in the Business Term tab, click the icon.
A confirmation message appears, confirming that the operation of updating the fields was
successful.
11. Click OK.

The Business Term is created and the state changes from Draft to Pending Approval.

5.5 Approving or Rejecting a Business Term

You should have Business Term Approver rights to approve/reject a Business Term.
To approve a Business term, perform the following steps:
1. Click the Standards and Policies menu and then click Business Terms.

2. The Business Terms workspace appears.

OFSAD | Monday, August27,2018 B orsas B avout 8 Logout

ORACLE' Data Governance for European Central Reporting

B mnbox Standards & Policies Contrals Q Key Indicators Pracess Monitoring |i| Issues & Actions 5 Admin
Business Terms Help
Search and Filter ® o Clear
D Term

Subject Area B status

Glossary B
Business Terms (8233) Wadd ' Delete EEwport [ Export to PDF

D Term Critical Data Element  Subject Area Domain Source Status Glossary

472443 Zero Percent Risk Weiaht Flaa 2 Ves Account Flag Internal Active OFSAA Glossarv

472484 Probability of Default & Yes Account Percent Long Internal Active OFSAA Glossany

472445 Loss Given Default ) Yes Account Percent Long Internal Active OFSAA Glossary

472406 Risk Weiahted Asset - Unexpected Loss @& Yes Account Amount Internal Active OFSAA Glossarv

In the Search and Filter sub-section, search the required business term.
4. Inthe ID column, select the ID link of the business term.

The Business Term section appears with the Business Term tab open by default.

In the Reason for Approval/Rejection field, provide a reason.
6. Click either Approve or Reject.

A confirmation message appears, confirming that the update operation was successful.
7. Click OK.

If you have approved the Business Term, the state of the Business Term changes to Active. If
you have rejected the Business Term, the state of the Business Term changes to Draft.
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5.6 Exporting a Business Term

To export a Business Term, perform the following steps:

1.

Click the Standards and Policies menu and then click Business Terms.

The Business Terms workspace appears.

ORACLE' Data Governance for European Central Reporting

9 tnbox Standards & Policies Controls qe Key Indicators Process Monitoring |-| Issues & Actions & Admin
Business Terms

Search and Filter 6o O Clear

oY) Term @
Subject Area @ status @
Glossary @ B
Business Terms (8233) [@add  pelete [Mexport 2 export to PDF
& D Term Critical Data Element  Subject Area Domain
O 272003 Zero Percent Risk Weiaht Flaa @) Yes Account Flag
[ 472428 Probabilite of Default @ ves Account Percent_Long
O az2415 Loss Given Default @) Ves Account Percent_Long
O 472426 Risk Weiahted Asset - Unexpected Loss ) ves Account Amount

OFSAD | Monday, August27, 2018 OfFsas about 8l Logout

Source Status

Internal Active

Internal Active

Internal Active

Internal Active

Help

Glossary

OFSAA Glossary.
OFSAA Glossary
OFSAA Glossary

OFSAA Glossary

Click the Expcr‘t icon.

The Export window appears.

—
Q Export - Properties - Mozilla Firefox

Export Details
Select Form Data/ Grid Data:  Form Data

Include Mapper Information @[]

Include Search Information: [

Document Type :  Word

Display Form Mame : @ Yes () Mo

Export Cancel

e

n Template :  General Word TemplateB

N

In the Select Form Data/Grid Data drop-down list, select either Grid Data or Form Data.

Select the Include Mapper Information check box if you want to include information about the

Mapper.

Select the Include Search Information check box if you want to include search information.

In the Document Type drop-down list, select the document type as Word or Excel or PDF.

In the Template drop-down list, select the template type.
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8. Inthe Display Form Name field, select, ‘Yes’ if you want to display a form name.
9. Click Export.

The Opening <FormExport.doc> window appears.

You have chosen to open:

¥ FormExport.dec

which is: Microsoft Word 97 - 2002 Docurnent
from: http://10.184.156.31:5020

What should Firefox do with this file?

i) Save File

[ Do this automatically for files like this from now on.

o | [oma ]

e g

| S

10. Click Open with and then select OK.

5.7 Usage Term

The definition of Business Terms is generally designed to produce a common understanding of the
meaning of the term for the entire organization irrespective of the business function. These are standard
definitions and do not really define the usage of the term in a specific context.

The Usage Term of Business Terms explains the terminology in the context of its usage. A terminology
can have one or more usage terms based on the number of use cases that it is applicable for in the
organization. Each usage of that particular term has its own explanation of how and why it is used,
along with the list of values for that specific context.

The BIRD and the OFSAA business glossary provides a standard and complete Usage Term for each
Business Term.

5.7.1 Creating a Usage Term

The user can only create a Usage Term for Business Terms that are in the Draft stage.

While defining a Usage Term, the fields that are displayed are explained as tabulated.

5.71.1 Fields and their Descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory
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Fields Description

Fields marked in blue asterisk(*) are mandatory

Context Name Related to other glossary identifiers (multiple contextual
definitions for the glossary term).

Context Definition Contextual definition of the glossary term from perspective
of source or application.

Usage Term Name The name of the context in which the term is used.

Business Term ID A system generated number.

5.7.1.2 Creating a Usage Term

1.
2.

10.
11.

12.

Perform the following steps to add a Usage Term:
Click the Standards and Policies menu and then click Business Terms.

The Business Terms workspace appears.

ORACLE' Data Governance for European Central Reporting

A mbox Standlards & Policies Contrals Q< Key Indicators Pracess Monitoring |i| Issues & Actions & Admin
Business Terms

Search and Filter ®Go 'O clear

D@ Term @
Subject Area @ B status @
Glossary @ B

Business Terms (8233) 7§ pdd pelete B export A export to POF

& |p Term Critical Data Element  Subject Area Domain Source Status Glossary
[0 a72043 Zero Percent Risk Weiaht Flaa &) ves Account Flag Internal Active OFsAA Glossary
O a72004 Probabilitv of Default &) ves Account Percent Long Internal Adtive OFSAA Glossary
[0 472805 Loss Given Default &) ves Account Percent_Long Internal Active OFSAA Glossary

[0 472008 Risk Weiahted Asset - Unexoected Loss (3 Yes Account Amount Internal Adtive OFSAA Glossary

OFSAD | Monday, August27,2018  #horsan (B vout Bl Logout

Help

In the Search and Filter sub-section, search the required business term.
In the ID column, select the ID link of the business term.
The Business Term section appears with the Business Term tab open by default.

Click the Term Usage tab.

% Add icon.

In the Usage Term sub-section, click the
The Contextual Definition window appears.
In the Usage Term Name field, enter the name of the usage term.

In the Context Name field, enter the name of the context name.

In the Context Definition field, enter a definition for the context.

Additionally, in the List of Values sub-section, you can also Add, Save, or Delete.

Click Save.

A confirmation appears, confirming that the operation to add a usage term was successful.

Click OK.

You can view the newly created Usage Term in the Search and List page.
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5.8 Mapping Business Terms

This process involves mapping a term from one glossary to another glossary. Terms in one glossary are
mapped to similar, or related terms in another glossary to achieve consistency and standardization.
While organizations use their own terminology, it is essential for them to map their terminologies to
industry standard terminologies. This ensures completeness and consistentency in communication with
external parties and regulators.

Following are the steps to map business terms with other business terms:

1. Select a business term that is in draft status.

B Link

2. Inthe Related Business Term sub-section, click the

The Related Glossary Map window appears.

Q Related Glessary Map - Mozilla Firefox _

G 10.184.156.31:5020/0FSAAB00/formsFramework/formsrenderer/MapRenderer.jsp

Q search 2 Clear
PO
Status @

Glossary @

|
| Glossary Terms (8235)

£ D Name
[ 472528 Total Liauid ...
O 472529 Eauity Marke...
O 472530 Eauitv Marke...
| [ 472531 Option Mark..
| O azas3 Ontion Mark..

icon.

Subject Area
22) Account
2 Account
2 Account
22l Account

22 Account

(E9)
9]
(9]
9]
(9]

—— — —— . — . |- | 2 ]|

Name @

Subject Area @

Glossary Definition

Indicates the total liauid assets in this accou..

Indicates the total market value of all lona e...

Indicates the total market value of all short ...

Indicates the total market value of all lona o...

Indicates the total market value of all short ...

E

E

E

E

E

Last Assessed

Status

Active

Active

Active

Active

Active

- O % =

m

Glossary

OFSAA Gloss..
OFSAA Gloss..
OFSAA Gloss..
OFSAA Gloss..

OFSAA Gloss..

m

3. Select the checkbox next to the required glossary items and then click Link.

A confirmation message appears, confirming that the operation was successful.
4. Click OK and then click Close.

5.9 List of Values

The List of Values sub-section enables the user to add values to the corresponding Business Term.

Perform the following steps to add a value:

1. Select a business term that is in draft status.

& add.

In the List of Values sub-section, click the icon.

The Add List of Values window appears.
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Add List of Values - Mozilla Firefox —pl=! X

@ 10.184.156.31:5020/0OFSAAB00 formsFramework/formsrenderer/MapRenderer.jsp ERN ﬁ

Business Term ID: 1335132

List Of Value™

Save Close

In the List of Value* field, enter a value, and then click Save.

A confirmation message appears, confirming that the operation was successful.
Click OK, and then click Close.

The newly added value is now appears in the List of Values sub-section.
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6 Identifying the Critical Data Elements

This chapter explains the process of identifying the critical data elements. It includes the following

topics:

e About Critical Data Elements

e User Roles and Actions

e  Workflow of Critical Data Elements

e Creating Critical Data Elements

6.1 About Critical Data Elements

Critical Data Elements are Business Terms that are critical for a specific business process. These terms
and their values are vital and significant for specific processes, for example, regulatory reporting or

management reporting.

These data elements are marked critical as per their context, justification, level of criticality, and
approval for the classification. They are ensured to have additional rigor in their data quality checks,
controls, and so on and have sufficient metrics around it to ensure timeliness and accuracy of the

values.

Critical Data Elements (CDESs) are defined for each report in Regulatory Repoting. DGECR will contain
all CDEs for a particular report. The list of Critical Data Elements are identified for a particular report and
the level of criticality will be defined and is stored in the FSI_GL_CDE_DETAILS table. These elements
are monitored for accuracy and consistency of data within the Key Indicator and Control section.

ORACLE' Data Governance for EBA Regulatory Reporting

Inbox Standards & Policies  Controls  Key Indicators  Process Monitoring
Critical Data Element

El Search and Filter ©>Go | 4 Clear

Issues & Actions

Admin

OFSAD | Thursday, August10,2017 i OFSAA

[E About & Logout

Help

CDEID

Business Term

B critical Data Element (340) |TgAdd | Delete |[&]Export

CDE Name
Status

1714

>I»

D CDE Name Business Term
Forbearance Status Code

Basel Credit Rating Basel Credit Rating
Lendable Value Amount
Outflow Adjustment Amount
Regulatory Product Type Le... ()
Total Priority Claim Amount

Source Currency

Maximum Value Guarantee . ()
Issuer Financial Enity Flag

CCR Exposures Add On Am... ()
Operational Loss Floor Amount

Standard Sequential IRB Flag

Standard Accounting Head |... (3]

275042 Realized Gain Or Loss Amo.

Access Level
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential
Confidential

Confidential

Data Classification Level
Financial
Financial
Financial
Financial
Financial
Financial
Financial
Financial
Financial
Financial
Financial
Financial
Financial

Financial

Draft
Dratt
Drat
Drait
Draft
Draft
Dratt
Drait
Draft
Draft
Dratt
Drait
Drait
Draft

status

Created Date
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016

Created By
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD

Last Modified Date
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016
05-05-2016

Last Modified By
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD
OFSAD

6.2 User Roles and Actions

All the users are required to be mapped to the DGS EBA AUTHORIZER GROUP, DGS EBA
ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP groups, along with their respective

following groups.

The following are the user roles and actions for critical data elements:

e Critical Data Elements Viewer: Permits the user to view the critical data elements. The user
needs to be mapped to the CDEVIEWERGRP group.
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e Critical Data Elements Creator: The user is responsible for the classification and maintenance
of critical data elements. The user needs to be mapped to the CDECREATEGRP group.

e Critical Data Elements Approver: The user is responsible for the approval and rejection of
critical data elements. The user needs to be mapped to the CDEAPPRGRP group.

e Critical Data Elements Owner: A user with this role has all the permissions/rights that a creator
has to his specific critical data elements. The user is responsible for the critical data elements of
the organization. Additionally, a user with this role receives all important ongoing notifications,
emails, and so on regarding those critical data elements. The user needs to be mapped to the
CDEOWNERGRP group.

6.3 Workflow of Critical Data Elements

Mew Critical Data Element

l

Saved as draft

|

Pending approval

|

Active Critical Data Element

6.4 Creating a Critical Data Element (CDE)

While defining a CDE, the fields that are displayed are explained as tabulated.
You should have CDE Creator rights to create a CDE.

6.4.1 Fields and their descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory

The identification number automatically assigned to the
CDE

CDE Name* Provide a name for the CDE

ID*

Select the access level from the drop-down list:
Public

Confidential

Restricted

Access Level*
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Fields Description

Fields marked in blue asterisk(*) are mandatory

Select the data classification level from the drop-down list:
Legal

Data Classification Level* Financial

PHI

Pl

Select a Business Term from the Hierarchy Browser

Business Term* )
window.

Provide a justification for classifying the Business Term as a

e
Justification CDE

Fields Description

Fields marked in blue asterisk(*)
are mandatory

The Entity Name and Attribute Name can only be added if a CDE is in a Draft state.

6.4.2 Creating a Critical Data Element

Perform the following steps to create a CDE:
1. Click the Standards and Policies menu and then click Critical Data Element.

2. The Critical Data Element Details page appears.

OFSAD | Monday, August 27,2018 @ oFsar [ sbout & Logout

ORACLE" Data Governance for European Central Reporting

9 mbox Standards & Policies Controls Qe Key Indicators Process Monitoring |i| Issues & Actions & Admin
Critical Data Element Help

Search and Filter ®Go 'O clear

COED @ CDE Name @)

Business Term @) Status @)

Critical Data Element (793) [ add Delete [ export

& D CDE Name Business Term Access Level Data Classification Level Status Created Date v Created By Last Modified Date Last Modified By
[ as0683 CREDIT STATUS DATE [£3) Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
[0 ss0684 EFFECTIVE MATURITY DATE (). Effective Maturity Date ) Confidential Financial Active 05-05-2016 OFsAD 05-05-2016 OFsAD
[ 180685 EFFECTIVE FROM DATE [=3) Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
[ 180686 EFFECTIVE TO DATE [=3) Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFsAD
[0 ss0687 END OF INTEREST ONLY P... (2] Confidential Financial Active 05-05-2016 OFsAD 05-05-2016 OFsAD
[0 180604 HEDGE INDICATOR [=3) Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
O as0605 INTRA BANK IDENTIFIER e Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFsAD
[] 480696 ISSUER TYPE FINANCIALE.. (2 Confidential Financial Active 05-05-2016 OFsAD 05-05-2016 OFsAD
[0 480607 FORBEARANCE AND RENE... (2 Confidential Financial Active 05-05-2016 OFSAD 05-03-2016 OFsAD

Click the % Add icon.
The Critical Data Element section appears.
Enter the data in the available fields.

6. Click the bl save Draft icon.

A confirmation message appears, confirming that the operation was successful.
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7. Click OK.
8. Additionally, click Edit to review and update the fields and then click Submit..
A confirmation message appears, confirming that the operation was successful.
9. Click OK.
The CDE is created,and the state changes from Draft to Pending Approval.

6.5 Approving or Rejecting a CDE

You should have CDE Approver rights to approve/reject a CDE.
To approve a CDE perform the following steps:
1. Click the Standards and Policies menu and then click Critical Data Element.

2. The Critical Data Element Details page appears.

OFSAD | Monday, August 27,2018 # orsas B apou 8l togout

ORACLE' Data Governance for European Central Reporting

& mbox Standards & Policies Controls Q& Key Indicators Process Monitoring  |fff) Issues & Actions & Admin

Critical Data Element Help.

Search and Filter ®Go 'O clear

COED @ CDE Name @)

Business Term @) Status @

Critical Data Element (793) [add  pelete Ml export

D CDE Name Business Term Access Level Data Classification Level Status Created Date ~  Created By Last Modified Date Last Modified By
480683 CREDIT STATUS DATE 5] Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480684 EFFECTIVE MATURITY DATE 2 Effective Maturitv Date () Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480685 EFFECTIVE FROM DATE [5] Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480686 EFFECTIVE TO DATE =] Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480687 END OF INTEREST ONLY P... (2 Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
450694 HEDGE INDICATOR 5] Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480695 INTRA BANK IDENTIFIER b2 Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480696 ISSUER TYPE FINANCIAL E... B2 Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD
480697 FORBEARANCE AND RENE... (32 Confidential Financial Active 05-05-2016 OFSAD 05-05-2016 OFSAD

3. Inthe Critical Data Element sub-section, in the ID column, click the link of the required CDE ID.
The Critical Data Element section appears.

4. Inthe Reason for Approval/Rejection field, provide a reason for the approval or rejection.
Click either Approve or Reject.
A confirmation message appears, confirming that the operation was successful.

6. Click OK.

If you have approved the Business Term, the state of the Business Term changes to Active. If
you have rejected the Business Term, the state of the Business Term changes to Draft.
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7 Identifying the Controls

This chapter explains the process of identifying the runs and includes the following topics:
e About Controls
e DQ Check and Controls

e User Roles and Actions

e Creating a Control

e Assessing a Control

e Raising Issues on Control

e Closing a Control

7.1 About Controls

A Control is a measure taken to mitigate a regulatory reporting risk. Control measures help an
organization to avoid risks that may otherwise hamper a business due to inconsistentcy in reporting.
Controls are defined to ensure that the data elements used for various business processes are accurate
in value and obtained in time.

The controls identified for risk mitigation can be recorded and stored in a repository. This section helps
in capturing Controls, and also assess their effectiveness in avoiding the risks pertaining to reporting.

Control effectiveness establishes the confidence factor on data elements and its values.
The following are the two types of Controls:
e Quality Controls: They are used to assess the data accuracy.
e Operational Controls: They are used to assess the availability and timeliness of data elements.

Controls are defined on data elements based on defined DQ rules. The effectiveness of these controls
can be automatically assessed based on the DQ execution facts.

To create an Issue, a Control user should be mapped to the Issue Creator group in addition to other Control
related groups.

7.2 DQ Checks and Controls

Controls are defined on data elements based on the defined DQ rules. The effectiveness of these
controls can be automatically assessed based on the DQ execution facts.

To create an issue, a Control user should be mapped to the Issue Creator group in addition to other Control
related groups.

The following are the types of Data Quality Checks and their definitions:

Data Quality Check Definition

Blank Value Check Identifies if the base column is empty
considering the blank space.

Column Reference/Specific Value Check Compares the base column data with another
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column of the base table or with a specified
direct value by using a list of pre-defined
operators.

Data Length Check Checks for the length of the base column data
by using a minimum and maximum value, and
identifies if it falls outside the specified range

Duplicate Check Is used when a combination of column is
unique and identifies all duplicate data of a
base table in terms of the columns selected
for the duplicate check

List of Value Check Can be used to verify values where a
dimension/master table is not present. This
check identifies if the base column data does
not match with a value or specified code in a

list of values.

NULL Value Check Identifies if ‘NULL’ is specified in the base
column.

Referential Integrity Check Identifies all the base column data that has

not been referenced by the selected column
of the referenced table. Here, the user
specifies the reference table and columns.

Range Check Identifies if the base column data falls outside
a specified range of a Minimum and Maximum
value.

The controls are specific to reports. The DQs are defined in the DQ_CHECK_MASTER and
DQ_GROUP_MAPPING tables.

The DQ rules are defined on the basis of the Stage Table and Column mapped to a particular report.

7.3 Operational Control

Operational Controls are created for each unique task available for a Run.

The batch #INFODOM##_CREATE_OP_CONTROLS needs to be executed for any date to create the
Operational Controls based on the Tasks available at that point of time in the system.

If new tasks are added, then this batch is required to be executed again to create the new operational
controls. There will not be any effect on the existing controls.

The FSI_CONTROL table stores the list of controls created. The Operational controls can be identified
with N_CONTROL_TYPE_KEY=10002. All the tasks and operational controls mapping will be stored in
table -FSI_OP_CONTROL_TASK_MAP.

7.4 User Roles and Actions

All users are required to be mapped to DGS EBA AUTHORIZER GROUP, DGS EBA
ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP groups, along with their respective
individual group.

The user roles defined in the Controls section of the DGECR application are:

e Control Owner: Permits the user to create, view, and maintain controls.
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e Creating Control: Allows the user to create a new Control. The user can attach or delete
documents. The user needs to be mapped to the DGCOGRP group.

e Assessing Control: Allows the user to assess the effectiveness of a Control.

e Closing Control: Allows the user to close a Control that is in an Open status and not in use.
o Deleting Control: Allows the user to delete a Control that is in Draft status.

e Exporting Control: Allows the user to export all the controls.

e Viewing Control: Allows the user to view the controls. The user needs to be mapped to the
DGCOVIEWGRP group

7.5 Creating a Control

The fields that are displayed while defining a Control are explained as tabulated.

You should have Control Owner rights to create a Control.

7.5.1 Fields and their Descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory

ID* Displays the unique auto-generated ID for the control.

Name* Provide a short description or name for the control.

Description Provide a long description of the control to indicate the purpose and
nature of the control.

Owner* Select the user responsible for overseeing the control.

Type* Select the control type from the drop —down box:

Quality Control
Operational Control

Comments Provide additional information about the Control.

Financial Accuracy Select the Yes or No.

Check*

Methodology* Select the methodology from the drop-down box: OFSAA
Methodology.

Weight This field appears in the Data Quality Rules section. The weights of

the Data Quality Rule should not be greater than 100.

7.5.2 Procedure to Create a Control

This section details the procedure to create a control by using Batches.

7521 Control Creation via Batches

Perform the following steps to create a Control via Batches:
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1. For control creation, the FSI_DGS_CONFIGURATION table has to be seeded first. In an
Operational Control, you need to set the frequency.

Note: In the N_LOOKUP_VALUE column, you can modify the values in the CREATOR and the OWNER fields.

=|V_MODULE_NAME V_LOOKUP_CODE |N_LOOKUP_VALUE V_LOOKUP_CODE_DESC
b |CTL COMMENT The control has been newly created by system|Default Comments
CTL CREATOR DGSUSER User who created this control
CTL LOCALE en_Us English
CTL OWHER DGSUSER User to whom this control is assigned
CTL UPDATE_COMMENT |DQ Updated - Updation Comments

2. Check the FCT_CONTROL and FSI_CONTROL_DQ_MAP tables once the batchhas been
successfully executed.

75211 Error Profiling

1. Execute the DQs and check the Result Summary and Details.

2. Runthe Batch - ##INFODOM##_ REFRESH_MAT_VIEWS. This will refresh all the required
Materialized Views.

3. Execute the Batch - #INFODOM##_LOAD_FSI_ERROR_DATA_PROFILE. This will load the
data into the FSI_ERROR_DATA_PROFILE table.

4. Once the config table is seeded, then the following batch has to be executed that will create the
Controls for the available DQs - Batch - #INFODOM##_CREATE_CONTROL.

This step is not required to be executed for the current release.
e *FSI_ERROR_DATA_PROFILE table is used for Error Profiling.

. X OFSAD | Monday, September 3, 2018 8 orsas sbout Bl Logout
ORACLE' Data Governance for European Central Reporting AD | Y. Sep 2

K9 tnbox Standards & Policies Cantrols Q Key Indicators Process Monitoring |i| Issues & Actions ‘ Admin

[ edit
Name* @ Interest Payment Date in Stage Borrowings D* @ 495733
Description @ Control for Stage Borrowings Interest Payment Date
Methedology* @ OFsaA Method
Owner' @ OFSAD Type” @ Quality Contral

Financial Accuracy Check” @ No

Comments @
Data Quality Rules (1) fdsave =

Data Quality Rule  Data Quality Rule Description Wweight

DQFSDWDT0007  To Check Interst Date Should Be Less Than Or Equal To Closed Datt 100

© Oracle. All rights reserved

75.2.1.2 Control Execution Details

The following are the steps to perform control execution:

1. Once the FSI_ERROR_DATA PROFILE table is populated, execute the Batch
##INFODOM##_LOAD_FSI_CONTROL_EXEC_DETAIL.
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This will load data into the FSI_CONTROL_EXECUTION_DETAILS tables, which will be used by
the DGECR Ul to display the required execution details for a control.

All the batches require FIC_MIS_DATE while executing. The wrong FIC_MIS_DATE might result
in data corruption.

All the batches should be executed in the same sequence mentioned above.

7.5.3 Assessment Parameter Maintenance

Navigate to Admin > Control > Control Assessment Parameters. The maintenance has a list of
seeded parameters that are dependent on the Data Quality Framework of OFSAAI. The outputs
associated with these parameters are derived at the run time based on the Data Quality Profiling
information within the Data Governance for European Central Reporting. The screen also enables a
user to define new Assessment Parameters that can participate in the Score and Rating calculation of
Assessment. The assessments for a particular control depends on the Parameter Type and Score

. . OFSAD | Monday, August27, 2018 #horssa (= avout 8 Logout
ORACLE" Data Governance for European Central Reporting
4 mbox Standards & Policies Controls t),e Key Indicators Process Monitoring |i| Issues & Actions a Admin
Control Assessment Parameters Help
Control Assessment Parameters (4) jsave
= [C] parameter Name Weight

Data Quality Errors 19

Data Quality Warning Flag El

Data Quality Information Flags 25

Defaults 25

Threshold Score 100

e The sum of the weights of all parameters should not be greater than 100.
e The value in the Threshold field should not exceed 100.

Once the parameters are created and the ranges are specified, add values for the same parameter in
the table - FSI_CONTROL_USER_PARAM_VALUES. This table captures the Assessment parameter
values at the control level. The user is supposed to enter values in this table. The Assessment
calculation mechanism will pick data from this table and utilize the inputs in the score calculation of
Assessment for a control or for multiple controls at run time.

n_control_key Refers to n_control_key column of FCT_CONTROL
d_fic_mis_date Date on which Parameter value is generated.

n_param_id V_ID column of fsi_control_assessment_admin

v_value Expected Value of a Parameter

The parameters can be defined as Inference Based/Fact Based.

7.5.4 Control Assessment

For Operational control, the Assessment can be done for Controls (data elements) using an ICC batch.
This provides the flexibility to trigger assessments of all the Controls in one go based on the frequency
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7.54.1

75411

7.5.4.1.2

7.5.4.13

7.54.2

as defined in FSI_CTL_FREQUENCY table. This Frequency can be set in the
FSI_DGS_CONFIGURATION table. The parameter information (definition/Values) present above are
utilized during the batch execution of Control Assessments.

Quality Control Assessment

Pre-Requisites
e For doing Control Assessment, the Control Execution Details should be present.
e Execution Details can be DQ or User Defined Parameters related.

e The DQ related parameters are available by default if DQ executions are done for that control.

Generate Assessments

e Once all the pre-requisites are met, execute the batch — Create_Control_Assessment for a
given FIC_MIS_DATE.

Once the Assessment batch is triggered, the user can see the assessment IDs that are generated in the
User Interface of Data Governance for European Central Reporting. The backend engine generates the
Assessment Start Date as the date on which batch is triggered.

User Defined Assessments

1. In DGECR, click Controls.
The Controls workspace appears.

2

3. Inthe ID column, click the required control.

4. The Control Profile section appears, with the Details tab displayed by default.
5

Click the Assessment tab.

Delete Assessment

Click the icon to delete an assessment.

Operational Control Assessment

Before doing an assessment on an operational control, the following steps need to be completed:
1. Complete the Process Monitoring of the RUN for a given date.
2. Execute the T2T to move the Process Monitoring statistics to the FACT table for the same date.
3. The data should be available in the following tables:
e FS|_PM_BATCH_SCHEDULED TIME
e FSI_PM_BATCH_TASK_DEPENDENCY
e FSI_PM_BATCH_TASK_AVG_TIME
e FSI_PM_BATCH_TASK_SCH_TIME

Once the above steps are done, then the batch #INFODOM##_OP_CONTROL_ASSESSMENT
needs to be executed for the given date to do the assessment on operational controls. Once the
assessment is done, it will start appearing in the Ul under the Assessment tab for a control.

Tables:
e FCT_PM_BATCH_TASK MEASURES: Stores the statistics on each task.
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FSI_CTL_EFFECTIVENESS: Stores the Assessments created.

FSI_CONTROL_ASSESS_SUMMARY: Summary of the assessment.
FSI_OP_CONTROL_EXEC_DETAILS: Assessment details with all parameters.

The default frequency that is used is configurable and can be adjusted in the table
fsi_dgs_configuration.

In DGECR, click Controls.

The Controls workspace appears.

In the ID column, click the required control.

The Control Profile section appears, with the Details tab displayed by default.

Click the Assessment tab.

The details of the Assessment appear.

ORACLE' Data Governance for European Central Reporting

Controls >> Control Details

Defails | Assessments | lIssues and Actions

+ Control
Name Recalcitrant Flag in Stage Loan Contracts

Control Assessments (0) (i pelete Assassment

D~ Date Effectiveness Score Effectiveness Rating  Status

No Data Found

GL Recon Adjustment (782)

Adjustment ID ~ Adjusted Amount GL Code Currency GAPP Code
GL81.342 -4000 DEFAULT usD AUGAAP
GL81342 -4000 DEFAULT usb AUGAAP
GL81.342 -4000 DEFAULT usD AUGAAP
GL81342 -4000 DEFAULT usD AUGAAP
GL813a1 -537.521 DEFAULT AUD AUGAAP

9 mmbox Standards & Policies Controls Qt Key Indicators Process Monitoring |-| Issues & Actions & Admin

Leqal Entity
[i=1
[i=1
LEL
LE1

LEL

OFSAD | Monday, August 27, 2018 @ OFsas & avout Bl Logout

Help
open

@ Oracle. Allrighis reserved =

7.6 Raising Issues on Controls

In the Control workspace, if the user is mapped to the Issue Creator role, the user has an option to
create issue if the control is in open status.

1.

2.

In DGECR, click Controls.

The Controls workspace appears.

In the ID column, click the required control.

The Control Profile section appears, with the Details tab displayed by default.

OFSAA DOCUMENT TITLE | 59



OFSAD | Monday, August 27, 2018 #B OFsas 15 about B Logout

ORACLE" Data Governance for European Central Reporting

5 mbox Standards & Policies Controls. 0‘ Key Indicators. Process Monitoring |i| Issues & Actions & Admin

Controls >> Control Details Help
Status: Open

Details Assessments Issues and Actions
(# Edit
Name* @ Interest Payment Date in Stage Borrowings D@ 495733
Description @) Control for Stage Borrowings.Interest Payment Date
Methodology* € OFSAA Method
Owner* @ OFSAD Type* @ Quality Control

I

Financial Accuracy Check* @ No

Comments @

Data Quality Rules (1) f{save =

<& [ pata Quality Rule  Data Quality Rule Description Weight

[T DQFSDWDT0007  To Check Interst Date Should Be Less Than Or Equal To Clased Date 100

©Oracle. Al rights reserved ~

7.7 Closing a Control

A Control in an Open state can be closed. Perform the following steps to close a control:
1. In DGECR, click Controls.
The Controls workspace appears.

2. Select the check box next to the control that you want to close.

I'LB Close Control
e

Th icon is now enabled.

3. Click the @Claie Control icon.

The Control window appears.

@ Controls - Moxzilla Firef

@ 10.184.156.31:5020/OFSAAB00/formsFramework/formsrenderer/MapRenderer jsp

D" ) 495733

Reason for Closure @)

4. Inthe Reason for Closure field, enter a reason and then click Submit.

A confirmation message appears, confirming that the operation was successful.
5. Click Back.

The Control is closed.
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8 Defining the Key Indicators for Monitoring

This chapter explains the details of the Key Indicators (KI) module in the Oracle Financial Services Data
Governance for European Central Reporting application and step-by-step instructions on how to use
this module.

This chapter includes the following topics:

e About Key Indicators

e Parameters of Key Indicators

e User Roles and Actions

e Creating Key Indicator Conditions

e Managing Measure and Formulas

8.1 About Key Indicators

The Key Indicator (KI) component provides the flexibility to define Key Indicators to evaluate values,
trends, and variances of various data elements. They are important measures from the data foundation
that provide an insight into the values of various data elements that are required for critical
organizational processes. These indicators are reviewed on a periodic basis to alert stakeholders of
possible situations needing attention.

The OFS DGECR Key Indicators module provides an early-warning system to identify potential costly
operational hazards including fraud, legal and technology risks. The use of Kls is recommended by the
Bank of International Settelments (BIS) for sound Operational Risk management. Therefore, it is an
essential component of Basel Il and Sarbanes-Oxley laws.

The type of values are quantitative and qualitative. For the quantitative type of Kl, the user should load
the measures. The Kls then are used as quantitative measures to monitor individual Critical Data
elements and to determine the effectiveness of the controls. The Kl values are monitored for specific
business processes such as regulatory reporting, determining variances, time series trends, and many
other metrics of data elements.

The application allows users to define various levels of thresholds depending on the level of analysis
required. The Kl values are compared against defined threshold ranges.This determines the Red Amber
Green (RAG) status of the KI. Various natifications and tasks can be sent to the appropriate
stakeholders, depending on the level of the Kl threshold value breach. The RAG status can be used as
an indicator of the effectiveness of the Controls.

A Key Indicator user should be mapped to the Issue Creator group in addition to other Key Indicator related
groups, to create an Issue.

8.2 Parameters of Key Indicators

The DGECR for Key Indicators for Regulatory Reporting is based on two parameters:
e Periodic Comparison

e Edit Checks
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8.2.1 Key Indicators based on Periodic Comparison

The Periodic comparison, as the name suggests, is the comparison of reports between two time
intervals or periods. If we are handling monthly reports, then we need to compare and analyze the
reports of two months (periods). If we are handling yearly reports, then we need to compare and
analyze the reports of two years (periods). This kind of comparison helps us to identify any kind of issue
with the data.

For a few reports, the first quarter of the current year cannot be compared with the last quarter of the previous
year. As the report is for the current year, comparison with the previous year’s data is invalid. By default, the
reports are filtered by the latest values on the basis of the Run Skey and MIS Date Skey Filter for period
comparison.

The Data is analyzed for each cell ID present in the Regulatory Reports to identify the possible
indicators. We have defined the Key Indicator based on Period Comparison for each cell ID present in a
report. The Corresponding Thresholds are defined for each Key Indicator and Scores are provided for
each threshold value. This score value in turn helps us to categorize the RAG (Red, Amber and Green)
status against each Key Indicator. According to the RAG value, the user can take necessary actions for
Red and Amber Kis.

8.2.2 Key Indicators based on Edit Checks

Each report has its own Edit check sheet that includes various Validity, Qualitative, Intraseries, and
Interseries check.

Validity Check: Validity check is a Quantitaive check. A validity check is used to check whether a
particular value in a report is a number or not as it should be as per the Edit Check sheet. For example;
One of the most common validity check states the Value not equal to null.

The Derived columns should not be considered for Key Indicators. For example: if cells A1+A2=A3, then A3 is the
derived column.

Qualitative Check: Qualitative Checks define which values in one column should match the values of
another column. This ensures the quality of the reports.

Interseries Check: Interseries Check involves the comparison of two schedules within a single report.

Intraseries Check: Intraseries Check involves the comparison of two schedules from two different
reports.

The edit checks are classified into two types:
Controls
Key Indicators

The edit check is defined on the basis of the cell ID. If the cell ID mapping is received from the Staging
phase, it is a Control and hence defined as a DQ check. If the cell ID mapping is received from the
Reporting phase, it is a Key Indicator. The Kl has its own formula. The Content of DGECR will define
the KI definition and threshold values. This is fed to the DGECR, which reads the Kl definition and
threshold values to generate the Kl indicators and provide the required RAG value.

The KI definitions are available in the FCT_KRI_DEF table.
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& mbox Standards & Policies Controls q& Key Indicators Process Monitoring |-| Issues & Actions & Admin
ey Indicators

Search 'O clear = Go

Help *.

oX5) Name @
Owner @

Key Indicators (167)

D~ Name Owner

4383206 Wotina Share Percent In Fact Entitv Parent Information 2 OFsAD (]
433204 Walue Of Mitiaant In Reportina Currency In Fact Mitioants ) oFsap 9]
488203 Walue Adiustment And Provisions In Reaulatorv Account Summarv ) oFsap [59]
488201 Unrealized Gain And Lass Amount In Reortina Currency In Requlatorv Account Summary & oFsap =]
4288190 Undrawn Amaunt In Repartina Currency In Reaulatorv Account Summary & oFsap =]
488185 Underivina Exposure Amount In Fact Reaulatory Counterpartv Canital Summary & oFsap =]
488178 Total Reaulatorv Canital OF Entitv In Reportina Currency In Fact Leaal Entity Details &2 OFsaD (=]
488175 Total Gain And Loss Amount In Reportina Currency In Requlatorv Account Summary & OFsaD (=]
488170 Total Assets Of Entitv In Reporting Currency In Fact Leaal Entitv Details (2 OFsaD (]

© Oracle. All ights reserved

The Threshold values are available in the FCT_KI_DEF_THRSLD table

. . OFSAD | Monday, August 27, 2018 @B OFsaa |5 About % Logout
ORACLE' Data Governance for European Central Reporting ! v Avg

£ mbox Standards & Policies Controls (l< Key Indicators Process Monitoring |-| Issues & Actions & Admin

Key Indicators >> Key Indicator Details. Help
Details Kl Metrics Issues and Actions.
+ Name @) voting Share Percent In Fact Entity Parent Information

Key Indicator Metrics (6) i=

AssessmentKey ¥ Assessment Date Legal Entity Assessment Status
1333615 20-Jun-2016 Wells Fargo Bank, Nation PASS
1230013 30-Jun-2018 PASS
1230595 30-Mar-2016 Wells Fargo Bank, Nation PASS
1128509 20-Mar-2016 PASS
702375 01-Jan-2016 Wells Fargo Bank, Nation PASS
600088 31-Dec-2015 Wells Fargo Bank, Nation PASS

Variance (0) i=

Validation Checks (0) =

©Oracle. All rights reserved

8.3 User Roles and Actions

This section explains the different user roles and actions that can be perform in the Key Indicator
module of the OFS DGECR application.

8.3.1 User Roles

All the users are required to be mapped to the DGS EBA AUTHORIZER GROUP, DGS EBA
ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP groups along with their following
respective groups.

The user roles are defined in the Key Indicator module of OFS DGECR:

o Key Indicator Creator: Permits the user to create, view, and maintain Key Indicators. The user
needs to be mapped to the DGSKRCODGRP group.

¢ Key Indicator Value Capturer: Helps the user to generate metrics. The user needs to be
mapped to the KIVCAP group.

o Key Indicator Viewer: Helps the user to view the key indicators. The user needs to be mapped
to the DGKIVIEWGRP group.
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8.3.2 Actions

The Key Indicator records module allows users to perform the following actions:

Creating Key Indicator: This action allows the user to create a new Key Indicator record. Users
can link or delink the components, define the formulas, Threshold limits, and attach or delete the
documents before or after submitting the Key Indicator.

Editing Key Indicator: This action allows the user to edit and update the Key Indicators in Draft
or Review state.

Closing Key Indicator: This action allows the user to close the Key Indicators in Open state.
Deleting Key Indicator: This action allows the user to delete the Key Indicators in Draft State.

Exporting Key Indicator: This action allows the user to export the list of Key Indicator records.
The Exported Key Indicator function allows the organization to have a compiled list of all
applicable Key Indicator records. This functionality enables the user to update the Owner and
Lower and upper threshold for an existing Kl in a seamless way rather than doing it individually.

Importing Key Indicator: This action allows the user to import the list of Key Indicator records.
The Imported Key Indicator function allows the organization to have a compiled list of all
applicable Key Indicator records. This functionality enables the user to update the Owner and
Lower and upper threshold for existing Kl in a seamless way rather than doing it individually.

8.4 Creating Key Indicator Conditions

When defining a Key Indicator Condition, the displayed fields are explained as tabulated.

You must have Key Indicator Creator rights to create a Key Indicator Condition.

8.4.1 Fields and their descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory

Name* Provide a short description for the KI.
ID A unique ID for the Kl (auto-generated).
Description Provide a description for the KI.
Type Value Based
Variance Based
Owner The Kl owner.
Entity Name The table for which the Kl Group is created.

Attribute Name

The column for which the KI Group is created.

KI Conditions ID

A unique ID for the KI Condition (auto-generated).

Report

The Kl Condition report for EBA.

Schedule

A schedule for the report.

Cell Reference

A reference to the cell ID
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Fields Description

Fields marked in blue asterisk(*) are mandatory

KI Condition The name of the KI Condition.

8.4.2 Creating a Key Indicator Condition

You can create a set of new Key Indicator Conditions in bulk when you identify a warning signal that has
a potential impact in the organization. The Key Indicator Details workspace allows you to import a set
of new Key Indicator Conditions in bulk.

Only users that are mapped to the role of a Key Indicator Creator can create a Key Indicator Condition.

To create one or more Key Indicator Conditions, perform the following steps:

1.
2.

In DGECR navigate to Common Tasks > Operations > Batch Execution.

In the Batch Execution pane, execute the DG_KI_GRP_BATCH_PROCESS batch. This Batch is
mentioned in the file OFS Data Governance Studio v 8 0 6 0 0 Runchart.

Key Indicator group with Key Indicator Conditions are generated in these target tables:
FSI_KI_GRP_MAP_DETAILS
FSI_KI_GRP_QRY_MAP_DETAILS

8.4.3 Viewing and Editing a Key Indicator Condition

To view or edit the existing KI Condition details, perform the following steps:

1.
2.

3.

In DGECR, click Key Indicators

The Key Indicators workspace appears.

OFSAD | Monday, August 27,2018 # orsas B avout 8 Logout

ORACLE’ Data Governance for European Central Reporting

3 mbox Standards & Policies Controls Qe Key Indicators Process Monitoring |-| Issues & Actions ‘ Admin
Key Indicators Help
Search 'O Clear = 6o
D@ Name @
Owner @

Key Indicators (167) b

S Dv Name Owner
[0 188206 Votina Share Percent In Fact Entitv Parent Information &) oFsAD &
7] 488204 Value Of Mitiaant In Rebortina Currency In Fact Mitiaants () oFsap 5] L4
[0 488203 Value Adiustment And Provisions In Reaulatory Account Summary () oFsap 5]
o 488201 Unrealized Gain And Less Amount In Reoortina Currency In Reaulatorv Account Summary 2 oFsaD 2
[0 1ss100 Undrawn Amount In Reporting Currency In Reaulatorv Account Summary & oFsaD =]
[ ass1e5 Underhina Exoosure Amount In Fact Reaulatory Counteroarty Cabital Summary &) OFsAD @
O ass178 Total Reaulatorv Capital OF Entitv In Reportina Currency In Fact Leaal Entitv Details ) OFsAD 5]
O asg175 Total Gain And Loss Amount In Reportina Currency In Reaulatory Account Summary 2 OFsaD [&9]
[0 4ss170 Total Assets Of Entitv In Reportina Currency In Fact Leazl Entity Details ) OFsAD 53]

© Oracie. All fights reserved

In the Key Indicators section, in the ID column, select the link of the required KI.

4. The Key Indicators Details section appears with the Details tab open by default.
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5.

6.

ORACLE’ Data Governance for European Central Reporting

g Inbox

Key Indicators >> Key Indicator Details

Standards & Policies Controls Q¢ Key Indicators Process Monitoring |i|

Defails | KiMetrics  Issues and Actions

Name* @) Woting Share Percent In Fact Entity Parent Information
Description @ This Column Stores The Voting Percentage

Owner OFSAD

Entity Name 0 FACT ENTITY PARENT INFORMATION
KI Conditions (1)

@Expm &Hmpm =

D~ Report Schedule Cell Reference
69769 F140 FI4001 FI4001¢120

Issues & Actions @ Admin

KI Condition

(32 VOTING RIGHTS (361

OFSAD | Tuesday, August28, 2018 8B OFSAA [ About S Logout

Help

D 4s8205

Agtribute Name @) VOTING SHARE PERCENT

Type

(33) Variance-Based

In the Conditions section, click the
system.

same file name, Kl.xIsx.

Export

icon,

and then save the Excel file to your local

In the downloaded Excel file, enter the required information and then save the Excel with the

Only the columns that are highlighted in Green can be edited.

7.

In the Kl Indicator Details page, click the
updated data into the application,.

The File Import Form window appears.

IilIm;:n:nrfc

icon to upload this excel file and import the
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| @ File Import Form - Mezilla Fi =N

@ 10.184.156.31:5020/0F5AAB00/DGS/dgsexport/dgsExport.jsplinfodom=DMINFO&module=KI s w =
H
File Import |
Choose the File No file selected. I
Import to Application Tables Import
View Status Refresh

8. Click Browse, locate the Kl.xIsx file, and then click Open.
9. Click Attach. A confirmation message appears, confirming that the file has been uploaded.
10. Click OK.
11. To import the data into the application tables, click Import.

A confirmation message appears, indicating that the import process has been triggered.
12. Click OK.
13. To view the status details, click Refresh, and then close the window.

The updated data will be imported into the application.

14. The uploaded KI Condition now appears in the KI Conditions list.

8.4.3.1 Editing the Alert Threshold Field

To view or edit the existing KI Condition details, perform the following steps:
1. In DGRR, click Key Indicators

The Key Indicators workspace appears.
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[ mbox  standards & policies  Controls @ Key Indicators  Process Monitoring

) Issues & Actions &y Admin
Key Indicators Help

Search O clear ®co

ol Name @)
Owner @

Key Indicators (221)

& DY Name Owner
[ as8215 Write Off Amount In Reportina Currency 1545315 In Reaulatory Account Summary 12 oFsAD &3]
[0 88210 Weichted Average Probability Of Defaut In Percent In Fact Reaulatorv Cavital Pool Summary 12 oFsAD &3]
[ 488200 Weichted Average Loss Given Default Percentace Post Mitiaation In Fact Reaulatorv Canital Pool Summary ) oFsAD 3]
[ 88208 Weichted Average Loss Given Default Percentaae Post Mitiaation In Fact Reaulatorv Canital Account Summary ) OFsAD @
[ 488202 Unrealized Loss Or Gain Of Exaosure In Reportina Currency In Reaulatory Account Summary ) OFsAD &
[ 288200 Unrealized Gain And Loss Amount In Revortina Currency In Fact firs Account Summary G OFSAD &)
[ ass104 Unfunded Default Fund Contribution Amount In Fact Reaulatorv Counternarty Capital Summary &) OFSAD @
[0 488102 Unearned Income In Reportina Currency In Reaulatory Account Summary &) OFSAD @
[0 288190 Undrawn Amount In Repartina Currency In Reaulatorv Account Summarv 2 oFsAD =]

OFSAD | Thursday, August 30,2018  # OFsAa about S Logout
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In the Key Indicators section, in the ID column, select the link of the required KI.

The Key Indicators Details section appears with the Details tab open by default.

ORACLE’ Data Governance for US Regulatory Reporting

£ mbox Standards & Policies Controls Q€ Key Indiicators Process Monitoring

) issues & actions @ Admin

Key Indicstors >> Key Indicator Details Help

Details KI Metrics Issues and Actions.
Name* @ Weighted Average Probability Of Defauft In Percent In Fact Regulatory Capital Pool Summary D@ 488210

Description @ This Stores The Weighted Average Probability Of Default In Percent

Ouwner OFSAD

Entity Name 0 FACT REGULATORY CAPITAL POOL SUMMARY Attribute Name 0 'WEIGHTED AVERAGE PROBABILITY OF DEFAULT IN PERCENT
KI Conditions (102)
& Export &‘]mpun =
£ D~ Report Schedule Cell Reference KI Condition Type
O 34156 FrECI01 SchH AAHGP930 () EDIT NO. IS S060: IF (AAHGP930) IS NO... B2 Validation Check
[0 34155 FrECI01 SchH AAHAPO30 () EDIT NO. IS S040: IF (AAHAPO30) IS NO.. ) Validation Check
[ 4085 FrECI01 Schi AAHGP929 (=) EDIT NO. IS 5020: IF (AAHGP9Z9) I5 NO... B2 Validation Check
[0 34084 FRECIO1 SchH AAHAPO29 () EDIT NO. IS 5000: IF (AAHAPO29) IS NO... (2 Validation Check
[Czze75  FrECI0L SchH AAHGI032 () EDIT NO. IS 0289: IF (AAHGJ032] IS NO... (2 Validation Check
Page 1 of21 >

© Oracle. All rights reserved
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]

In the KI Conditions sub-section, in the ID column, select the link of the required KI Condition.

The Key Indicator Condition Details section appears.

Details KI Metrics

Key Indicators >> Key Indicator Details >> Key Indicator Condition Details Help

Open

D Edit | Submit

Name* Variance of charge-offs on assets sold and securitized with recourse or other seller- D 1808953
provided credit enhancements (calendar year-to-date): all other loans
Description This Key Indicator compares the value of charge-offs on assets sold and securiti
year-to-date): all other loans as of current period with that of previous period

d with recourse or other seller-provided credit enhancements (calendar

Type* Variance-Based
Source Internal

Frequency Quarterly
Measure Scale Number Currency
Owner* OFSAD Alert Threshold(%)
Caution User* OFSAD Critical User* OFSAD
Comments KI Comments

©® Oracle. All rights reserved
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[ # Edi
4. In the upper-right corner of the section, click the Edit icon.

5. Inthe Alert Threshold(%) field, enter a value for the threshold.

ails >> Key Indicator Condition Details Help
Open

A edit | £ Submit

Name*

arge-offs on assets sold and
it enhancements (calend:
ator compares the value ¢
all ather loans as of curre

dwith recourse or other seller- D 1808953

ther loans

Description This Key
year-to-d.

-offs on assets sold and securitized with recourse or other seller-provided credit enhancements (calendar
with that of previous period

Type* 7 Variance-Based
Source Internal
Frequency » Quarterly
Measure Scale 7 Number Currency

Owner* OFSAD Alert Threshold(%) 25
Caution User* OFSAD Critical User* OFSAD
Comments KI Comments
) ) ) Submit
6. Inthe upper-right corner of the section, click the icon.

A confirmation message appears, indicating that the operation was successful.

8.5 Key Indicator Assessments

This section explains about how to create and view Key Indicator Assessments.

8.5.1 Creating a Key Indicator Assessment

To create Key Indicator Assessment at the group level:
7. Prerequisites:
e This table DIM_RUN must consist the of jurisdiction of EBA in it.
e Thistable FCT_REG_RUN_LEGAL_ENTITY_MAP must consist of valid data values.
8. Inthe DGECR, navigate to Common Tasks > Operations > Batch Execution.

Resave the temporary DE Batches corresponding to the reports for which assessment is done.
These Batches are mentioned in the OFS Data Governance Studio v 8 0 6 0 0 Runchatrt.

Every time a new data is loaded, you must resave these temporary DE Batches.

10. In the Batch Execution pane, run the BULK_KI_ASSESSMENT batch. This Batch is mentioned
in the OFS Data Governance Studio v 8 0 6 0 0 Runchart.

11. For each Key Indicator group execution, one assessment is created in these target tables:
e FSI_KI_GRP_ASSESSMENT_STATUS

o FCT_KI_ASSESSMENT

e FCT_KI_ASSMT_VARIANCE

e FCT_ISSUES

e FSI_DG_WF_ENTITIES

The Frequency of Key Indicator Condition level assessment execution can be set at these intervals: Daily, Weekly,
Fortnightly, Monthly, Quarterly, Half Yearly, or Yearly.
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8.5.2 Viewing a Key Indicator Assessment

To view Key Indicator Assessments, perform the following steps:

1.
2.

In DGECR, click Key Indicators
The Key Indicators workspace appears.

ORACLE' Data Governance for European Central Reporting

Qt Key Indicators

Standards & Policies  Controls

E Inbox

Key Indicators

Process Monitoring |i| Issues & Actions

& ~dmin

Search O clear ®Go

©Q

owner @

Name @

Key Indicators (167)

£ D Name
288206 Votina Share Percent In Fact Entitv Parent Information
488204 Value OF Mitioant In Reportina Currency In Fact Mitiaants
488203 Value Adiustment And Provisions In Reaulatory Account Summary
488201 Unrealized Gain And Loss Amount In Reportina Currency In Reaulatory Account Summarv
488190 Undrawn Amount In Reportina Currency In Reaulaterv Account Summary
488185 Underivina Exposure Amount In Fact Reaulatorv Counteroartv Capital Summary

Total Requlatorv Cabital Of Entitv In Reparting Currency In Fact Leaal Entitv Details

Total Gain And Loss Amount In Renortina Currency In Reaulatory Account Summary

Total Assets O Entitv In Reportina Currency In Fact Leaal Entitv Details

OFSAD | Monday, August 27, 2018

Cwner
& oFsap @
(=) oFsaD &
) oFsAD @
& oFsap =]
) oFsAD @
() OFsAD @
& oFsap 53]
) OFsAD =]
& oFsap @

In the Key Indicators section, in the ID column, select the link of the required KI.

The Key Indicators Details section appears with the Details tab open by default.

#h OFsas

about Bl Logout

Help *
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ORACLE' Data Governance for European Central Reporting

qe Key Indicators

Standards & Policies Controls

g Inbox

Key Indicators >> Key Indicator Details

Process Monitoring |i| Tssues & Actions

& Admin

Details | KiMetrics

Issues and Actions

OFSAD | Tuesday, August 28, 2018

& oFsan About S Logout

Help

Name* @
Description €
Owner

Entity Name )

Voting Share Percent In Fact Entity Parent Information
This Calumn Stores The Voting Percentage

OFSAD

FACT ENTITY PARENT INFORMATION

D@ 488206

Attribute Name € VOTING SHARE PERCENT

5.

KI Conditions (1)

Riggort Himport =

£ D Report Schedule Cell Reference KI Condition

69769 F40 F400L F4001C120 (2 VOTING RIGHTS (%)

Type

(2 Variance-Based

In the ID column, click the link of the required KI.

6. The Key Indicator Condition Details section appears, with the Details tab open by default.
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- - OFSAD Tuesday, Al it 28, 2018 o oFsan About ng
ORACLE' Data Governance for European Central Reporting || Toesday Aug o T

9 mnbox Standards & Policies Controls Qe Key Indicators Process Monitoring |-| Issues & Actions & Admin

Key Indicators >> Key Indicator Details >> Key Indicator Condition Details Help|
Stafus:  Ope]

Details | KIMefrics

Name* @) VOTING RIGHTS (%) D@ 89769
Description @) This Key Indicator compares the value of voting rights (3%) s of current period with that of previous period
Type" @ Variance-Based
Source @ Internal
Frequency @ Daily
Measure Scale € Number Currency @
Owner* @ OFSAD
Caution User €)  OFSAD Critical User* @) OFSAD

Comments @ KI Comments

B Hide
B Measures and Formula

Reporting Element Map (0) [ iink  EB pelink =

Thresholds (3) 4 pefine Limits ~ Delete Limits |~ Update View Rating Scale ==

== [] Lower Limit Upper Limit Score Rating

g -10 10 1 Green

0 -100 -1 9 Red

7. Click the KI Metrics tab.

8. Select check box next to the the required Kl Metrics record to display its KI Condition Type
details:

9. Expand Variance to display Variance-based check assessment details in the Variance section.

10. Expand Validation Checks to display Validation check assessment details in the Validation
Checks section.

11. Select the Variance record to edit its KI Condition.

12. Select the Validation Checks record to edit its KI Condition.

8.6 Issues and Actions for Key Indicator Assessment

For any Key Indicator Assessment that is in a FAIL status, the associated Issues and Actions details are
displayed in the Issues & Actions tab.

8.7 Managing Measure and Formulas

For Enterprise valid Key Indicators, the values are generated. Predefined value sets are created in the
applications and then installed in the same Information Domain. Users mapped to the role of a Key
Indicator Creator can update these details that are in Draft or Open status.

8.7.1 Creating Measures

The seeded measures are populated in the measure list of Measure and Formula page. To create the
manual measures, perform these steps:

1. Enter the values in following columns of DIM_KI_MEASURE table (available in atomic schema):
2. Columns of DIM_KI_MEASURE Table

Column Description
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N_MEASURE_KEY

This is the primary key. Enter a unique key number.

V_MEASURE_CODE

Enter the measure code. This should be same as of
N_MEASURE_KEY.

V_MEASURE_NAME

/Allows you to enter the name of measure which is not available in
existing list. For example, number of customers, number or complaints
and so on. You can enter a maximum 300 characters in this column.

N_MEASURE_TYPE

Enter the type of measure. The type is entered as Number as you have
defined it for status. Following are the types of measure

1 - Internal Source - (Automated)
2 - External Source - (Automated)
3 - Internal Source - (Manual)
4 - External Source - (Manual)

N_MEASURE_STATUS

Enter the status of measure as 1 (active) or 2 (Inactive). Only active
mea- sures will be displayed in measure list of Measure and Formula

page.

N_ENTITY_KEY

Enter the entity key value. For example, if you want to create a
measure based on Risk module, enter the entity value of that module
in this field. The Entity Key values are available in
SETUP_COMPONENTS table.

N_APP_KEY

Enter the name of application. Following are the values for Application
key:
1 — Data Governance for European Central Reporting

3. DIM_KI_MEASURE_MLS table is used to store the names of the measure in different languages
as available or installed. Enter the values in following fields of DIM_KI_MEASURE_MLS table:

4. Columns of DIM_KI_MEASURE_MLS table

Column Description

N_MEASURE_KEY

This is the primary key. Enter the unique key number. This value
should be same as defined in DIM_KI_MEASURE table.

V_MEASURE_NAME

/Allows you to enter the name of measure which is not available in
existing list. For example, number of custom- ers, number or
complaints and so on. This value should be same as defined in
DIM_KI_MEASURE table.

DESCLOCALE

Enter the locale details of measure. For example, en_US and so on.

After populating these values in table, the created measures (if status is active) will be displayed in KI

screen when defining the formula.

Measures must be created in these tables to appear in the user interface.
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8.7.2 Defining Limits

The seeded Limits from the FCT_KI_DEF_THRSLD table are populated in the list of the Threshold

section.

To view the Limits for a specific Kl, perform these steps:

1.
2.

In DGECR, click Key Indicators

ORACLE’ Data Governance for European Central Reporting

Standards & Policies Controls

3 nbox

Key Indicators

a< Key Indicators Process Monitoring

search 'O clear o
D
Owner @

Key Indicators (167)

D Name

1l ssues & Actions

The Key Indicators workspace appears.

& Admin

Name €

Owner
488206 Votina Share Percent In Fact Entitv Parent Information &) oFsAD
488204 Value OFf Mitioant In Reportina Currency In Fact Mitiaants 22 OFsAD
488203 Value Adiustment And Provisions In Reaulatorv Account Summary &) oFsAD
488201 Unrealized Gain And Loss Amount In Reportina Currency In Reaulatorv Account Summary @) oFsaD
488190 Undrawn Amount In Reportina Currency In Reaulatorv Account Summarv. &) oFsaD
488185 Underivina Exposure Amount In Fact Reaulatorv Counterpartv Canital Summary @) ofsaD
488178 Total Reaulatorv Capital Of Entitv In Rebortina Currency In Fact Leaal Entitv Details &) oFsaD
488175 Total Gain And Loss Amount In Reportina Currency In Reaulatorv Account Summary &) ofsap
488170 Total Assets Of Entitv In Reportina Currency In Fact Leaal Entitv Details &) oFsaD

3.

OFSAD | Monday, August 27,2018 & oFsas sbout Bl Logout

Help ~

© Oracie. All rights reserved

In the Key Indicators section, in the ID column, select the link of the required KI.

4. The Key Indicators Details section appears with the Details tab open by default.

ORACLE' Data Governance for European Central Reporting

q& Key Indicators

Standards & Policies Controls

E Tnbox

Key Indicators >>

Process Monitaring

Key Indicator Details

Defails | KiMetics  Issues and Actions
Name* ) Voting Share Percent In Fact Entity Parent Information
Description €  This Column Stores The Voting Percentage
Owner  OFSAD
Entity Name @) FACT ENTITY PARENT INFORMATION

KI Conditions (1)

Biggport Bimpart =
D Report Schedule cell Reference
69769 Fl40 Fla001

FI4001€120

() Tssues & actions

& Admin

KI Condition Type

() VOTING RIGHTS (%)

B oAk

OFSAD | Tuesday, August 28, 2018 Hbout Bl Logout

Help

D@ 488206

Attribute Name @) VOTING SHARE PERCENT

() Variance-Based

When creating the Kl, enter the Type as Quantitative, and Source as Internal.

5.

In the ID column, click the link of the required KI.

6. The Key Indicator Condition Details section appears, with the Details tab open by default.
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OFSAD | Tuesday, August28,2018 M OFsas 15 about 8 Logo

ORACLE' Data Governance for European Central Reporting
9 mnbox Standards & Policies Controls qe Key Indicators Process Monitoring |-| Issues & Actions ‘ Admin

KeyIndicators >® Key Indicator Details >> Key Indicator Condition Details

Details | KiMetrics

Name* @ VOTING RIGHTS (%) D@ 69760

Description @ This Key Indicator compares the value of voting rights (%) as of current period with that of previous period
Type* Variance-Based
Source @ Internal
Frequency @ Daily
Measure Scale Number Currency
Owner’ OFSAD
Caution User* OFSAD Critical User” OFSAD

Comments @ KI Comments

& Hide
Measures and Formula

Reporting Element Map (0) 5 Lne BB pelink

Thresholds (3) + pefine Limits ~ Delete Limits | Update  View Rating Scale

Lower Limit Upper Limit Score Rating

-10 10 1 Green

-100 11 9 Red

Help
Opel

In the Threshold section, you can view the list of Limits.

Click View Rating Scale to view the rating assigned to each score. Based on the score the rating

scale is classified as Green, Amber or Red.

8.7.3 DQ-Control Mapping Utility

Perform the following steps to access DQ_Control Mapping Utility:

1.
2.
3.

In DGECR, navigate to Common Tasks-> Operations-> Batch Execution.

Select DQ_MDRM_CTRL_MAPPER batch from the Batch Details grid to execute the batch.

To map the created controls to the DQs, navigate to the Batch Execution and execute the batch

DQ_MDRM_CTRL_MAPPER.

This will map N_CONTROL_KEY from the DQs present in the fsi_control_dq_map table to the pre-
seeded entries in the fsi_rr_ctl_map.

8.7.4 Viewing Measures in Formula

To view a Formula, perform these steps:

1.

In DGECR, click Key Indicators

The Key Indicators workspace appears.
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ORACLE' Data Governance for European Central Reporting

[F mbox  standards & Policies  Controls @ KeyIndicators  Process Monitoring

Issues & Actions & Admin
Key Indicators
Search "D Clear ®Go
oX=) Name @
Owner @

Key Indicators (167)

E Name
[0 4g8208 Votina Share Percent In Fact Entitv Parent Information
[0 488204 Value Of Mitiaant In Reportina Currency In Fact Mitioants
O ag8203 Value Adiustment And Provisions In Reaulator Account Summary
[0 sss201 Unrealized Gain And Loss Amount In Reoortina Currency In Reaulatorv Account Summary
[0 4gs100 Undrawn Amount In Reportina Currency In Reaulatorv Account Summary
O sss185 Underlvina Exposure Amount In Fact Reaulatorv Counterpartv Cabital Summarv
[0 4g8178 Total Reaulatorv Canital Of Entity In Reportina Currency In Fact Leaal Entity Details
[0 ass175 Total Gain And Loss Amount In Reportina Currency In Reaulatory Account Summary
[ ass170 Total Assets Of Entitv In Reportina Currency In Fact Leaal Entitv Details

E

&

5

[

E

&

&

[

E

Owner

OFSAD

OFSAD

OFSAD

OF$AD

OF$AD

OFSAD

OFSAD

OFsAD

OF$AD

OFSAD |

@

[E

®

[4

[

2

®

[4

[

Monday, August 27,2018 #orsas (B svout @ ogout

Help

i

© Oracle. All ights reserved

In the Key Indicators section, in the ID column, select the link of the required KI.

The Key Indicators Details section appears with the Details tab open by default.

Description €  This Column Stores The Voting Percentage
Owner OFSAD

Entity Name @) FACT ENTITY PARENT INFORMATION

KI Conditions (1)

Rigport Himport

£ Dv Report Schedule Cell Reference KI Condition

[0 saz69 Fl40 FI4001 FI4001C120 (=) VOTING RIGHTS (%)

Type

(@) Variance-Based

. . OFSAD | Tuesday, August 28, 2018 8 oFsan About Logout.
ORACLE’ Data Governance for European Central Reporting
3 mbox Standards & Policies Controls Q& Key Indicators Process Monitoring ) Issues & Actions & Admin
Key Indicators >> Key Indicator Details Help.
Details Kl Metrics. Issues and Actions
Name* ) Voting Share Percent In Fact Entity Parent Information D@ 488206

Attribute Name @ VOTING SHARE PERCENT

In the ID column, click the link of the required KI.

The Key Indicator Condition Details section appears, with the Details tab open by default.

ORACLE' Data Governance for European Central Reporting

5 mbox standards & Policies Controls qt Key Indicators Process Monitoring |-| Issues & Actions a Admin

Key Indicators > Key Indicator Details >> Key Indicator Condition Details
Details | KiMetrics

Name* @ VOTING RIGHTS (%) D@ 69769
Description @) This Key Indicator compares the value of voting rights (%) as of current period with that of previous period
Type* @ Variance-Based
Source @ Internsl
Frequency @ Daily
Measure Scale @) Number Currency @)
Owner* € OFSAD
Caution User* @ OFSAD Critical User* @ OFSAD

Comments € KI Comments

B Hide

[ Measures and Formula

Reporting Element Map (0) {3 e EH pelink 1=

Thresholds (3) + pefine Limits  Delete Limits | Update ~ View Rating Scale

2 [0 Lower Limit Upper Limit Score Rating
] -10 10 1 Green
] -100 -11 9 Red

OFSAD | Tuesday, August 26, 2018 BB oFsan 15 about 8l Logo

Help
Ope]

]
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4. Inthe Threshold section, you can view the list of Limits.

5. Inthe Measure and Formula section, view the formula.
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9

Issues and Actions

This chapter explains the process of creating issues for problems or deficiencies that arise during the
execution of a plan, which require attention and resolution, and describes the process of identifying the
corrective actions for these issues. When you identify a particular issue or a problem statement that
poses a risk, you can create issues and subsequently create necessary action plans to resolve or
address such issues.

Organizations use action plans to address a particular issue that has occurred. Users mapped to the
role of Issue Owners or Action Creators can create Action Plans for their Issues.

This chapter includes the following topics:

e Aboutissues and Actions

e |ssues

e Managing Issues

e Actions

e Managing Actions

9.1 About Issues and Actions

9.2

An issue is a problem statement or a matter requiring attention. Actions are plans or activities taken up
to resolve those issues. Actions are corrections activities that are planned to remediate an issue and are
assigned to individual users for updates and completion.

Organizations may need to identify and track issues whenever there is an alarming situation, such as
when an incident is reported, Key Indicators (KIs) are breached, a risk is assessed as high, control is
assessed as ineffective, regulation is breached, and so on. It can be created out of ineffective controls,
breached key indicators, or as a result of delays in the completion of tasks process monitoring. It can
also be created to track change management, for example, the change of a metadata and its impact on
all the related metadata objects.

Issues can be created either from the Issues & Actions menu or from other the Controls menu,
whenever the parameters are alarming and require issue creation.

Actions are created to remediate an issue. After the actions are closed the issue is reviewed for closure.
Therefore, ensure that you complete all actions to close an issue. Action plans aim at estimating the
cost involved in addressing issues. If the cost of taking up the action is more than the risk involved in the
issue, an organization can choose to close the issues without any actions.

Issues

This section includes:

e User Roles and Actions

e Issue Workflow

e Tasks and Notifications in Issues
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9.2.1 User Roles and Actions

All users are required to be mapped to DGS EBA AUTHORIZER GROUP, DGS EBA
ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP groups along with their respective
groups.

This section provides information on the user roles and actions in the Issues module.
User Roles

This module is designed for users mapped to the roles of Issue Creator, Issue Owner or Action Creator,
and Action Owner. Their roles and responsibilities, as they operate within the application, include the
following:

e Issue Creator: This user is responsible for creating an issue and helping the organization to track
the progress of an issue till its closure. This user can assign a created issue to an Issue Owner
and reopen closed issues.

e Issue Owner or Action Creator: This user is responsible for assessing the issue created by the
Issue Creator, adding issue details, and creating adequate action plans to resolve the issue. This
user can assign a created action to an Action Owner and reopen the completed actions.

Actions
The User Roles described above can perform the following actions:

e Creating Issue: This action allows an Issue Creator to create a new issue identified by an
organization.

e Creating Action: This action allows an Issue Owner to create new action plans or link existing
action plans from the Issue Details page to resolve an issue.

o Deleting Issue: This action allows an Issue Creator to delete an issue in the Draft state if the
Issue Creator believes that the particular issue is no longer required.

e Closing Issue: This action allows either an Issue Creator to close an issue when all the
associated actions have been completed.

¢ Reopening Issue: This action allows an Issue Creator to reopen a closed issue.

e Transferring Ownership: This action allows an Issue Owner to transfer the ownership of an
issue to an appropriate user.

e Exporting Issue: This action allows the user to export the list of issues into an Excel format.

9.2.2 Issue Workflow

The following figure displays the complete workflow of the Issues module:
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' 3 stat

( [5‘ Creation of Issue by Issue Creator.

[ Role:lssue Creator |

| Capture additional details of the Issue. Identify an lssue Owner &Submiﬂ

@ [ Role: Issue Creator |

J

A

7

!' Create Actions forthe Issue, update Issue Cost, Action Cost and otherw
@ Issue details. Also assign a Action Owner for each related Action.

[ Role: Issue Owner ]

J

L

| When all the actions forthe Issue are complete, the Issue Owner can T

% choose to close the Issue.

Role: Issue Owner

A
o

after closure.

[ Rale: Issue Creator |

| The Issue Creator can reopen
the Issue if the lssue persists

71 Closed I

Open

Closed

The status flow of the Issues module is as follows:

New Issue

Saved as
Draft

Open

Closed
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9.2.3 Tasks and Notifications in Issues

Tasks are actionable items assigned and sent to a user. By performing these tasks, you complete the
workflow defined in the module. Notifications are messages sent to a user stating that an action has
been performed in the application. Both Tasks and Notifications can be viewed from the Inbox menu in

the application.

The following table lists the tasks and notifications that each user role will receive in their Inbox menu on
performing a particular action.

Action
Performed

Task/Notificat
ion

Task/Notification
Description

Sent To

Status

Action by Issue
Owner or Action
Creator

Action Owner that
was selected in the
Owner field.

Submitting an Task A Task is sent to the | Issue Owner Open
Issue Issue Owner that
was selected in the
Owner field.
Transferring the Task A Task is sent to the | Issue Owner Open
Ownership of an new Issue Owner
Issue that was selected in
the Transfer
Ownership window.
Transferring the Notification A Notification is sent | Issue Creator Open
Ownership of an to the Issue Creator
Issue who created the
issue.
Closing an Issue. Notification A Notification is sent | Issue Creator Closed
to the Issue Creator
who created the
issue.
Reopening an Task A Task is sent to the | Issue Owner Open
Issue by Issue Issue Owner that
Creator. was selected in the
Owner field.
Submitting an Task A Task is sent to the | Action Owner Open

9.3 Managing Issues

This section includes the following:

e Creating an Issue

e Managing Issue Details

e Transferring Ownership of an Issue

e Closing an Issue
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e Reopening Closed Issues

e Deleting an Issue

e Exporting List of Issues to Excel

e Creating Actions from Issues

9.3.1 Creating an Issue

While creating an Issue, the fields that appear are explained as tabulated.

9.3.1.1 Fields and their descriptions

Fields Description

Fields marked in blue asterisk(*) are mandatory

Name* A short description for the issue.

ID A unique id for the issue (auto generated).

Description A long description for the issue.

Issue Category Select the classification type of the issue from the drop-down box:

Data Authorization
Data Security
Data Privacy

Data Accuracy
Data Availability
Timeliness

Criticality* Select the level of criticality of the issue from the drop-down
box:

. High
° Medium
. Low

Target Date* Select a target date from the calendar.

Owner* Select the User, from the hierarchy button, who owns and tracks
the resolution of the issue.

Issue Source* Select the source of the Issue from the hierarchy button which
the Issue must be created.

Primary Source Select the required entity in the source function for which the
Issue is to be created. This is only active if input is provided for
a Component.

Comments Provide additional information if any.
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9.3.1.2 Procedure to Create an Issue

When you identify a particular issue or a problem statement that poses as risk to an organization, you
can create issues either from the Issues & Action module or from the Controls menu in the

application, and subsequently create the necessary action plans to resolve or address the identified
issue.

Only users mapped to the role of Issue Creator can create a new issue from the respective modules.
To manually create an issue from the Issues & Actions menu, perform the following steps:

1. When creating issues from the Issues & Actions module, select Issues, in the Issues section
click Create Issue. The Issues Details page appears.

Or

When creating issues from other modules in the DGECR application, navigate to the respective
module details page and click Create Issue. The Issues Details page appears.

; - SFSAD | Wednesday, AUGUt 0, 2076 BN OFS I 2o S [GaaE
ORACLE' Data Governance for European Central Reporting T v A

9 mnbox Standards & Policies Controls qc Key Indicators Process Monitoring |i| Issues & Actions ‘ Admin

FdsaveDraft ™ submit @ cancel

Name* @ 1335851

Issue Category B
Criticality B
Target Date” b 4 Owner* OFsAD X

Issue Source™ Primary Source

Enter the required information in the available fields.
3. Click Save Draft to save the information.

A confirmation message appears, confirming that the operation was successful.
4. Click OK.

The Issues Details page appears and the state of the issue changes to Draft. You can edit,
update, or submit the issue to the Issue Owner.

Or,

Click Submit to save issue and submit it to the issue to the Issue Owner. A confirmation dialog
box appears confirming that the operatiion was successful.

5. Click OK.

The Issues Details page appears and the state of the issue changes to Open. A new issue is
created.

9.3.2 Causes

In the Causes section, you can view the details of the Key Indicator or the Data Quality that failed the
staging.

1. In DGECR, click the Issues & Actions tab, and then click Issues.
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The Issues workspace appears.

In the Issues section, in the ID column, select the link of the required issue.

The Issue Details section appears.

Click the Causes tab.

You can view the Data Quality ID details which failed at the staging. In the Causes tab:

You can view the Key Indicator ID details that failed at staging. Therefore, this failed Key Indicator
is the source of the Issue associated with it.

N R OFSAD | Wednesday, August 29, 2018 8B OFsas ‘about B Logout
ORACLE’ Data Governance for European Central Reporting
9 mnbox Standards & Palicies Controls q& Key Indicators Process Monitoring |-| Issues & Actions & Admin
lssues *> lssue Details Help
. o
[ Close Issue @ Transfer Ownership & Show Data pen
Detail: Causes
Issue
+
Name TEST
Data Quality (0) =
£ pab v DQMName Total Row Count Failed Rows
No Data Found
GL Reconciliation Failure (0) =
% RunbD < Definition Name GL Date Reconciliation Amount
No Data Found
Or,

You can view Data Quality ID details that failed at staging. Therefore, this failed Data Quality is
the source of the Issue associated with it.

Or,

You can view the GL Reconcilation Failure details that failed at staging. Therefore, this failed GL
Reconcilation Failure is the source of the Issue associated with it.

In the Issue Details page, if the Issue Source is Control, then the Data Quality details are displayed in the Causes
tab. Or, if the Issue Source is Key Indicator, then the Key Indicator details are displayed in the Causes tab.

The Control Details page appears.

To view the unique Assessment ID along with the Score, Rating, and Status of the Assessment,
click the Assessments tab.

To view the Assessment Parameter details and Assessment Data Quality Execution details, click
the Control Assessment ID.

9.3.3 Managing Issue Details

The Issues Details page allows you to manage additional tasks and functionalities pertaining to the
Issues. This section covers the following topics:

Editing an Issue
Managing Details

Managing Linkages

Editing an Issue

In the Issue Details page, you can update or modify the issue details as well as edit an issue.
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Users mapped to the role of Issue Creator can view the details of all the issues in the Issues page, but
can edit only the issues that they created. An Issue Owner can edit an issue in an Open state whereas
an Issue Creator can only edit an issue that iis in a Draft or Open state.

9.3.3.11 Editing an Issue
To edit an issue in a Draft state, perform the following steps:

1. In DGECR, click the Issues & Actions tab, and then click Issues.
The Issues workspace appears.

2. Inthe Issues section, in the ID column, select the link of the required issue.
The Issue Details section appears.
From the Details tab, click Edit. Modify the required issue details.

4. Click Update to save the information.
A confirmation message appears, confirming that the operation was successful.

5. Click OK.
The Issue Details page appears and the status of the issue remains in Draft.
Or:

Click Submit to save the entered information and submit the issue to the Issue Owner for further
action. A confirmation message appears, confirming that the operation was successful.

6. Click OK.

The state of the issue changes to Open.

9.3.3.2 Managing Details

This section covers the following topics:

e Attaching and Deleting Documents

Attaching and Deleting Documents

The Issue Details page allows you to attach or delete documents related to an issue. Refer to
Managing Documents section for more details.

9.3.3.3 Managing Linkages

When an issue is in the Open state, the Issue Owner can link and delink the records of entities to the
respective sections such as Controls and Key Indicators from the Linkages tab.

You cannot perform link or delink action when the status of an issues is in Closed.
This section includes the following topics:

e Linking a Record to an Issue

e Delinking a Record to an Issue

9.3.3.31 Linking an Record to an Issue

To link an entity record, such as controls or Key Indicators to an issue, perform the following steps:
1. Log in to the application as an Issue Owner.

2. Navigate to the Issue Details page of an issue that is in an Open state.
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Expand the View More section.

The Actions and Documents sub-sections appear.

In the Actions sub-section, select the required action item and then click the Link icon.

A window with a search bar and a list of pre-filtered records appears in various statuses. The
following table displays the statuses of records that you can link to each entity:

Controls Open

Key Indicators Open

Search for the required entity record using the search bar and then select the entity record from
the List section.

Or:

Select the required entity record from the List section that already displays the pre-filtered list of
entity records through a default search criteria.

Click Link.
A confirmation window appears, confirming that the records have been successfully linked.
Click OK, and then click Back.

The linked entity records are displayed in the respective entities section. You can click the ID of
the linked record to navigate to the respective entity details page.

Delinking a Record from an Issue

To delink entity records such as controls or Key Indicators from an issue, perform the following steps:

1.
2.
3.

Log in to the application as an Issue Owner.

Navigate to the Issue Details page of an issue that is in an Open state.
Expand the View More section.

The Actions and Documents sub-sections appear.

Expand the required section where you want to delink a record.

. . [ pelink
Select check box next to the required record(s) and then click the icon.

A confirmation message appears, asking you to confirm that you want to delink the records.
Click OK.

A message appears, confirming that the de-link operation was successful.

Click OK.

The record is delinked from the selected entities.

You cannot delink a primary source record from the entities section. If you try to delete a primary source record,
the following message appears: ‘The selected record cannot be delinked as it is a primary source record for the

issue.’
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9.3.4 Transferring Ownership of an Issue

When the owner of an issue has changed for reasons such as the Issue Owner user has quit the
organization or moved to a different role, and so on, an Issue Owner user can transfer the ownership of
the issue to an appropriate user by using the Transfer Ownership option in the Issue Details Page or
from the Issues page

To transfer the ownership of an issue, perform the following steps:

1. Navigate to the Issues page. Select an issue in Open status, and click Transfer Ownership. The
Ownership Transfer window appears.

Or:

From the Issues Details page of an issue in Open status, click Transfer Ownership. The
Ownership Transfer window appears.

2. Select a new owner from the hierarchy browser window.
Enter any comments in the Comments fields.

4. Click Submit. A Confirmation dialog box appears, with the message: ‘Update Operation
Successful.’

Click OK.
6. Click Back.

You are navigated to either the updated Issues and Search List page or the Issues Details
page from where the transfer of ownership action is performed.

9.3.5 Viewing the Data of an Issue

In the Issue Details page, you can view the pre and post adjusted data of a selected issue by the
adjustment name, MIS date, and Batch ID. Additionally, you can also download this data in an Excel
format.

To view the data of an issue:
1. Navigate to the Issues page.
2. Inthe ID column, select the link of the required issue.

3. The Issue Details section appears.

_ Show Data
In the upper-left corner of the section, select the icon.

The Adjustment Data window appears.

In the Adjustment Name drop-down box, select the adjustment name.
In the MIS Date drop-down box, select an MIS date.

In the Batch Id drop-down box, select a batch ID.

Click the Show Data button.

The pre and post adjusted data list is populated.

© N o g &
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P =

(@ Not secure | 10.184.156.31:5020/0FSAA300/A
Filters
Adjustment Name MIS Date Batch Id
12/31/2015 v DMINFO_ADJUSTMENT_BATCH_20151231_34
BEL Adj -

¥ Show Data V" Export Data

Pre and Post Adjusted Data (5900)

Account Number GAAP Code MIS Date Load Run Id Account Branch Code Pre Account Branch Code Post
CASA30784 USGAAP 2015123 29 WFBRANCHOOM JIGIOT

CASA30793 USGAAP 20151231 29 WFBRANCHOD1 JIGIO1

CASA30795 USGAAP 2015121 29 WFBRANCHOD1 JIGIO1

CASA30801 USGAAP 20191231 29 WFBRANCHOD1 JIGIO1

CASA30805 USGAAP 20151231 29 WFBRANCHOD1 JIGIO1

CASA33484 USGAAP 20151231 29 WFBRANCHOD1 JIGIO1

CASA33485 USGAAP 20151231 29 WFBRANCHOD1 JIGIO1

CASA33489 USGAAP 2015121 29 WFBRANCHOD1 JIGIO1

CASA33450 USGAAP 2015123 29 WFBRANCHOOM JIGIOT

CASAA3498 LISGAAP 20151231 29 WFRRANCHON1 JIGINT T

_— = ]

9. Additionally, click the Export Data button to download the adjustment data.

9.3.6 Closing an Issue

You can close an issue when you have completed all the actions created for an issue or you believe
that the identified issue is no longer relevant.

When you want to close an issue, the status of all the associated actions must be in the Completed state. If you try
to close an issue without completing all the actions associated with it, the following message appears: ‘Please
close all actions associated with the Issue.’

To close an Issue, perform the following steps:
1. Navigate to the Issues page.
2. Select an issue that is in an Open state, and then click Close Issue.
3. The Issue Details page appears.
Or

: . . . I8 Close Issue
From Issues Details page of an issue that is in an Open state, click the icon

In the Comments field, enter a reason for the closure of the issue.

Click Submit.

A confirmation message appears, confirming that the update operation was successful.
6. Click OK, and then click Back.

You are navigated to either the updated Issues and Search List page or the Issues Details page from
where the closure action is performed. The state of the issue changes to Closed.
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9.3.7 Reopening Closed Issues

An Issue Creator user can reopen a closed issue if the user believes that there is a need to re-examine
the issue or the issue that was closed is still existing in the organization, or the actions plans initiated to
mitigate the issue were not satisfactory.

Only users mapped to the role of Issue Creator can reopen closed issues.

To reopen a closed issue, perform the following steps:

1
2
3.
4

8.

Navigate to the Issues page.

In the Issues section, in the ID column, select an issue that is in a Closed state.
Click Reopen Issue.

The Issue Details section appears.

Or,

From the Issues Details section of an issue in a Closed state, click Reopen Issue.
The Issue Details section appears.

In the Comments field, enter comments.

Click Submit.

A confirmation message appears, confirming that the update operation was successful.
Click OK.

The Issue Details section appears.

Click Back.

You are navigated to either the updated Issues and Search List page or the Issues Details page from
where the reopening actions are performed. The state of the issue changes to Open.

9.3.8 Deleting an Issue

Users mapped to the role of Issue Creator, or Issue Owner can delete issues in a Draft state if they are
not applicable to the business or an organization.

You can delete an issue only when it is in a Draft state.

To delete an issue, perform the following steps:

1.
2.
3.

Navigate to the Issues page.

Select an issue that is in Draft status.

Click Delete Issue.

A confirmation message appears, asking you to confirm that you want to delete the issue.
Click OK.

A confirmation message appears, confirming that the deletion was successful.

Click OK.

The selected issue is deleted. You are navigated to the updated Issues page.

9.3.9 Exporting a List of Issues to Excel

You can export the list of issues displayed in the Issues page to an Excel format.
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You cannot export individual issues to Excel.

9.3.10

Refer to section Exporting Records for more details.

Creating Actions from Issues

An organization can create action plans when they want to record a recommended action plan to
address a particular issue that have occurred. Users mapped to the role of Issue Owner or Action

Creator can create action plans or new actions for an issue.

To create action plans for an issue, perform the following steps:
1.
2.

Navigate to the Issues page.

In the Issues section, in the ID column, click the link of the required Issue.

The Issues Details section appears.

Expand the View More sub-section. The Actions, Document, and Workflow History sub-

sections are displayed.

Create Action

In the Actions sub-section, click the

The Actions Details section appears.

Issues »> Issue Details »> Action Details

Details

Name* @)

Dascription @

Criticality” €)
Start Date” @)

Reminder(days)” @

Component* @ Control

Action Type* @

Comments )

ORACLE' Data Governance for European Central Reporting

& mbox Standards & Policies Controls Qt Key Indicators Process Monitoring |-| Issues & Actions & Admin

D@ 13302

B Oowner* @
B X Target Date* @
Progress @

Primary Source @

OFSAD | Wednesday, August 20, 2018 #B Ofses 15 About S Logews

Help
Status:  New

fsave Draft submit [ cancel %

# X
&8 X

Enter the required information in the following fields:

Fields

Description

Fields marked in blue asterisk(*) are mandatory

Action Name

A short description of the action.

High/Medium/Low.

ID A unique id for the action (auto generated).
Description Provide a long description for the action.
Criticality Select the level of criticality of the action plan such as
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Fields

Fields marked in blue asterisk(*) are mandatory

Description

Start Date

Enter the start date of the action plan.

Target Date

Enter a target date for completion of the action.

Owner

Select the User who owns and tracks the resolution of the
action.

Reminder Days

Enter the number of days before which the action assessor has
to be intimated to complete the action

Progress

This field is enabled for an Action Owner to update the measure of
completion of action plan.

Note: By default, this field is disabled when the action is
created.

Component

Select the component for the action

Primary Source

Select the particular entity in the source function for which the
automatic issue is being created

Action Type

Data Adjustments - DQ errors: This value indicates that it is a Data
Quiality error, which requires Data Adjustments. Here, the table and
column names, and location of the error are known to the User.

Data Adjustments - Others: This value indicates that the error
requires Data Adjustments. Here, the User does not know the
location of error, or the table or column name.

Others: This indicates the existence of error that is not a Data
Adjustment error.

Comments

Provide additional information if any

6. Click Save Draft to save the information entered in the details page.

A confirmation dialog box appears, confirming that the operation was successful.

7. Click OK.

You are navigated to the Actions Details page and the state of the issue changes to Draft.

Or

Click Submit to save the entered information and submit the action to the Action Owner for taking

further actions.

A confirmation message appears, confirming that the add operation was successful.

8. Click OK.

You are navigated to the Actions Details page and the state of the action changes to Open.

A new artinn is created and a task is sent to the owner of the action for taking further actions.

B Link

You can also use the icon to link the various actions that are applicable to the current issue.

9.4 Actions

This section includes:
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User Roles and Actions

Action Workflow

Tasks and Notifications in Actions

9.4.1 User Roles and Actions

This section provides information on the user roles and actions in the Actions module.

User Roles

This module is designed for users mapped to the roles of Issue Owner or Action Creator, Issue Creator,
and Action Owner. Their roles and responsibilities, as they operate within the application, include the
following:

Issue Owner or Action Creator: This user is responsible for assessing the issue created by the
Issue Creator, adding issue details, and creating adequate action plans to resolve the issue. This
user can assign a created action to an Action Owner and can also reopen the completed actions.
The user needs to be mapped to the DGISASRGRP group.

Action Owner: This user is responsible for assessing the actions created by the Issue Owner,
implementing action plans pertaining to an issue and tracking them to completion. This user can
update the percentage completion of actions, activities performed and cost incurred in carrying
out the actions. The user needs to be mapped to the DGS EBA AUTHORIZER GROUP, DGS
EBA ADMINISTRATOR GROUP, and DGS EBA ANALYST GROUP along with the DGAAGRP

group.

Actions

The user roles described above can perform the following actions:

Deleting Action: This action allows an Issue Owner or Action Creator user to delete an action in
the Draft state when an Issue Owner or Action Creator believes that the action is no longer
required.

Force- Closing Action: This action allows an Action Creator or Issue Owner user to close an
issue when associated actions have been completed.

Reopening Action: This action allows an Issue Owner or an Action Creator to reopen closed
actions.

Transferring Ownership: This action allows an Action Owner to transfer the ownership of an
action to an appropriate user.

Exporting Action: This action allows all user roles to export the list of actions to a Microsoft
Excel spreadsheet.

OFSAA DOCUMENT TITLE | 91



9.4.2 Actions Workflow

Actions Workflow

Creation of Action by |ssue Owner

Newy
Roie: Issue Owner
Capture additional details of the Action. |dentify an Action Owner & Submit Draf
raft
Role: Issue Owner
/ldentify Stakeholders, create activities for the action, define updates and modify other
Action details. Open
& Role: Action Owner
When the Progress of the Action reaches 100%, the Action is Completed. The action
can be force closed too. Complete

& Role: Action Owner

l

The lssue Owner can reopen the
Action if not satisfied with the
closure.

Role: Issue Owner

Y

(o)

The status flow of the Actions module is as follows:
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New Action

Saved as
Draft

Open

Complete

9.4.3 Tasks and Notifications in Actions

Tasks are actionable items assigned and sent to a user. By performing these tasks, the appropriate
user completes the workflow defined in the module. Notifications are messages sent to a user stating
that an action has been performed in the application. Both Tasks and Notifications can be viewed from
the Inbox menu in the application.

The following table lists the tasks and notifications that each user role will receive in their Inbox

workspace on performing a particular action.

Action Task/Notificat Task/Notification
Performed ion Description
Submitting an Task A Task is sent to the Action Owner | Open
Action by Issue Action Owner selected in
Owner or Action the Owner field.
Creator
Submitting an Notification A Notification is sent to Issue Creator | Open
Action by Action the Issue Creator of the
Owner Issues mapped to the

action.
Transferring the Task A Task is sent to the new | Action Owner | Open
Ownership action ownerselected in

the Transfer Ownership

window.
Transferring Notification A Notification is sent to Issue Owner | Open
Ownership the Issue Owner who and Stake

created the Action and all
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the stakeholders holders

captured in stake holders

tab.
Completing the Notification A Notification is sent to Issue Owner | Closed
Progress of an the Issue Owner who and Stake
Action to 100% created the Action and all | Holders

the stake holders

captured in Stakeholders

tab.
Force closing an Notification A Notification is sent to Issue Owner | Open
Action the Issue Owner who and Stake

created the Action and all | holders

the stake holders

captured in Stakeholders

tab.

9.5 Managing Actions

This section includes the following:

Managing Action Details

Transferring the Ownership of an Action

e Closing an Action

¢ Reopening Completed Actions

e Deleting an Action

e Exporting a List of Actions to Excel

9.5.1 Managing Action Details

9511

The Actions Details page allows you to manage additional tasks and functionalities pertaining to the
Actions.

This section discuses the following topics:

e Viewing the Action Details

e Editing Action Details

e Managing Details

Viewing the Action Details

You can view the action details of an issue from the Issue Details section.
To view an action:
1. In DGECR, click the Issues & Actions tab, and then click Issues.
The Issues workspace appears.
2. Inthe Issues section, in the ID column, select the link of the required issue.

The Issue Details section appears.
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3. Click the View More oo

The Actions section appears.
4. Inthe ID column, select the link of the required action.
The Action Details workspace appears.

When creating an issue, in the Action Type drop-down box, if you selected the Action Type as Reconciliation
Adjustments, then you will be able to view the adjustment details in the Reconciliation Adjustments section.

OFSAD | Tuesday, September 4,2018  # orsan |5 apout @ Logout

ORACLE" Data Governance for European Central Reporting

3 mbox Standards & Policies Controls Qe Key Indicators Process Monitoring |i| Issues & Actions 6 Admin

Help

Issues >> Issue Details >> Action Details
Open

12 Force close Action (i@ Transfer Ownership
Details Linkages Associated Issues
Zedit =

Issue Name @ Issue in Control Assessment ID- 1025247
Name* @ Action0g17 D@ 1025445
Description
Criticality @ Medium Owner* @ OFSAD
Start Date* @  17-Aug-2018 Target Date* @ 19-Aug-2018

Reminder(days)" @ 1

Component* @ Control
Action Type* @ Reconciliation Adjustments

Comments

Adjustments (1) [add  Edit  Delete | View 'O Refresh
j:hg Adjustment Name Adjustment Table Status Effective From Effective To

208304 adj1708 STG_CARDS Aooraved )

@ Oracle. All rights reserved  ~

9.5.1.2 Editing Action Details

When you want to update or modify action plans associated with issues, you can edit an action from the
Action Details page. Users mapped to the role of Action Owner can edit an issue in the Open state,
whereas an Action Creator user can only edit actions that are in a Draft state.

To edit an action in the Open state, perform the following steps:
1. Navigate to the Action Details page.
The Action Details section appears, with the Details tab open by default.

[# edi
2. Click the Edit icon.

3. Modify the necessary action details.

You can also perform actions such as adding an activity, adding stakeholders, adding action updates, and viewing
the workflow. For more information, refer to Managing Details.

4. Click Submit.

A confirmation message appears, confirming that the update operation was successful.
5. Click OK.

The updated Action Details page appears.

9.5.1.3 Managing Details
The Details page allows you to manage additional tasks and functionalities pertaining to the Actions.
This section discuses the following topics:

e Adding Activities to an Action
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e Adding Action Updates

e Attaching and Deleting Documents

9.5.1.31 Adding Activities to an Action
To add an activity to an action, perform the following steps:

1. Navigate to the Action Details page of an action that is in an Open state.

2. Expand View More to display the list of sections.

3. Click Add Activity from the Activity section.
An activity row is added.

4. Select the check box to make the Activity editable.
Enter the Activity Name, Progress, Start date, End date of the activity, and any comments.

6. Click Save.
A confirmation message appears, comfirming that the updateoperation was successful.
7. Click OK.

A new activity is added in the activities section.

To delete an activity, select the row and click Delete Activities.

9.5.1.3.2 Adding Action Updates
To add an update to an Action, perform the following steps:
1. Navigate to the Action Details page of an action in the Open state.
2. Expand View More to display the list of sections.
3. Click Add Action Updates from Action Updates section.
An Action Update row is added.
4. Click the check box for the row to make the action update editable.
In the field Update Comments, add a comment.
6. Click Save Action Updates.
A confirmation message appears, confirming that the update operation was succesful.
7. Click OK.
A new update action is added in the Action Updates section.

To delete an action update, select check box next to each row and click Delete Action Updates.

9.5.1.3.3 Attaching and Deleting Documents

The Action Details page allows you to attach or delete documents related to an action. For more
details on how to attach and delete documents, refer to Managing Documents section.

9.5.2 Transferring Ownership of an Action

To transfer the ownership of an Action, perform the following steps:

1. From the Action page, select an action in Open status, and then click Transfer Ownership.
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The Ownership Transfer window appears.
Or:
From the Action Details page of an action in Open status, click Transfer Ownership.

The Ownership Transfer window appears.

@ Ownership Transfer - Mozilla Firefox e ——— - — [F=RE )
ar 10.184.156.31:5020/0FSAAB00/formsFramework/formsrenderer/MapRenderer.jsp e @ ﬁ =
Name @ TESTL D@ 1334422
Present Owner @) OFSAD MNew Owner* @) s X
Comments @

Submit Back -

In the New Owner field, click the ““ icon select a new owner from the Hierarchy Browser
window.

In the Comments fields, enter a comment.

Click Submit.

A confirmation message appears, confirming that the update operation was succesful.
Click OK, and then click Back.

You are navigated to either the updated Issues and Search List page or Issues Details page
from where the transfer of ownership action is performed.

9.5.3 Closing an Action

9531

Actions can be closed once they are complete. If all actions for an Issue are addressed, then Issues can
be closed. If an Action is abandoned mid-way, it can be force closed. Once all actions are closed, the
Issue can be closed.

Only users mapped to the role of Action Owner can close or force close actions. Only an Issue Owner
can close Issues.

Force-Closing an Action

You can force-close an action if it is no longer relevant to the associated issues. You can force-close an
action only when it is in the Open state.

To close an action, perform the following steps:

1.

From the Action page, select an actionthat is in an Open state, and then click Force Close
Action.

The Action Details window appears.
Or,
From the Action Details page of an action in Open status, click Force Close Action.

The Action Details window appears.
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@& Action Details - Moxilla Firefox EE

@ 10.184.156.31:5020/0FSAABDO/formsFramework/formsrenderer/MapRenderer,sp coo f?

Comments @)

Submit Back

In the Comments field, enter the reason for the closure of the issue.
3. Click Submit.

A confirmation message appears, confirming that the update operation was successful
4. Click OK, and then click Back.

You are navigated to either the updated Actions and Search List page or Action Details page
from where the closure action is performed. The state of the issue changes to Complete.

9.5.4 Reopening Completed Actions

Only a user mapped to the role of Issue Owner can reopen actions associated for an Issue.
To reopen a completed action by an Issue Owner, perform the following steps:

1. From the Action page, select an action that is in a Complete state, and then click Reopen
Action.

The Action Details page appears.
Or,
In the Action Details page of an action in the Complete state, click Reopen Action.

The Action Details window appears.

.' Action Details - Mozilla Firefox E S|
(6] 10.184.156.31:5020/0F5AAB00/formsFramework/formsrenderer/MapRenderer,jsp e @ ﬁ =
Comments @&

Submit Back

2. Inthe Comments field, enter a comment.
Click Submit.

A confirmation message appears, confirming that the update ioperation was succesful.
4. Click OK, and then click Back.

You are navigated to either the updated Action Search List page or the Issues Details page
from where the reopening actions is performed. The state of the issue changes to Open.

9.5.5 Deleting an Action

The Controls section allows you to delete Action Plans that are in a Draft state.
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Users mapped to the role of Issue Owner can delete Actions that are in a Draft state, if the Issue
Creation is turned on. If the Issue Creation is turned off, Users mapped to the role of Control Owner, can
delete Draft Actions linked to Controls. Users mapped to the role of Action Owner can delete issues in a
Draft state if they are not applicable to the business or an organization.

To delete an action in a Draft state, perform the following steps:
1. From the Action page, select an action that is in a Draft state.
2. Click Delete Action.
A confirmation message appears, asking you to confirm that you want to delete this record.

3. Click OK.
A confirmation message appears, confirming that the delete operation was succesful.
4. Click OK.

The selected action is deleted. You are navigated to the updated Action page.

9.5.6 Exporting List of Actions to Excel

You can export the list of actions displayed in the Action page to an Excel spreadsheet. Refer to
section Exporting Records for more details.

You cannot export individual actions to Excel.
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10 Data Adjustments

This chapter explains the process of an automated application configuration when a Data Quality failure
occurs at the staging. In this automated process, a system generated issue is assigned to the default
Issue Owner.

The Issue Owner (Action Creator) may undergo the change of ownership when required. The Issue
Owner creates Action of type Data Adjustment for this system generated Issue, and assigns it to the
Action Owner. As a result, in Actions, the Data Adjustment grid appears. Then the Action Owner
(Adjustment Creator) creates required Data Adjustment and makes data corrections for the failed Data
Quality.

The Adjustment Creator submits Data Adjustment to the Adjustment Approver (Issue Owner). After the
Issue Owner approves all the Data Adjustment definitions, the Data Adjustments are grouped in a Batch
and executed at the level of that Issue. After the successful execution of these Data Adjustments, the
Action Owners must mark the Action progress to 100% or mark the Action as completed.

This chapter includes the following topics:

e User Roles and Actions

e Settings for Data Adjustments

e Data Adjustment Creation

e Approve or Reject Data Adjustments

e Executing Data Quality after Data Adjustments

10.1 User Roles and Actions

10.1.1.1 User Roles

e Assign the ADJCREATGRP (Adjustment Creator) User Group to the Action Owner.
e Assign the ADJAPPGRP (Adjustment Approver) User Group to the Issue Owner.

It is not recommended to map the ADJCREATGRP and ADJAPPGRP User Groups to a single User since data
masking gets affected.

10.1.1.2  Actions Performed by the Users

Action Performed User Role

In the automated process, an Issue is Assigned to the Issue Owner

generated by the system

Creating Action for the system generated By the Issue Owner

Issue

Creating Data Adjustment By the Action Owner

Submitting Data Adjustment By the Action Owner

Data Adjustment Approval By the Issue Owner
Marking the progress of Data Adjustment By the Action Owner
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execution action to 100%

You must follow the sequence of order in the procedures in the following sections

10.2 Settings for Data Adjustments

10.2.1  Controls for Data Quality

To assess the data accuracy of the failed Data Quality through Controls:
1. Login as an Issue Owner, who is also a Control Creator.
2. Create a Control to perform the Data Quality Check.
3. Execute the Batches corresponding to the Data Quality.
A Control Assessment is also created. When this Control fails, an Issue is automatically generated by the system.

Refer to the OFS Data Governance Studio v 8 0 7 0 0 Runchart for Run Name/Batch ID. Refer to Control Creation
via Batches to create a Control for the required Data Quality Rule.

4. In the application, click Financial Services Data Governance for European Central Reporting.
5. Click the Data Governance for European Central Reporting option on the left side of the menu.

The Data Governance for European Central Reporting window opens, with the Inbox
workspace open by default.

ORACLE’ Data Governance for European Central Reporting OFsAD | wednesday august 9, 018 Mors (3 oo Wlisoos
=] mbox standards & Policies controls Q¢ Key ndicators Process Monitoring |i| Issues & Actions ‘ Admin
Help
B Search & Ciear search crter | © partorm search
Task Hame DueDate 7 <
EntityType ©  Select Al - staws
Tasks | Molifcations  Reassigned Tasks
A Tasks (17)
8 Reassion | 18 unwrso 1n > »
TaskiD | Task Hame Entity Hame Entty Type Entity Status Due Date OverdueBy  Staws Receied On | Completed On | Flag
024 BBL Acton Action Mot Applicable pen 20180020
820 BBL Test lssue Not Applicable open ey
80 Esc CONTEST action ot applicable open i
g9 Esc CONTRACT TEST lssue ot Appllcadte open mensz
g 2 Esc AckonDB17 Action Not Applicasle 1 Open ey
a1 2 . Issus Mot Applicable 1 open e
g7 102 lssue Mot Appllcadte 1 Open st
77 102535-Task Created Issus ot dpplicadle ot open P
g 1025347-TaskCrasted lssue Not Appiicadle wpew open wigosia
Bss  1025341.Task Craated lssue Nat Applicable Al g open e
813 3-Task Created ssus ot Applicable e open e
g1 1025350-Task Created Issue Mot Applicadie Wi 0ee 1 open el

6. Click Controls.

The list of all existing Control records appears. Search for the required Control Name by name or
ID.

7. Inthe ID column, click the link of the required Control ID.
The Control Details page appears.

To search for the failed Data Quality of this Control, follow the procedure in Causes.
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Standards & Policies

5 mbox

Controls >> Control Details

Details | Assessments

Name* @
Deseription @
Methodology* @
Owner* @

Financial Accuracy Check” @)

Comments @)

Data Quality Rules (1) [save =

Controls

Issues and Actions

ORACLE" Data Governance for European Central Reporting

Process Monitoring

Q¢ Key Indicators

(W) issues & Actions

& #dmin

Interest Payment Date in Stage Borrowings D@ 495733
Control for Stage BorrowingsInterest Payment Date

OFSAA Method

QFSAD Type* @ Quality Control

No

£ [ pata Quality Rule  Data Quality Rule Description Weight

[T DQFSDWDT0007  To Check Interst Date Should Be Less Than Or Equal To Clased Date 100

OFSAD | Monday, August27, 2018 @B OFsaa [ About B Logout

Hep  ©
Open

[# edit

I

©Oracle. Al rights reserved ~

8. Inthe Details tab, you can view the field details of the selected Control: Name, ID, Description,
Methodology, Owner, Assessment Start Date, Comments, Type, Frequency, and the Data

10.

11.

12.

Quality Rules section.

Click the Assessments tab.

- - oFSAT LU g i e g
ORACLE' Data Governance for European Central Reporting T T
£ inbex Standards & Policies Cantrols o,t Key Indicators Process Monitoring |i| Issues & Actions ‘ Admin
Controls > Control Detaits Help
Gpen
Deai ssessments | Issues and
control
+

Name jnterest Payment Date in Stage Borrawings

Control Assessments (0) (3 pelete Assessment

GL Recon Adjustment (782)

Adjustment 1D *  adjusted Amount GL Code Currency GAPP Code Legal Entity
GL81:42 4000 DEFAULT uso AUGAAP LEL
GLE1 M2 4000 DEFAULT usp AUGARP LEL
GL81342 4000 DEFAULT usD AUGRAP LE1
GL81.342 4000 DEFAULT usp AUGALP LE1
GLELML -537.521 DEFAULT AUD AUGAKP LEL
GL.81.341 -537521 DEFAULT AuD AUGAAP LEL
6L81341 -537.521 DEFAULT AUD AUGALP 21
GLE1ML -537.521 DEFAULT AUD AUGARP LEL
GL62.91 741164 DEFAULT AuD AUGARP shivalE7
6L62.91 741184 DEFAULT AUD AUGALP ShivalE7

Page 1 of79

DQ Execution Details (0)

In the ID column, click the link of the assessment whose details you want to view.

The Control Assessment Summary and Control Execution Details for the selected Control IDs
appear. The Assessment ID, Assessment Date, and Control Execution Date field values
corresponding to the selected Control ID appear too.

To change the Weight value of the Control ID Assessment Parameter, select the required
Parameter. You can also edit the value in the the Weight field.

Click Save.
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10.2.2

10.2.2.1

Issues and Actions for Data Adjustments

Issues for Data Adjustments

1. For the Control from the previous section, to view the Issue details, click the Issues and Actions
tab.

2. Click the Issue ID, which is system generated for this Control.

The state of the Issue is always Open.

10.2.2.2

10.2.2.2.1

3. Alternatively, you can access the Issues & Actions tab from the menu.

The system generated Issue is automatically assigned to the default Issue Owner.

OFSAD | Wednesday, August 26, 2018 M ofsas B snour M Logoune

ORACLE" Data Governance for European Central Reporting

A mbox Standards & Policies Controls Q Key Indicators Process Monitoring  |fff]) lssues & Actions & Admin

la >> Control Details Help

Issues (0)  pelete ;ssue ELink [ Delink

D Name Component  Issue Cateqory Actions Creator Owner Target Date  Status Last Modified

Mo Data Found

Actions (0)

4. The Issue section appears.

To find the cause for the Issue, follow the steps in the Causes section for the DQ failure.

Actions for Data Adjustments

The Issue Owner creates the required Actions for the system generated Issue and also, the Issue
Owner is the Data Adjustment Approver. In the Actions section, when you select the Actions of type
Data Adjustment, the Data Adjustment grid appears for this Action.

Creating a new Action

To create a new Action for the system generated Issue:
1. Inthe Issue Details page, click Create Action.
The Action Details page appears.

2. Inthe Owner field, select the Action Owner name, and then fill required details in all the other
fields. The Action Type dropdown box lists three values. They are:

e Data Adjustments - DQ errors: This value indicates that it is a Data Quality error, which requires
Data Adjustments. Here, the table and column names, and location of the error are known to the
User.

e Data Adjustments - Others: This value indicates that the error requires Data Adjustments. Here,
the User does not know the location of error, or the table or column name.

e Others: This indicates the existence of error that is not a Data Adjustment error.

3. This Action is related to the DQ error. Therefore, select the option Data Adjustments - DQ
errors.

4. To submit the newly created Action for approval (to the Action Owner), click Submit.

Based on the Action Type, the Data Adjustment details page will be displayed during the Data Adjustments
process for DQ errors or any other errors.
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5. A confirmation message appears, confirming that the add operation was successful.
6. Click OK.

10.3 Data Adjustment Creation by the Action Owner

The Action Owner is the Data Adjustment Creator. The Actions are of type Data Adjustment. Therefore,
the Data Adjustment grid appears in this section.

1. Log in to the application as the Action Owner (Data Adjustment Creator).
2. Click Data Governance for European Central Reporting.

3. Inthelssues & Actions tab, click Issues.

4. Inthe Issues workspace, click the required system generated Issue ID.

The Issue Details page appears. Expand View More. In the Actions section, click the Action ID
created in the previous section.

The Action Details page appears.
The Action is of Type Data Adjustment. Therefore, the Adjustments section appears.

10.3.1 Create Data Adjustment

1. Inthe Action Details page, in the Adjustments section, click Add.
The Adjustment Rule Details window appears.

In the Name section, type values in the Adjustment Name and Description fields. The
Adjustment ID is system generated.

2. To go to the next section, click Next or click Dataset.

3. Inthe Dataset tab, click the Select DQ dropdown box and select the required DQ value. This is
the failed DQ for which this Data Adjsutment is being created.

4. To go to the next section, click Next or click Attributes.
For Data Adjustments — Others Action type, the User can use Select Entity and Select DQ fields.

For Data Adjustments — DQ errors Action type, the values in the Select Entity and Select DQ fields are pre-
populated and frozen. Only one value is generated in the Select DQ field.

5. Inthe Attributes tab, select the required Assignmet Type, either User Input Assignment Type or
Rule Driven Assignment Type.

10.3.1.1 User Input or Rule Driven Type

10.3.1.1.1  User Input Assignment Type
The User Input Assignment Type provides the provision for input by the User.
1. Inthe Attributes tab, select the User Input option, and then click Add Attribute.
The Add Column window appears.
2. Click theTarget Attribute dropdown box and select the required value.
3. Click OK.
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10.3.1.1.2  Rule Driven Assignment Type

Rule Driven Assignment Type provides the provision for rule based input.
1. Inthe Attributes tab, select the Rule Driven option.
2. Click Add Expression.
The Add Expression window appears.
3. Select the required data for all the fields, and then click OK.
The selected value is populated in the Target Attribute section in the Attributes tab.
4. Select the Target Attribute.

To go to the next tab, click Next or click Review & Save.

10.3.1.2 Export and Import Data Updates

In the Review & Save tab:

10.3.1.2.1  For User Input Type Data Adjustment
Exporting User Input Type Data Adjustment

a. To export (download from the application) a record from the User Input type Data Adjustment,
click Export.

The Export window appears.

b. Select the MIS Date for which you are downloading the record to make the data corrections.
c. Click Export, and then close the Export window.

An excel file is downloaded to your system.

d. Inthe downloaded (exported) excel file, you can make the required data corrections in the
final column.

e. Save the changes made to the file.
Importing User Input Type Data Adjustment

f.  Toimport (upload to the application) the updated excel file for the User Input type Data
Adjustment, select the Manual Data Id of the required record, and then click Import.

The Import window appears.
g. To search for the updated excel file, open and attach it, click Attach.

h. To upload this excel file, click Upload. After the successful upload, an acknowledgement
message appears.

i. Then, to import the uploaded excel file into the application, click Import.

10.3.1.3 Save and Submit Data Adjustment

1. To save this Data Adjustment record, select the checkbox against the imported record, and then
click Save.

A confirmation message appears, confirming that the adjustment details were successfully saved.
2. Click OK.

3. To submit this Data Adjustment for approval to the Adjustment Approver, click Submit.
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4,

A confirmation message appears, confirming that the adjustment details were saved successfully.
Click OK.

The Adjustment Rules Details page automatically closes.

To send the imported file for approval to the Approver, you must select the checkbox against the record and then

click Save.
5.

In the Action Details page, click Refresh.

The newly created Data Adjustment is in the Pending Approval state.

After you click Save, and do not submit the Data Adjustment for approval, then the Status of the Data Adjustment
is in the Draft state. To move the Status from Draft to Pending Approval, open the Data Adjustment, and click

Submit.

10.4 Approve or Reject Data Adjustments

To view, and approve or reject the Data Adjustment, perform the following steps:

1.
2.

10.
11.

12.
13.

14.

Log in as a Data Adjustment Approver.

In the application, select Financial Services Data Governance for European Central
Reporting.

Click the Data Governance for European Central Reporting option on the left hand side of the
menu.

The Data Governance for European Central Reporting window opens with the Inbox
workspace displayed by default.

Click the Issues and Actions tab and then click Issues.

In the ID column, click the ID of of the required issue.

The Issue Details page appears.

Expand View More.

In the Actions section, in the ID column, click the required Action ID.
The Action Details page appears.

In the Adjustments section, select the required Data Adjustment which is in the Pending
Approval state.

To open this Data Adjustment details, click View.
The Adjustment Rule Details window appears.
Click the Review & Save tab.

Select the Manual Data Id, and then click Download.

The data correction records file uploaded to the system, by the Data Adjustment Creator, is
downloaded to your system.

Verify the data records and then in the Comments field, type the required comments.
To approve the Data Adjustment, click Approve.
The Adjustment Rule Details window automatically closes.

In the Action Details page, in the Adjustments section, click Refresh. The status of the Data
Adjustment is changed to the Approved state. In the account of Data Adjustment Creator, the
state of this Data Adjustment is updated to the Approved state.
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1041

15.

Or

To reject the Data Adjustment, click Reject. The Adjustment Rule Details window automatically
closes.

In the Action Details page, in the Adjustments section, click Refresh.

a. For arejected Data Adjustment, the state is changed to Draft.

b. Log in as a Data Adjustment Creator. The Data Adjustment State is in Draft.
c. Select the Data Adjustment ID and click View.
d

In the Adjustment Rule Details page, in the Review & Save tab, make the required correct
changes.

e. To save this Data Adjustment record, click Save.

A confirmation message appears, confirming that the adjustment details have been save
succesfully.

f. Click OK.
g. To re-submit this Data Adjustment for approval to the Adjustment Approver, click Submit.

A confirmation message appears, confirming that the adjustment details have been succesfully
updated.

h. Click OK.
The Adjustment Rules Details page automatically closes.

i. Login as a Data Adjustment Approver and Approve this Data Adjustment.

Summary of the Data Adjustment Approval Process

In the Approval process:

For the User Input Assignment Type:

a. The Data Adjustment definition with data correction record is created and submitted for
approval by the Data Adjustment Creator (Action Owner) as an actionable task to the Data
Adjustment Approver (Issue Owner). Additionally, each Action of the manual user input,
which is the excel sheet import action, is submitted for approval individually.

b. A workflow task is created for each FIC_MIS_DATE.

If the Data Adjustment record is approved by the Issue Owner (Data Adjustment Approver) then no
further actions are required.

If the Data Adjustment record is rejected by the Issue Owner (Data Adjustment Approver) then an
actionable task is generated for the Data Adjustment Creator (Action Owner) to resolve the problem and
re-submit.

Data Adjustment workflow for the User Input Assignment Type is: New Data Adjustment > Draft > Pending
Approval > Approved or Rejected

For the Rule Driven Assignmet Type:

a. The Data Adjustment definition with data correction is submitted for approval by the Data
Adjustment Creator (Action Owner).

b. Atask is created for the Data Adjustment Approver (Issue Owner).

If the Data Adjustment record is approved by the Issue Owner (Data Adjustment Approver) then no
further actions are required.
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If the Data Adjustment record is rejected by the Issue Owner (Data Adjustment Approver) then an
actionable task is generated for the Data Adjustment Creator (Action Owner) to resolve the problems
and re-submit. The State of the Data Adjustment is in Draft state till resubmission and approval.

The Data Adjustment workflow for the Rule Driven Assignment Type is: New Data Adjustment > Draft > Pending
Approval (If Data Adjustment is Approved, and then it is moved to the Approved state. Or, if Data Adjustment is
Rejected, then it is moved to the Draft state) > Approved

After the approval of all the Data Adjustment definitions, you must group and execute, at the level of an
Issue, the Data Quality rule associated with the required Data Adjustments.

10.5 Executing Data Quality after Data Adjustments

After creating Data Adjustments, perform these step-by-step procedures to check the Data Quality of
the data corrections made during the Data Adjustment process.

10.5.1

10.5.2

Batch Execution Rights

1. Select Financial Services Data Governance for European Central Reporting.

2. Navigate to Common Tasks > Operations > Batch Execution Rights.

The User Group — Batch Execution Map pane appears.

3. To select the required batch for mapping, in the Batch Map column, select the checkboxes
associated with the required Batch Names.

4. Click Save.

User Group - Batch Execution Map
User Group - Batch Execution Map

User Group - Batch Execution Map
Information Domain  pMINFO

© gatch Maintenance ) Enterprise Modeling © Run Rules Framework

User Group - Batch Execution Map
Batch Name
DMINFO_ADJUSTMENT_BATCH
DMINFO_ALM
DMINFO_AMHM_STG_DIM_DATA_LOAD
DMINFO_BULK_KLASSESSMENT
DMINFO_CAMPAIGN
DMINFO_COLLATERAL
DMINFO_COLLECTION_AND_RECOVERY
DMINFO_CREATE_CONTROL
DMINFO_CREATE_CONTROL_ASSESSMENT
DMINFO_CREATE ISSUES
DMINFO_CREATE_OP_CONTROLS
DMINFO_CRM
DMINFO_CRSA_TMP_DE_RESAVE
DMINFO_CUSTOMER
DMINFO_DATA FOUNDATION_SCD
DMINFO_DATA_FOUNDATION_SCD_MLS
DMINFO_DATA REDACTION
DMINFO_DEMVIEWS_REFRESH
DMINFO_DE_FSIMAP_POPULATE
DMINFO_DGPMPWorkflowlnitiate
NMINFO NG KT GRP RATCH PROCFSS

= ORACLE pata Governance for European Central Reporting

E| User Groups

Batch Description

ADJUSTMENT_BATCH

Data Quality batch for ALM tables

AMHM Dimension Data Load

This batch is to do assessment for Bulk KI for a given date,
Data Quality batch for CAMPAIGN tables

Data Guality batch for Collateral tables

Data Quality batch for Collection and Recovery tables

Create Controls

This Batch is used to create Assessments for the Controls
This batch is used for creation of Issues for a given MIS_DATE
Batch to create Operational Controls

Data Quality batch for CRM tables

Create or Refresh Temp DE for Report code CRSA

Data Quality batch for Customer tables

Data Foudation SCD for Loading Dimension Tables

Data Foundation SCD for Multi Language Support Dimensions
Batch for Data Redaction

DEMVIEWS_REFRESH

This Batch Resaves the Derived Entity and them populated the FSI MAP tables,
This is required to handle the Workflow calls for the backend flows of Issue creation
NG KT GRP RATCH PROCFSS

US-English ¥ OFSAD + a

©o o

@

Business Administrator B

Batch Map

CDEY’IEM © 1993. 2018 Oracle ar\d‘ml’ its affiliates. All r’\ﬁms reserved.

5. The batches corresponding to Data Quality must be executed. Refer to the OFS Data
Governance Studio v 8 0 7 0 0 Runchart for Run Name/Batch ID and their order of execution.

From the Runchart, perform the tasks from Task 1 to Task 12, and then Task 79.

Batch Maintenance

To create a new Batch:
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Navigate to Common Tasks > Operations > Batch Maintenance.

The Batch Maintenance pane appears on the right hand side.

) i ) = add |
To create a Batch, in the Batch Name section, click the icon.

The AddBatch Definition window appears.

@ AddBatch Definition - Moszilla Firefox (s e e |

'fﬁ 10.184.156.31:5020/0OFSAAB00/icc/Batch/Batch_Definition.jsp ooo ﬁ =
Batch Maintenance Q- '
Save Cancel
Batch Maintenance

m

Batch Name BATCH1 Batch Description

m

Duplicate Batch [ Batch ID

Sequential Batch [ B

Enter the required details in all the fields, and then click Save.

A new Batch is created.

In the Batch Maintenance pane, in the Batch Name section, select the Batch Name checkbox
associated with the the newly created Batch. The Task Details section appears, which lists the
tasks corresponding to the selected Batch Name.

To add a new Task to the newly created Batch, click the Add icon.
The Task Definition window appears.
In the Components dropdown box, select the RUN EXECUTABLE value.

The values are automatically generated for the Datastore Type, Datastore Name, and IP
Address fields.

In the Executable field, enter the value DataAdjustment.sh,<ISSUE NAME>.
For the Wait field, select either Y or N as required.

For the Batch Parameter field, select Y.

Enter the required details in all the other fields.

Click Save.

A new Task for the new Batch is created. You can run this Batch in the Batch Execution section.
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To check the success and failure status of the Adjustment Task, Log in to FSI_MESSAGE_LOG and
$FIC_DB_HOME/log/DGS/.

10.5.3

10.5.4

Batch Execution

1. Navigate to Common Tasks > Operations > Batch Execution.

The Batch Execution pane appears on the right hand side.

In the Batch Mode section, select the Run mode.

To select the required batch for execution, search for required Batch ID.

In the Batch Details section, select the checkbox associated with that Batch ID.

The Task Details section lists the tasks corresponding to the selected Batch ID.

In the Information Date section, click the calendar and then select the date on which the Data
Quality had failed and for which the data corrections are made.

To run the selected batch, click Execute Batch.

A message appears, asking you to confirm that you want to execute the batch for the selected

date.
Click OK.

A confirmation message appears, confirming that the batch was triggered successfully.

Click OK.

Batch Monitor

1.

2.

Navigate to Common Tasks > Operations > Batch Monitor.

The Batch Monitor pane appears on the right hand side.

— ORACLE pata Governance for European Central Reporting
Batch Monitor

Batch ID Like DMINFO_

Module [

Start Date i

Batch Details
BatchID 4
DMINFO_ADJUSTMENT_BATCH
DMINFO_BULK_KI_ASSESSMENT
DMINFO_CREATE_CONTROL
DMINFO_CREATE_CONTROL ASSESSMENT
DMINFO_CRSA_TMP_DE_RESAVE
DMINFO_DGPMFWorkflowlnitiate
DMINFO_DG_KI_GRP_BATCH PROCESS
DMINFO_DIM_BATCH
DMINFO_DIM_CONTROL_ASMT_RATING
DMINFO_DIM_CTL_EFF_PARAMETERS
DMINFO_DIM_DG_CONTROL
DMINFO_DIM_DQ_CHECK
DMINFO_DIM_DQ_GROUP
DMINFO_DIM_KEY_INDICATOR
DMINFO_DIM_REPORT_SUB_PLAN

Page 1 of7 (1-15 of 103 items) <>

Batch Run Details &% Start Monitoring  Stop Monitoring = Reset

9 @ [  UsEnglsh v  OFSAD ¥

o

@ search D Reset

Batch Description Like

Status B

End Date i

Batch Description

ADJUSTMENT_BATCH

This batch is to do assessment for Bulk KI for a given date
Create Contrals

This Batch is used to create Assessments for the Controls
Create or Refresh Temp DE for Report code CRSA

This is required to handle the Workflow calls for the backend flows of Issue creation
DG_KIGRP_BATCH_PROCESS

DIM_BATCH

DIM_CONTROL_ASMT_RATING

DIM_CTL_EFF_PARAMETERS

DIM_DG_CONTROL

DIM_DQ_CHECK

DIM_DQ_GROUP

DIM_DIM_KEY_INDICATOR

Plan Dimension Reporting Batch

Records Per Page 15

In the Batch Details section, select the Batch ID which was executed during the Batch Execution

steps.
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In the Batch Run Details section, click the Information Date drop-down, and then select the
MIS Date.This is the date on which the Data Quality had failed at the staging.

Click the Batch Run ID dropdown box and select the required value.
Click the Start Monitoring icon.

The Batch Status, Task Details, and Event Log sections are displayed in addition to the
existing details in the Batch Monitor pane.

Select any task in the Task Details section to view its Event Log details.
To generate an excel file for these Event Log details, click the Export icon.

After the successful execution of these Data Quality rules for Data Adjustments, the Action
Owners must mark the action progress to 100% or mark the Action as completed.
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11 Process Monitoring

This chapter explains the process of identifying the reporting plan.

This chapter includes the following topics:

User Roles and Actions

Process Monitoring Workflow

Creating a Reporting Plan
Linking the OFSAA Runs to a Plan

Linking the Tasks to Runs

Linking the Dependent Tasks to Tasks

Monitoring a Reporting Plan

Viewing a Reporting Plan

11.1 User Roles and Actions

All users need to be mapped to DGS EBA AUTHORIZER GROUP, DGS EBA ADMINISTRATOR
GROUP, and DGS EBA ANALYST GROUP, along with DGSPSI and PROCUSER.

Following is the user role and action for Glossary:

PROCUSER : Permits the user to access the processs monitioring module.

11.2 Process Monitoring Workflow

The following flowchart describes the Process Monitoring Workflow:
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New Plan

Saved as
Draft

Open

Closed

11.3 Creating a Reporting Plan

11.31

The reporting plan provides an overview of the timelines for the regulatory submission. It is activity
specific. For example, the plan for the regulatory report submission of one activity is different from
another. The plan includes the scope and schedule for tracking and completion.

To create a reporting plan, define the name, purpose, owner and additional attributes for the plan.
Additionally, you need to define the OFSAA runs and scope of the plan. You can choose any OFSAA
run as the scope and derive the tasks from all the runs in the scope.

Fields and their descriptions

Fields Description
Fields marked in blue asterisk(*) are mandatory
Name* Provide a short description of the plan.
ID Displays a unique ID for the plan (auto-generated).
Objective* Select an objective from the drop-down box:
Business
Management
Regulatory
Owner* Select the owner of the plan such who is the user that is
responsible for tracking the plan to closure.
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Fields Description
Fields marked in blue asterisk(*) are mandatory
Type* Select the plan type from the drop-down box:
Regulatory Report Submission
Management Report Submission
Description Provide a description of the plan.
Frequency* Select a frequency for the plan from the drop-down box:
Yearly
Half Yearly
Quarterly
Monthly

11.3.2 Procedure to Create a Reporting Plan

To create a Reporting Plan, perform the following steps:

1.

In DGECR, click Process Monitoring.

The Plans workspace appears.

ORACLE' Data Governance for European Central Reporting

& mnbox Standards & Policies Contrals Qe Key Indlicators Process Monitoring |i| Issues & Actions ‘ Admin
Plans

search O clear ®aco

D@ Name @
Plans (1)

Facreateplan  Delete Plan [l export

£ On Name Type Status

O se7513 Ouarterly reaulatory repart submission plan 1) Regulatory Report Submission Chen

Last Modified

23-Jun-2016

OFSAD | Thursday, August 30, 2018 o OFsaa About Bl Logout

Help

QQE Create Plan
Click the icon.

The Plan Details page appears.
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Details

g Inbox

Controls

ORACLE' Data Governance for European Central Reporting
Plans >>

Qe Key Indicators

Process Monitoring |i| Issues & Actions & Admin

OFSAD | Thursday, August 30, 2018

4. Click Save Draft.

5. Click OK.

3. Enter the required information in the available fileds.

n@ 1336342

Owner* @) OFSAD

Frequency”

©Oracle. All rights reserved

® orsas 5 sbout B Logout

Hep -

New

[ save Draft

The status of the plan changes to Draft.

You should schedule the plan before submitting.

6. The plan is submitted, and the status changes to Open.

following message: ‘Mandatory fields are not entered.’

To submit a plan, all mandatory fields (marked with an asterisk) must be filled. If not, the application displays the
11.4 Linking Reports to a Plan

E Inbox

Standards & Policies
Plan Details

Controls

Q¢ Key Indicators
Details

Name* @ Quarterly regulatory report submission plan
Objective* € Regulatory
Type* @ Regulatory Report Submission
B Hide
Biscope

Description @ Quarterly regulatory report submission plan

Regulatory Reports can be associated to a plan.

ORACLE’ Data Governance for European Central Reporting
Puans >>

Process Monitoring |i| Tssues & Actions

& Admin

OFSAD | Thursday, August 30, 2018

A confirmation message appears, asking you to click either OK or Cancel.

Reports (21) &, ink [ pelink

Report ID

D@ 487513

Owner' @ OFSAD

Frequency’ Quarterly
Report Name
2 CRSA
31 F02
37 F04
19 F0S

- o & Oracle. Al rights d

#orsen |5 about BlLogout

Hep

Open
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11.5 Linking the OFSAA Runs to a Plan

Data Governance for European Central Reporting facilitates mapping of OFSAA Runs to the plans
created in the Plan Details section. For the created plan, the user can link the Runs by selecting the
Link button in the Runs grid. All the selected runs will be displayed in the Runs grid.

Install another media pack to obtain the Run information. The runs available as a part of the applications in the
media pack can be made visible in Data Governance for European Central Reporting.

Metadata Publish is required to publish the Run related information.

& Runs - Internet Explorer

Link Close

B Runs (3) |14
L1 Run Name Run Code Run Description
1443686743571 PMSegBasel3Std_Scr PMSegBasel3Std PMSegBasel3Std_Scr
1443686743578 Risk Weighted Asset Calculation - C 1305907253832 Risk Weighted Asset Calculation - C.
1443686743540 USA- US Il - Minimum Tier 1 Levera RNBL0025 USA - US Il - Minimum Tier 1 Levera

11.6 Linking the Tasks to Runs

Data Governance for European Central Reporting facilitates the mapping of Tasks to Runs in the Plan
Details section. The Task button in the Runs grid allows the user to select the tasks. On clicking the
Task button, a window appears displays all the tasks under the selected Run. The selected tasks can

be seen in the Task grid under the Run grid.

[ Run Task Selection

Object Name
[=} PMsegBasel3std_Scr
=" [YIPM Basel lll Risk Weighted Asset Calculation - Credit Risk - BIS Standardised Approach
Non Sec Basel Product Type Assignment - STD
[¥I Mitigant Standard Issuer Type Assignment - STD
Non Sec Basel Methodology Assignment - STD
[¥INon Sec Off-Balance Sheet Drawn CCF Assignment - STD
[¥INon Sec CCF Assignment - STD
[¥INon Sec Pre-Mitigation EAD Amount - STD
[¥INon Sec Pre-itigation EAD Drawn Amount - STD
[¥INon Sec Pre-Mitigation EAD Undrawn Amount - STD
Basel | - ised Method
[VINON_SEC_RISK_WEIGHT_MAPPING_POPULATION

NON_SEC_RISK_WEIGHT_MAPPING_POPULATION

[VBasel -Non-Sec Approach - Option 1 - Banks
Non Sec Pre-Mitigation RW UL for Banks - Option | - STD

[ Basel | -Non-Sec d Approach - Option 1 - PSEs

Non Sec Pre-Mitigation RW UL for PSEs - Option | - STD

Submit | | Close |

Object Type
Run
Process
Computation Rule
Computation Rule
Computation Rule
Computation Rule
Computation Rule
Computation Rule
Computation Rule
Computation Rule
Computation Rule
Data Mapping
Data Mapping
Computation Rule
Computation Rule
Computation Rule

Computation Rule

Modified Date

23-Dec-2014

25-Jun-2012
25-Jun-2012
25-Jun-2012
25-Jun-2012
25-Jun-2012
25-Jun-2012
25-Jun-2012
29-Sep-2015
29-Sep-2015

25-Jun-2012

25-Jun-2012

Modified By Executable

SYSADMN

SYSADMN
SYSADMN
SYSADMN
SYSADMN
SYSADMN
SYSADMN

SYSADMN

MR N NN N N NN

SYSADMN
SYSADMN
SYSADMN T2T
SYSADMN
SYSADMN
SYSADMN

[CHECRICRNY

SYSADMN

11.7 Linking the Dependent Tasks to Tasks

Data Governance for European Central Reporting facilitates mapping of Dependent Tasks to Tasks in
the Plan Details section. The Dependent Task button in the Tasks grid allows the user to select the
dependent tasks. On selecting each task, the Dependent Task button is enabled and a window
appears in which the user has the provision to select the dependent task for the selected task. The

selected dependent task also appears in the Task Grid.
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E Dependent Tasks (57) | |

Task Name
NON_SEC_RISK_WEIGHT_MAPPING_POPULATION
PARTY_TYPE_RECLASSIFICATION_POPULATION_IRS
PARTY_TYPE_RECLASSIFICATION_POPULATION_STD
PROD_TYPE_RECLASSIFICATION_POP_IRB

Run Name

PMSegBasel3Std_Sa

USA - US Ill - Minimum Tier 1 Leverage Ratio Calculation
PMSegBasel3Std_Sor

USA - US il - Minimum Tier 1 Leverage Ratio Calculation

PROD_TYPE_RECLASSIFICATION_POP_STD
L SUB_EXPOSURES_NON_SEC

|

]

|

PMSegBaseliStd_Sor
PMSegBaselaStd_Scr
PNSegBasel3Std_Sa
PMSegBasel3Std_Scr
PMSegBasel3Std_Scr
PMSegBasel3Sty_Scr

CRM Mitigant Volatility Haircut - Supenvisory Haircut
Mitigant Esgibility - STD
Non Sec Basel Methodology Assignment - STD

Collateral Eligibility - STD

4 Link Close

11.8 Monitoring a Reporting Plan

After submission, the reporting plan is monitored for completion of individual tasks.

11.9 Viewing a Reporting Plan
This helps the user view the reporting plan. The user needs to be mapped to the DGPMVIEWGRP
group.

To get the Process Monitioring Plan and task details in T2T_FCT_PLAN_TASK_EXEC every time the
new plan and tasks are added, perform the following steps:

1. Create the batch from the FSDF Rule Run Framework screen.

2. Execute the created batch with the selected tasks.

3. Execute the fct_plan_task_exec by excluding T2T_FCT_PLAN_TASK_EXEC.

4. Execute the DIM_TASK, DIM_RUN_EXECUTION and DIM_REPORT_SUB_PLAN.
5

Execute the FCT_PLAN_TASK_EXEC batch by only including the
T2T_FCT_PLAN_TASK_EXEC task.
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12 Dashboards

The Data Quality Rules for Dashboards should be executed through batches only and not through the
DQ screen.

For Data Quality refer to the run chart and execute the batch DGS_DQ_BATCH, DataProfile for the date
on which the data quality check needs to be executed. Refer to the Runchart for further details.

Based on the Data Quality check defined in the DQ framework of AAAI, the dashboard generates the
reports. These are predefined values. The dashboard also generates the reports based on the check
type the user wants to analyze the data with.

The Data Quality Dashboard provides data based on selecting the desired Date and the following list of
drop-downs:

e Batch Name

e DQ Group Name

e DQ Type
e Date
e |teration

Click Apply to generate the reports.
Click Reset to reset the values.
The first grid displays the following data:
e Pass DQ percentage (Green shows the pass DQ %)
¢ Fail DQ percentage (Red shows the failed DQ %)
¢ Number of Total Records
¢ Number of Valid Records
e Number of Invalid Records

e Number of entities, attributes, and DQ checks

Batch Name -Select Value—- v SDOGroup Name' --Select Value-- (v EDOSype| --Select Value-- v/ Bpate 11/30/2010 v Tteration --Select Value-- v & Apply | Resetv

3277 total records
0,
B 2884 valid records
393 invalid records
2 entities 18 attributes 20 DQ checks

Edit

12.1.1  Distribution of Error Records by the Attribute Count

This analysis displays the distribution of error records based on range of attribute counts in the form of
pie charts and bar graphs.
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Distribution of Error Records by Attribute Count

of Re

Edit

Click either on pie chart or bar graph to drill down to view the following details:
e Entity
e Attributes
e DQ Check Type Name
o Percentage of Rejected Records Count
Click Attributes to display the following:
o Data Profile: It displays 2 analyses:

= Data Profile: A tabular representation of the following data based on the Entity-Attribute
Name:

— Count Distinct values

— Count Null Values

— Max Value

— Mean Value

— Minimum Value

— Outliers — Greater than 2x mean
— Ouitliers — Less than 2x mean

— Total Row Count

Business Intelligence search (TN SR €3 /cvonced Administration Help v SignOu|

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | B8 Open v | SignedInAs webloj

Data Profile  Data Buckets B

Data Profile

Entity Stage Cards  Attribute Product Code

‘Statistic Name Statistic Value
Count Distinct Values 1
Count Null Values 6
Total Row count 7

= Trend of Data Profile: This report shows the trend of data profiling in a 6 month interval from
the selected date. It is a Graphical representation of the following data based on the Entity-
Attribute Name:

— Count Distinct values
—  Count Null Values

— Total Row Count
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Trend of Data Profile

ot Distinct Vakues  Count Null Values Total Row count

e Data Bucket: It displays 2 analyses:

= Data Bucket: This is the tabular representation of the following data based on Dimension
Table:

— Node Code

— Distribution Count

Business Intelligence search (ITESD D €} ~cenced Adminstration Help v Sign Oy

Data Quality Drill

Home | Catalog | Favorites v | Dashboards v | [ New v | B8 Open v | SignedInAs weblo(

Dats Profile  Data Buckets. =

Data Buckets

Dimension Node Code Distribution Count
Product Dimension NCF 1
ssa

= Trend of Data Bucket: This report shows the trend of the data profiling in a 6 month interval
from the selected date. It is a graphical representation of the Distribution Count and Node
Codes against time intervals. The Trend of Data Buckets includes two types of graphs:

— Bar Graph
— Line Graph

Trend of Data Buckets

-
‘e

12.1.2 Distribution of Error Records by Error Type

This analysis displays the distribution of error records based on the error type.

Distribution of Error Records by Error Type

Reference
o

Specific
B Vaie
o
No. of
Records

Click either the pie chart or the bar graph to get a drill down to view the following details:
e Entity
e Attributes
e DQ Check Type Name

o Percentage of Rejected Records Count
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Click Attributes to view the following:

Data Profile: It displays two analyses:

= Data Profile: A tabular representation of the following data based on the Entity-Attribute
Name:

— Count Distinct values

— Count Null Values

— Max Value

— Mean Value

— Minimum Value

— Outliers — Greater than 2x mean
— Ouitliers — Less than 2x mean

— Total Row Count

Business Intelligence search (ITEED B €) /denced Administration Help v Sign Oy

Data Quality Drill Home | Catalog | Favorites v | Dashboards v | [ New v | BB Open + | SignedInAs weblo|

Data Profile  Data Buckets

Data Profile

Trend of Data Profile

= Trend of Data Profile: A graphical representation of the following data based on the Entity-
Attribute Name:

— Count Distinct values
— Count Null Values
— Total Row Count
Data Bucket: It displays two analysis:
= Data Bucket: The tabular representation of the following data based on the Dimension Table:
— Node Code

— Distribution Count
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Data Quality Drill Home | Catalog | Favorites v | Dashboards v | JE New v | B8 Open + | SignedInAs weblog

Dats Profile  Data Buckets

Data Buckets

Trend of Data Buckets

= Trend of Data Bucket: Graphical representation of the Distribution Count and Node Codes
against time intervals. The Trend of Data Buckets includes two types of graphs:

— Bar Graph
— Line Graph

12.1.3 Distribution of Defaults by Attribute Count

This analysis displays the distribution of default records based on the attribute count.

Distribution of Defaults by Attribute Count

M Not defauled, No. of Records

Not defauted

Click either the pie chart or bar graph to get drill down which displays the following details:

Entity
Attributes
e DQ Check Type Name

Percentage of Rejected Records Count
Click Attributes to display the following:
o Data Profile: It displays two analysis:
= Data Profile: A tabular representation of the following data based on Entity-Attribute Name:
— Count Distinct values
— Count Null Values
— Max Value
— Mean Value
— Minimum Value
— Outliers — Greater than 2x mean

— Outliers — Less than 2x mean
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— Total Row Count

Business Intelligence E) Adwenced Administration Help v

Data Quality Drill Home | Catalog | Favorites » | Dashboards v | [ New v | S Open

Data Profile  Data Buckets

Data Profile

Entity Stage Cards  Attribute Next Payment Date

Statistic Name  Statistic Value.
Count Distinct Values 1.00
Count Null Vakses
Total Row count

Trend of Data Profile

Entity Stage Cards
Attribute Count Distinct Values  Count Null Values Total Row count

Next Payment Date I I l

Signed In As

Sign O

= Trend of Data Profile: Graphical representation of the following data based on the Entity-
Attribute Name:

— Count Distinct values
— Count Null Values
— Total Row Count
Data Bucket: It displays two analysis:
= Data Bucket: The tabular representation of the following data based on the Dimension Table:
— Node Code

— Distribution Count

Business Intelligence

Data Quality Drill Home | Catalog | Faworites v | Dashboards v | & New v | BS Open v | SignedInAs

Dats Profile  Data Buckets.

Data Buckets

Dimension Node Code Distribution Count
VU 1.00
VAN

PERF

Trend of Data Buckets

= Trend of Data Bucket: A graphical representation of the Distribution Count and Node Codes
against time intervals. The Trend of Data Buckets includes two types of graphs:

— Bar Graph
— Line Graph
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12.2 Controls Dashboard

Execute the batches corresponding to Controls to view the Controls dashboards. For Controld
Dashboard refer to the run chart and execute the batch DGS_CONTROL_BATCH for the date on which
the control and assessment needs to be executed. Refer to the Runchart for further details.

This section displays two dashboard pages:
e Summary

e Controls by Regulatory Reports

12.2.1  Summary

Select the date to generate the dashboard reports.

The following are the types of Controls that are displayed as the Performance Tiles in the Controls
module:

Total Controls: Provides the number of total controls present in the system.

Quality Control: Provides the number of Quality controls present in the system.
Operational Control: Provides the number of operational controls present in the system.
Ineffective Controls: Provides the number of inffective controls present in the system.

Issues: Provides the number of issues present in the system.

Action: Provides the number of actions present in the system.

Business Intelligence search (RS B ) - onced Administaton Help v Sign Out

Home | Catalog | Favorites | Dashboards + | [ New » | BS Open v | Signedin As wel

Summary  Controls by Regulatory Reports =@

Date|12/31/2015 [ Legal Entity. (Al Column Val [vI| appiy | Reset ~

Total Controls Quality Controls Operational Controls Ineffective Controls Issue Action

Edt Edt Edt Bt Edt Edit

Quality Controls by Rating

Rating Distribution for Quality Controls No data for this report

Edit -Refiesh

M Effective
i Ineffective

12.2.1.1  Quality Controls by Rating

This section provides the graphical representation of Number of Controls against Quality Controls. The
following are the types of Rating Names:

o Effective

e Ineffective
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Quality Controls by Rating

Count of Confrols

Effective

Rating Name

Edit

Ineffective

Click the graphs to view the drill-down Control Assessment reports. The following data appears under
the Control Assessment Details dashboard:

Control ID

Control Name
Number of DQ checks

Assessment ID

Assessment Date

Effective Score

Rating Name
Control Assessment Details
Control ID Control Name Number of DQ checks AssessmentID Assessment Date Effective Score Rating Name
51010 Original Term in Original Term 2 52782 12-Nov-16 80,00 Ineffective
51020 Interest Provision Amount MTD in Interest Provision Amount MTD 1 52785 12-Nov-16 80.00 Ineffective
51029 Account Write-off Date in Account Write-off Date 1 52772 12-Nov-16 80.00 Ineffective
51080 Card Renewal Date in Card Renewal Date 1 52784 12-Nov-16 80.00 Ineffective
51113 Next Payment Date in Next Payment Date 1 52777 12-Nov-16 100.00 Ineffective
51114 Account Open Date in Account Open Date 1 52786 12-Nov-16 80.00 Ineffective
51139 Account Writeback Date in Account Writeback Date 1 52778 12-Nov-16 80.00 Ineffective
51180 Next Payment Date in Next Payment Date 1 52773 12-Nov-16 80.00 Ineffective
51226 Adjustment Effective Date in Adjustment Effective Date 2 52787 12-Nov-16 100.00 Ineffective
51278 Last Repriced Date in Last Repriced Date 1 52788 12-Nov-16 80.00 Ineffective
51293 End Of Period Balance in End Of Period Balance 1 52781 12-Nov-16 80.00 Ineffective
51305 Biling Cycle Date in Billing Cycle Date 1 52783 12-Nov-16 80.00 Ineffective
51395 Last Activity Date in Last Activity Date 1 52771 12-Nov-16 80.00 Ineffective
51415 Last Card Status Update Date in Last Card Status Update Date 1 52775 12-Nov-16 80.00 Ineffective
51444 Last Payment Date in Last Payment Date 1 52776 12-Nov-16 80.00 Ineffective
51517 Number Of Times Delinquent Throughout Life in Number Of Times Delinquent Throughout Life 1 52789 12-Nov-16 80.00 Ineffective
51540 Last Credit Limit Change Date in Last Credit Limit Change Date 1 52779 12-Nov-16 80.00 Ineffective
51583 Next Reprice Date in Next Reprice Date 1 52780 12-Nov-16 80.00 Ineffective
51839 Revised Renewal Date in Revised Renewal Date 1 52774 12-Nov-16 100.00 Ineffective

Return - Edit

- Create Bookmark Link

In the Assessment ID column, click the required link to view the drill-down Control Parameter Score.
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Control Parameter Score

Control ID Assessment ID Assessment Date Parameter ID Parameter Name Parameter Weight Parameter Value Parameter Score
51010 52782 12-Nov-16 1 Number of DQ checks that the data element goes through 80.00 2 1.00
2 Percentage of error flags (from all DQs put together) 20.00 97.5 0.00

Return - Edit - Create Bookmark Link

12.2.1.2  Quality Control Effectiveness Trend

This section provides the graphical representation of Number of Quality Controls within a period of six
months from the selected date.

Quality Control Effectiveness Trend

< Effective
* Ineffective

Count of Controls

Time
Time

m

it

Click the graphs to view the drill-down Control Assessment reports.
The following data appears under the Control Assessment dashboard:

e Control ID

e Control Name

e Number of DQ checks

e Assessment ID

e Assessment Date

o Effective Score

¢ Rating Name

Click Assessment ID to view the drill-down Control Parameter Score.

12.2.1.3 Operational Controls by Rating

This section provides the graphical representation of the Number of Controls against Operational
Controls. The following are the types of Rating Names:

e Effective

e |neffective
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12.2.1.4

Operational Controls by Rating

Count of Controls

Effective Ineffective
Rating Name

Edit

Click the graphs to view the drill-down Control Assessment reports. The following data appears under
the Control Assessment dashboard:

Control ID

Control Name
Number of DQ checks
Assessment ID
Assessment Date
Effective Score

Rating Name

Click Assessment ID to view the drill-down Control Parameter Score.

Operational Control Effectiveness Trend

This section provides the graphical representation of Number of Operational Controls within a period of
six months from the selected date.

Operational Control Effectiveness Trend

- Effective
-+ Ineffective

Count of Controls

2010
Time

Edit
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Click the graphs to view the drill-down Control Assessment reports. The following data appears under
the Control Assessment dashboard:

e Control ID

e Control Name

e Number of DQ checks
e Assessment D

e Assessment Date

o Effective Score

e Rating Name

Click Assessment ID to view the drill-down Control Parameter Score.

12.2.2  Controls by Regulatory Reports

Select the desired Regulatory Report and Date and then click Apply to view the Control Assessment
Analysis dashboard.

The following details are listed in the Control Assessment Analysis report:
¢ Rating Name

e Reporting Line Item

Business Intelligence search [T O £ ~cvnced Admrnstraton Hep » Sign oy

Home | Catalog | Favorites v | Dashboards v | [ New v | BSOpen + | SignedIn As weblo|

Summary Controls by Regulatory Reports
Plan (Al Column Val [« “jegal Entity (Al Column Val v Date 12/31/2015 [ Apply | Reset~

Quality Controls

Entity Name Name Control Score Control Rating DQ Checks Report Impact Trend
Mitigant Type Code in Stage Mitigants 52.00 1 Trend of Assessment Parameter

wiells Fargo Bank, National Association Mitigant Type Code in Stage Mitigants 5200 1 Trend of Assessment Parameter

1 Trend of Assessment Parameter

Repricing Date in Stage Loan Contracts 98.00
Maturity Date in Stage Investments 100.00
Criginal Rate in Stage Loan Contracts 100.00
Repurchased Or Indemnified Flag in Stage Loan Contracts 100.00

Interest Rate Code in Stage Loan Contracts 99.00 1 Trend of Assessment Parameter

End Of Period Balance in Stage Futures Contract 99.00

1 Trend of Assessment Parameter

12.3 Key Indicators Dashboards

Key Indicators dashboard displays the various types of reports based on the analysis of the Key
Indicators in the system. For the Key Indicators Dashboards refer to the run chart and execute the batch
DGS_KI_BATCH for the date on which the Key Indicator needs to be executed. Refer to the Runchart
for further details.

12.3.1 Key Indicators - Summary

The Summary tab consists of these performance tiles:

o Total Key Indicator Count: Displays the total number of Key Indicators.
Breached Key Indicator Count: Displays the total number of Breached Key Indicators.
Issue Count: Displays the total number of Issue based Key Indicators.

= Action Count: Displays the total number of Action based Key Indicators.
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These are the KI Summary dashboard sections:

e Rating Distribution for Kls: Displays the latest rating distribution for the assessed Key

Indicators.

Rating Distribution for KIs

Table FACT COMMON ACCOUNT SUMMARY

Edit - Refresh

B Breached
M Passed

KI Trends by Entities: Displays the trend of latest entities for the assessed Key Indicators.
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KI Trends by Entities

100%
80%
60%
M Breached
M Passed
40%

20%

0%
’ Wells Fargo Bank, National Association

Entity

Edit - Refresh

KI Trends across multiple execution: Displays the latest trend across multiple executions for the
assessed Key Indicators.

KI Trends across multiple execution

28
24
20
16

12

Breached Kl Groups

1506677546038
Entity

Edit - Refresh

Issues and Actions:
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12.3.1.1

Issues Actions
Created  Target - Created
Issue Name By Date Action Name By Target Date
Data Quality check failure End Of Period Balance in EBAUSER (04-Apr- Action ADj errors EBAUSER  3/19/2018
Stage Casa Accounts 31-DEC-10 2018 test 12:00:00 AM
04-Apr- Action for Data EBAUSER 3/15/2018
2018 AD] others 12:00:00 AM
Issue in Control Assessment ID- 338735 EBAUSER 23-Mar- action DQ errors EBAUSER  3/15/2018
2018 12:00:00 AM
Issue in Control Assessment ID- 338738 EBAUSER 23-Mar- action for others EBAUSER 3/15/2018
2018 test 12:00:00 AM
Issue in Control Assessment ID- 376251 EBAUSER 03-Apr- Edit - Refresh
2018
Issue in Control Assessment ID- 376254 EBAUSER 03-Apr-
2018
Issue in Control Assessment ID- 376257 EBAUSER 03-Apr-
2018
Issue in KI Assessment ID- 323144 EBAUSER 22-Mar-
2018
Issue in KI Assessment ID- 323174 EBAUSER 22-Mar-
2018
Issue in KI Assessment ID- 323207 EBAUSER 22-Mar-
2018
D {} EZ Rows 1 - 10
Edit - Refresh

Viewing Key Indicator Details

e To view the Key Indicator details:

In the Key Indicators Summary tab, to display the records for a specific date, select the required Date,

and then click Apply.

In the performance tiles, Key Indicator counts appear for the selected date.

Business Intelligence T

Key Indicators Home | Catalog | Favorites v | Dashboards v | [ New «

n Helpv Signout C

B8 Open v | Signed In As weblogic v

Summary  Kis by Regulatory Reports

Date % m Select Value—  |w il Apply | Resetv
257 23 0 0
Total Key Indicator Count Breached Key Indicator Count Issue Count Action Count

Edit -Refresh Edit -Refresh

dit - Refresh

f

To view the Key Indicator details for a performance tile, click that performance tile.
The following Key Indicator details appear:

e Key Indicator ID

e Key Indicator Name

e Key Indicator Description

e Entity

e Attribute
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Business Intelligence ed Administration Help v Sign Out

Key Indicators Home | Catalog | Favorites v | Dashboards v | [ New v | BB Open v | Signed In As weblogic ~
Breached Key Indicator Details A
Key
Indicator  Key Indicator Name Key Indicator Description Entity Attribute
1d
17 Book Value In Reporting Currency  This Column Stores The Book Value Of The Exposure In Reporting Currency. Book Value Is Similar To The Cost Basis And Doesn'|chr(39)||'T Reflect The  FACT FIXED ASSETS BOOK VALUE IN REPORTING
In Fact Fixed Assets Market Value. CURRENCY
44 Accrued Interest In Reporting This Stores The Accrued Interest Of The Exposure In The Reporting Currency. This Is The Interest Accrued As Of Date, And Which Is Not Yet Paid To The  REGULATORY ACCOUNT  ACCRUED INTEREST IN
Currency In Regulatory Account  Exposure Holder SUMMARY REPORTING CURRENCY
Summary
118 Effective Maturity In Fact This Stores The Effective Maturity Of The Exposure. FACT REGULATORY EFFECTIVE MATURITY
Regulatory Capital Account CAPITAL ACCOUNT
Summary SUMMARY
119 Effective Maturity In Fact This Stores The Effective Maturity Of The Exposure FACT REGULATORY EFFECTIVE MATURITY
Regulatory Capital Pool Summary CAPITAL POOL SUMMARY
216 Exposure At Defauit Post Mitigation This Stores The Exposure At Default Amount Post Mitigation By Al Eligible Mitigants FACT REGULATORY EXPOSURE AT DEFAULT
For The Exposure In Fact CAPITAL POOL SUMMARY  POST MITIGATION FOR THE
Regulatory Capital Pool Summary EXPOSURE
221 Exposure At Default Pre Mitigation  This Stores The Exposure At Default Pre Mitigation FACT REGULATORY EXPOSURE AT DEFAULT PRE
In Fact Regulatory Capital Pool CAPITAL POOL SUMMARY  MITIGATION
Summary
237 Interest Expense In Reporting This Column Stores The Interest Expenses Incurred By The Account By The Financial Institution For The Period In Reporting Currency. REGULATORY ACCOUNT  INTEREST EXPENSE IN
Currency In Regulatory Account SUMMARY REPORTING CURRENCY
Summary
269 Fair Value In Reporting Currency  This Column Stores Fair Value Of An Asset In Reporting Currency. Fair Value Is A Rational And Unbiased Estimate Of The Potential Market Price Of And  FACT FIXED ASSETS FAIR VALUE IN REPORTING
In Fact Fixed Assets Asset. CURRENCY
278 Funded Default Fund Contribution ~Reporting Entity'| chr(39)|I'S Default Fund Contribution Backed By Funded Commitments FACT REGULATORY FUNDED DEFAULT FUND
Amount In Fact Regulatory COUNTERPARTY CAPITAL  CONTRIBUTION AMOUNT
Counterparty Capital Summary
290 Hisotrical Acquisition Cost In This Stores The Historical Acquisition Cost In Reporting Currency REGULATORY ACCOUNT  HISOTRICAL ACQUISITION
Reporting Currency In Regulatory SUMMARY COST IN REPORTING
Acrnunt Simmans AwoeNey
Key Indicators: Summary > Breached Key Indicator Details

To view the Key Indicator Conditions details for a Key Indicator, click the required Key Indicator ID.

The Key Indicator Conditions page with dashboards appears.

Business Intelligence Administration Help v Sign Out

Key Indicators Home | Catalog | Favorites v | Dashboards v | I New v | BB Open v | Signed In As weblogic

Key Indicator Conditions A

12/31/2015 Apply | Reset v

0 0 0 76

Total Key Indicators Value Based Key Indicators Variance Based Key Indicators Breached Key Indicators
Edit - Refresh Edit - Refresh

12.3.1.2 Viewing Key Indicator Conditions Details

The Key Indicator Conditions page displays different Conditions based on which Key Indicators are
assessed.

These are the sections of the Key Indicator Conditions dashboards:

Rating Distribution for Variance Kils: This report displays the latest rating distribution for the assessed
Variance Key Indicators.
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Rating Distribution for Variance KIs

Passed
M Breached

Edit

Trend of Rating Distribution for Variance Kls: For the assessed Variance Key Indicators, this report
displays the trend of the latest rating distribution.

Trend of Rating Distribution for Variance KIs

Total

100 Assessed
Kis
80
M Breached
60
40
20
0

Jan-2011

Time

Edit

Rating Distribution for Value Based Kls: This report displays the latest rating distribution for the
assessed Value Based Key Indicators.
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Rating Distribution for Value Based KIs

A

Passed

M Breached

e Trend of Rating Distribution for Value Based Kls: This report displays the trend of the latest

rating distribution for the assessed Value Based Key Indicators.

Trend of Rating Distribution for Value Based KIs

150
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To view the Key Indicator Conditions details:

Total
Assessed
Ki

M Breached

To view the Key Indicator Conditions details for a performance tile, click that performance tile. The
following Key Indicator Conditions details appear:

= Key Indicator Condition ID

=  Name
= Description
=  Comment

=  Type
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Business Intelligence search [ ) Advanced tion Helpv Signout O

Home | Catalog | Favorites » | Dashboards v | [ New » | BB Open v | Signed In As weblogic ~

2 3 ~
Key Indicator Conditions
Key Indicator i

recisizers Name Description Comment  Type
33005 Edit No.9170: Assets Held In Trading Accounts - Revaluation Gains On Interest Rate, Foreign Exchange Rate, And Other Commodity And Equity Contracts  BHCSA210 should not be negative Kt Value
(Bhcsa210) Should Not Be Negative Comments ~ Based
33200 Edit No.9480: Notional Amounts By Regulatory Capital Treatment: All Other Positions: Purchased Protection That Is Recognized As A Guarantee For BHCKG404 should not be null and should not be negative KI Value
Regulatory Capital Purposes(Bhckg404) Should Not Be Null And Should Not Be Negative Comments  Based
33201 Edit No.9480: Notional Amounts By Regulatory Capital Treatment: All Other Positions: Purchased Protection That Is Not Recognized As A Guarantee For  BHCKGA0S should not be null and should not be negative  KI Value
Regulatory Capital Purposes(Bhckg405) Should Not Be Null And Should Not Be Negative Comments ~ Based
33298 Edit No.9030: Bhck6761 Should Not Be Null And Should Not Be Negative BHCK6761 should not be null and should not be negative  KI Value
Comments  Based
33299 Edit No.9040: Bhck4172 Should Not Be Negative bhck4172 shouid not be negative KI Value
Comments ~ Based
33518 Edit No.9480: Bhck3164 Should Not Be Null And Should Not Be Negative BHCK3164 should not be null and should not be negative KT Value
Comments  Based
33519 Edit No.9480: Bhck6438 Should Not Be Null And Should Not Be Negative BHCK6438 should not be null and should not be negative  KI Value
Comments ~ Based
33847 Edit No.9480: Interest Rate Contracts - Notional Value Of All Outstanding Interest Rate Swaps(Bhck3450) Should Not Be Null And Should Not Be Negative  BHCK3450 should not be null and should not be negative  KI Value
Comments  Based
33846 Edit No.9480: Foreign Exchange Swaps(Bhck3826) Should Not Be Null And Should Not Be Negative BHCK3826 should not be null and should not be negative  KI Value
Comments  Based
33849 Edit No.9480: Equity Swaps(BhckB719) Should Not Be Null And Should Not Be Negative BHCK8719 should not be null and should not be negative  KI Value
Comments  Based
33850 Edit No.9480: Commodity And Other Swaps(Bhck8720) Should Not Be Null And Should Not Be Negative BHCX8720 should not be null and should not be negative  KI Value
Comments  Based

33987 Edit No.6545: Bhck3164 Less Than Or Equal To Sum Of Bhck6438 + 25 bhck3164 less than or equal to sum of bhck6438 + 25 KI Value v
Comments Based

To view the Assessment Details page for a required Key Indicator Condition, click the corresponding
Key Indicator Condition ID.

The Assessment Details page appears with the following details:
= Assessment ID: This is the Assessment ID corresponding to the selected Key Indicator ID.
= Key Indicator ID: This is the selected Key Indicator ID.

Current Period Value: The current period value for the selected Key Indicator ID.
= Previous Period Value: The previous period value for the selected Key Indicator ID.

= Variance: The difference in Current and Previous Period Value for the selected Key Indicator
ID.

Variance %: The percentage of Variance based on the Previous Period value.
= RAG Score: The RAG value of the selected Key Indicator depending on the various values.

= Status: The status of the selected Key Indicators depending on the various values.

Business Intelligence " Advanced Administration Help v Sign Out O

Key Indicators Home | Catalog | Favorites v | Dashboards v | I New v | BB Open v | Signed In As weblogic ~

Assessment Details

Assessment ID Key Indicator ID Current Period Value Previous Period Value Variance Variance % Rag Score Status
322935 33201 1.00 10 Q
326712 33201 1.00 v

Retur - Edit - Refresh - Create Bookmark Link

12.3.2 Kls by Regulatory Reports

The Kls by Regulatory Reporting page displays the Key Indicator Group Details with the following
columns:

= Key Indicator
= Name
=  Owner

=  Status
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To view the above-mentioned column values for a particular report, select the required report name in
the Plan dropdown box, and column name in the Legal Entity dropdown box. Click Apply. A list of K
Group Details appears.

Business Intelligence search (] FY Advanced Administration Help v Sign out O

Key Indicators Home | Catalog | Favorites » | Dashboards » | I New v | B open = | Signed In As weblogic +

Summary  KIs by Regulatory Reports =@

Plan| (All Column Vav|\ Legal Entity (All Column Va v | Date 06/15/2016  |v = apply | Reset v

KI Group Details

Key Indicator Name Owner Status

9 Asset Market Value In Reporting Currency In Fact Fiduciary Services Investmnet Summary OFSAD ()
10 Asset Market Value In Reporting Currency In Fact Fund Cis Composition oFsaD @y
11 Balance Amortization Amount In Fact Common Account Summary orsa0 @y
12 Balance Amortzation Amount In Reporting Currency In Regulatory Account Summary  OFSAD (3
16 Book Value In Fact Ifrs Account Summary oFsa0 Q)
17 Book Value In Reporting Currency In Fact Fixed Assets oFsaD @y
18 Book Value In Reporting Currency In Regulatory Account Summary orsaD @y
19 Book Value OF Mitigant Rey In Fact Mitigants orsa0 @y
20 Book Yield In Fact Ifrs Account Summary oFsa0 Q@

21 Carrying Amount - Reporting Currency In Fact Reg Fixed Assets o v

For the required Key Indicator, to view the Variance Analysis, Validation Check Analysis, and Trend
Analysis, click any Key Indicator number. These details are displayed at the bottom of the page:

Variance Analysis: Variance Analysis provides these data for the selected report:

= Report: Displays the reporting line item for the selected report.

= Schedule: Displays the schedule code for the respective reporting line item.
Cell Reference: Displays the cell ID for the respective reporting line item.

= Kl Condition: Displays the Kl condition name.

= Current Value: Provides the current period value for the respective Reporting line item.
Previous Value: Provides the previous period value for the respective Reporting line item.

= Variance %: Displays the percentage of Variance based on Previous Value.

= Status: The status of the selected Key Indicators depending on the various values.

Dependent Kls: Displays the other Key Indicators on which this cell ID is dependent.

6. To view the Assessment details of the selected Key Indicator, click Dependent Kls. The
Assessment Details page appears.
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search (N O ) /cvoncei Admintiaton Help +  Sign Out O

Key Indicators Home | Catalog | Favorites ~ | Dashboards v | [& New ~ | BS Open + | Signed In As weblogic ~

Business Intelligence

Assessment ID Cell Reference Current Period Value Previous Period Value Variance Variance % Rag Score Status
320751 REONF23LWORK. 0.00
Retum - Edit -Refresh - Create Bookmark Link

.gulatory Reports > Key Indicators: Kls by Regulatory Reports > Key Indicators: Kls by Regulatory Reports > Key Indicators: Kls by Regulatory Reports > Key Indicators: Kl by Regulatory Reports > Key Indicators: Kis by Regulatory Reports > Key Indicators: Kis by Regulatory Reports > Assessment Details_Kls

Validation Checks: Displays all the Value-based Key Indicators associated with that Key Indicator
Group key. For the selected report, these details appear:

= Report: Displays the reporting line item for the selected report.
Schedule: Displays the schedule code for the respective reporting line item.
= Cell Reference: This displays the cell ID for the respective reporting line item.
= Kl Condition: Displays the KI condition name.
Status: The status of the selected Key Indicators depending on the various values.
= Dependent Kls: Displays the other Key Indicators on which this cell ID is dependent.

e Trend Analysis: Displays the trend of total assessed Key Indicators and breached Key Indicators
for a particular time interval.

Trend Analysis

2

Time: Dec2015 T

% Total
Breached: 1 & Assessed
Kis
; -
< Breached
0
Dec-2015

Edit - Refresh

To view the Key Indicator Details drill down report, click the graph points.
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Business Intelligence search (TN OO €3 ~vanced Administration Help ~  Sign out O

Key Indicators Home | Catolog | Favorites + | Dashboards ~ | I Mew~ | B Open ~ | signed In As weblogic ~
Key Indicator Details
Key Indicator vame Description Comment  Type
35458.00 Edit No.8400: Rcfdb868 Equal To Rcfdb868 rcfdb868 equal to rcfdbses: K Value
Comments  Based
36650.00 Edit No.0226: If Probability Of Default (Pct) 0.03 To < 0.10(A2haj003) Is Equal To Null, Then Probability Of Default (Pct) 0.03 To < 0.10(Aahbj003) Through Aahfjo03should Be Equal To Null If AAHAJOD3 i equal to null, then 2ahbj003 through aahfj003should be K Value
equalto null Comments  Based
37212.00 Edit No.203: How Many Loss Caps Are Used In Calculating The Risk-Based Capital Requirement For Operational Risk?(Aasaj121) Must Not Ba Negative AASAT121 must not be negative: K Value
Comments  Based
48058.00 Edit No.V3906_S: Debt Securities-General Governments-Collective Allowances For Incurred But Not Reported Losses-10064(Fi0404r030c050) Should Be Lesser Than Or Equal To 0 FI0404RO0300050 should be lesser than or equal to 0 and Edit no. is v3206_s KI Value
Comments  Based
48644.00 Edit No.V3928_S: Other entral Bank | Should Be Greater Than Or Equal To 0 FI10902R1600020 should be greater than or equal to 0 and Edit no. is K Value
V3928 s Comments  Based
49090.00 Edit No.v3956_S: Impairment Or (-) Reversal Of Impairment Of Investment In Subsidiaries, Joint Ventu d. ibsidi Accumulated Should Be FI11607R0700040 should be lesser than or equal to 0 and Edit no. is v3956_s KI Value
Lesser Than Or Equal To 0 Comments  Based
Retumn - Edit - Refresh - Create Bookmark Link

In the Key Indicator ID column, click the link of the required Kl ID to view the Assessment Details
report.

Business Intelligence search (IR N (3 :cvonced Acministration Hep v Signout O

Key Indicators Home | Catalog | Favorites v | Dashboards + | I Mew~ | BS Open + | Signed In As weblogic ~

Assessment Details

Assessment ID Key Indicator ID Current Period Value Previous Period Value Variance Variance % Rag Score Status
320749 35458 0.00 1 Q

Retum - Edt -Refresh - Create Bookmark Link

.. Indicators: Kl by Regulatory Reports > Key Indicators: Kis by Regulatory Reports > Key Indicators: Kis by Requlatory Reports > Key Indicators: Kis by Regulatory Reports > Key Indicators: KIs by Regulatory Reports: > Key Indicators: Kis by Regulatary Reports > KI Details Trend Analysis > Assessment Details

12.4 Process Monitoring

1241

This dashboard provides the following two pages: For Process Monitoring refer to the run chart and
execute the batch DGS_PM_BATCH for the date on which the Process Monitoring Runs and Tasks
needs to be analysed. Refer to the Runchart for further details.

e Process Monitoring

e Process Analysis

Process Monitoring

When a Plan is executed, the user can refresh the page to check the details of on-going tasks.

Select a Plan from the drop-down, and then click Apply to view the Process Monitoring dashboard. It
also displays the Plan Owner and Plan Status based on the Plan selection.

This section describes the following analysis:
e Plan Scope

e Task Tracking
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12.4.1.1

12.4.1.2

12.4.1.3

Plan Scope

This grid displays the Report Name and Report Description associated with the selected Plan from
the drop-down.

Business Intelligence

Process Monitoring
Process Monitoring  Process Analysis

% plan| Quarterly Regulatory Report vl soply | Reset~

Plan Owner: OFSAD Plan Status : Complete
Edit

Plan Scope

Sexch M) O ) vonced Adrmnstrsson il -

Home | Catdlog | Favorites v | Dashboards v | I New v | BB Open v | Signed In As weblogh|

and by counterparty sector

ST rows1-5
Edit

Performance Tiles
The following Performance Tiles are displayed based on the selected Plan:
e Total Runs: Displays the count of total number of runs
o Total Tasks: Displays the count of total number of tasks
Tasks Complete: Displays the percentage of tasks completed
e Time Elapsed: Displays the time elapsed during the execution of the Plan.

1 10 100% 00:00:16
Total Runs. Total Tasks c;; n:':o;;d

£dit Edt

Task Tracking

This grid displays the following data based on the selected Plan:
e Run Task Hierarchy: Displays the Runs associated with the Plan and tasks associated with the
Runs.

Start Time: Displays the start time of each Run on the Run level and the start time of each task
associated with the Run.

e End Time: Displays the end time of each Run on the Run level and the end time of each task
associated with the Run

e Time Taken: Displays the total time taken by each Run on the Run level and the time taken by
each task associated with the Run.

e Status: It displays the status of each Run on the Run level and the status of each task associated
with the Run.

Task Tracking

Start Time End Time Time Taken (HH:MM:SS) Status
EBA Regulatory Reporting Run 11.Ju}-17 12:43:41 11Juk17 12:43:57 00:00:16 Success
£dt
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12.4.2 Process Analysis

Select a plan from the drop-down, select a date, and then click Apply to view the Process Analysis
dashboard.

The Average Total Time (HH:MM:SS) Performance tile appears.

Business Intelligence Search [§ B Advanced Administration Help v  Sign Out

Process Monitoring Home | Catalog | Favorites v | Dashboards v | I New~ | BS Open ~ | Signed In As weblogi

rocess Montoring  Process Analysis

% Plan| Quarterly regulatory report submission p [v INDate! 11/30/2010 [wi apply | Reset ~

00:00:16

Average Total Time
HHMM:SS

The following sections appear in this dashboard:
e Plan Performance
e Longest Running Tasks
e Trend of Rating Distribution for Variance Kls
e Trend of Rating Distribution for Value Based Kls
e Trend of Issues
e Quality Control Effectiveness Trend
e Operational Control Effectiveness Trend

e Trend of Issues

12.4.2.1 Plan Performance

This report displays the time taken by the Run.

Plan Performance

EBA Regulatory Reporting Run

Edit

Click the X axis to view the Task level details.

12.4.2.2 Longest Running Tasks

This report displays the time taken by each task in descending order.
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Task Name
Standard Reg Product Type Redlass - 3
Standard Reg Deposit Type Re-Class

Standard Reg Product Type Reclass - 4
RL - Reg Trading Acct Book Type

Standard Reg Product Type Redlass - 2
Standard Reg Product Type Redlass - 1

Longest Running Tasks

Time Taken (HH:MM:SS)
00:00:14
00:00:12
00:00:12
00:00:11
00:00:10
00:00:09
00:00:09
00:00:00

ount Summary 00:00:00

12.4.2.3 Trend of Rating Distribution for Variance Kls

This report displays the rating distribution of Variance Kls in the form of a bar-graph.

Business Intelligence

Process Monitoring

Process Monitoring  Process Analysis

Trend of Rating Distribution for Variance KIs

Nov-2010

Time

m
(=9
-

Total
Assessed

M Breached

12.4.2.4 Trend of Rating Distribution for Value Based Kls

This report displays the rating distribution of Value Based Kls in the form of a bar-graph.
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Search

Home

Trend of Rating Distribution for Value Based KIs

10
8 Total
Assessed
Ki
6
Il Breached
4
2
0
Nov-2010
Time

m
Q.
-+

12.4.25 Trend of Issues

This report displays the issue reported for the Kis based on the selected plan.

] T ——————.

Catalog I Favorites | Dashboards ~ : ] BS Open ~ | Signed In As web

Trend of Issues

30-Nov-10

11-Jul-17
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12.4.2.6  Quality Control Effectiveness Trend

This report displays the Quality Control Effectiveness, based on the selected Plan, in the form of a bar-

graph.

Quality Control Effectiveness Trend

Count of Controls

B Effective
M Ineffective

Nov-2010
Time

12.4.2.7 Operational Control Effectiveness Trend

This report displays the Operational Control Effectiveness, based on the selected Plan, in the form of a

bar-graph.

Operational Control Effectiveness Trend

Count of Controls

4
3

I Effective
2 I Ineffective
1
0

Nov-2010 Nov-2011
Time

m
(=%
r
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12.4.2.8 Trend of Issues

This report displays issue reported for Controls based on the selected plan.

Trend of Issues

11-Jutk-17

17-Jul-17

sye Created Date

18-Jul-17

250 300 350 400 450

12.5 Regulatory Report Monitoring

Select a Plan Name from the dropdown, and then select a date from the calendar and click Apply to
view the Regulatory Report Monitoring.

The following values are displayed in terms of Performance Tiles:
¢ Reporting Elements with Errors: Displays the percentage of Reporting Elements with Errors.

e Reporting Elements with breach in Variance Indicators: Displays the percentage of Reporting
Elements associated with breached Variance Key Indicators.

Reporting Elements with breach in Key Indicators: Displays the percentage of Reporting Elements
associated with breached Key Indicators.

e Reporting Elements with Control Failures: Displays the percentage of Reporting Elements
associated with failed controls.

e Issues in total: Displays the total number of issues associated with Controls and KI.

Outstanding Issues: Displays the total number of open issues.

Business Intelligence

Search NN G €3 »ivrced Administrtion Help +  Sign Out

Home | Catalog | Favorites v | Dashboards v | I New~ | BS Open v | Signed In As weblogs|

Regulatory Report Monitoring

Plan Name| Quarterly Regul [v| ¥ Calendar Date| 11/30/2010 (250 Apply | Reset v

69.34% 40.00% 20.00% 69.88% 645 11
e s e e T Tt tsues ot Oustnding sues

Analyze - Edit - Refresh Analyze - Edit - Refresh

Analyze - Edit - Refresh Analyze - Edit - Refresh

Regulatory Report Monitoring dashboard displays the following grids:
e Plan Analysis by Report

e Issue and Action Tracking
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12.5.1 Plan Analysis by Report

This analysis displays reports, schedules, and count of Reporting Elements associated with the selected
Plan.

7. Select the Report Name from the drop-down to view the following data:
o Report/Schedule Name: Displays the name of report/schedule.

Total: Displays the number of reporting elements linked to schedule.
e No Errors: Displays the number of reporting elements without errors.

e Variance Indicator Breach: Displays the number of reporting elements linked to the breached
Variance Indicators.

Kl Breach: Displays the number of reporting elements linked to the breached Value Based Key
Indicators.

e Control Failure: Displays the number of reporting elements linked to failed controls.

Plan Analysis by Report

Reporting Elements
Report / Schedule Total No Errors Variance Indicator breach KI Breach Control Failure
RSA 2 0 0 2%
Fl02 s 1 0 0
F114 2 0 0 0 2
Fils 4 0 [} 4
18 126 0 0 0
F20 48 8 8 4 3
Lo 18 0 0
R 103 102 0

8. Click Total associated with each schedule to display Reporting Element drill-down Report. The
following details appear:

Schedule: Displays the name of the schedule.
o Cell Reference: Displays the reporting elements associated with the schedule.
e Breached Variance KI: Displays if there are any Breached Variance Kls.
Breached Value Based KI: Displays if there are any Breached Value Based Kils.

¢ Ineffective Control: Displays if there are any Ineffective Controls.

Business Intelligence search (RS O € /ovonced Administration Help v Sign Out

Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | I New ~ | B8 Open v | Signed In As weblogi|

Schedule Cell Reference Breached Variance KI Breached Value Based KI Ineffective Control
FI20 FI2001 FI2001R020C010 No
FI2001R020C020 No
FI2001R030C010 No.
FI2001R030C020 No
FI2001R040C010 No
FI2001R040C020 No
FI2001R060C010
FI2001R0600020
FI2001R070C010
FI2001R070C020
FI2001R080C010
FI2001R080C020
FI2001R090C010
FI2001R090C020
FI2001R110C010
FI2001R1100020

FI2001R1300020

§8FF55Zs85FFE8FF

FI2001R150C010
FI2001R1500020 No
FI2001R160C010 No

§ 8885358855 ZFF855F585FFEFEEEF¢E

IIIE ;IIII§ EIIIIE zIIE Il

9. Click No Errors associated with each schedule to display Reporting Element drill-down Report.
The following details appear:
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Schedule: Displays the name of the schedule.
o Cell Reference: Displays the reporting elements associated with the schedule.
e Breached Variance KI: Displays if there are any Breached Variance Kis.
Breached Value Based KI: Displays if there are any Breached Value Based Kils.

e Ineffective Control: Displays if there are any Ineffective Controls.

Business Intelligence seorch (NS GNN €3 Acvonced Adminstration Help ~  Sign Out

Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | [ New v | BS Open v | Signed in As weblogi

Schedule Cell Reference Breached Variance KI Breached Value Based KI Ineffective Control

FI20 FI2001 FI2001R0200010 No No No
FI2001R0200020 No No No
FI2001R030C010 No No No
FI2001R030C020 No No No
FI2001R060C010 No No No
FI2001R060C020 No No No
FI2001R090C010 No No No
FI2001R090C020 No No No
FI2001R1300010 No No No
FI2001R1300020 No No No
FI2001R170C010 No No No

No C

No N
FI2001R200C020 No No No
FI2001R230C010 No No No
FI2001R230C020 No No No
FI2001R2400010 No No No
FI2001R240C020 No No No
FI2001R250C010 No No No
FI2001R250C020 No No No

10. Click Variance Indicator Breach associated with each schedule to display the Variance
Indicators and Issue Details — Variance Based Indicators drill-down Report. The following details
appear in Variance Based Indicators:

e Plan Name

e Report Name

e Schedule

e Date

e Variance Indicator
e Owner

e Report

o Cell Reference

e Current Value

e Previous Value

e Variance

e Variance %

e Variance % (Last Period)
e Status

e Status (Last Period)
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Business Intelligence search (RS O € /cvanced Administration Help v Sign Out

Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | I New v | BB Open v | Signed In As weblogi

Variance Indicators
Plan Name :Quarterly Regulatory Report Report : F120 Schedule: FI2001 Date : 30-Nov-10

Variance Indicator Owner Report Cell Reference Current Value Previous Value Variance Variance % Variance %(Last Period) Status Status(Last Period)
Deposits-domestic activties-11319 OFSAD FI20  FI2002R040C010 530022 330022 200000 61 o Q@ [+
Derivatives-domestic activiies-11320 OFSAD FI20  FI2002R020C010 1000000 660044 339956 52 2 @ [+
Derivatives-non-domestic activities-11326 OFSAD FI20  FI2002R020C020 832924 632924 200000 2 2 Q@ [+
Non-current assets and disposal groups dassfied as held for sale-domestic actvities-10901  OFSAD FI20  FI2001R3100010 620154 820154 -200000 24 » Q@ [+)
Non-current assets and disposal groups dassified as held for sale-non-domestic activiies-10902 OFSAD FI20  FI2001R310C020 580000 780000 -200000 26 % Q@ o
Other assets-domestic activities-113133 OFSAD FI20  FI2001R300C010 1060044 1000000 6044 3 @ [+)
Other assets-non-domestic activties-113133 OFSAD FI20  FI2001R300C020 1040022 840022 200000 2 * Q@ [+
Short positions-non-domestic activities-11329 OFSAD FI20  FI2002R030C020 832024 632924 200000 2 2 Q@ [+

The following details appear in Issue Details-Variance Based Indicators:
e |ssue Key
e |ssue Name
e Variance Indicator
e Cell Reference
e Issue Owner
e Target Completion Date
e Issue Status
e Action Name
e Action Status
e Action Owner

e Create Action

Issue Details - Variance Indicators
Issue Issue  Target Issue  Action
Koy lssue Name Variance Indicator Cell Reference 5 e e e
298347 Threshold value breached for Variance of deposts-domestic activities Variance of deposits-domestic activities-11319 FI2002R040C010 OFSAD  31-Juk-2017 Open
298390 Threshold value breached for Variance of derivatives-domestic activities-11320 Variance of derivatives-domestic actvities-11320 FI2002R020C010 OFSAD  31-Ju-2017 Open
298433 Threshold value breached for Variance of derivatives-non-domestic activities-11326- Variance of derivatives-non-domestic activities-11326 FI2002R020C020 OFSAD  31-Juk-2017 Open
298466 Threshold value breached for Variance of non-current assets and disposal groups assified as heldfor  Variance of non-current assets and disposal groups dlassfied as held for sale- FI2001R310C010 OFSAD  31Juk-2017 Open
sale-domestic activities-10901 domestic activities-10901
298509 Threshold value breached for Variance of non-current assets and disposal groups dassified as heldfor  Variance of non-current assets and disposal groups dassfied as held for sale-non-  FI2001R310C020 OFSAD  31-Ju-2017 Open
sale-non-domestic activities-10902 domestic activities-10902
298552 Threshold value breached for Variance of other assets-domestic actvities-113133 Variance of ther assets-domestic activities-113133 FI2001R300C010 OFSAD  31-Juk-2017 Open Create
Action
298588 Threshold vakue breached for Variance of other assets-non-domestic activities-113138 Variance of other assets-non-domestic activities-113138 FI2001R300C020 OFSAD  31-Juk-2017 Open Create
Action

Click K1 Breach associated with each schedule to display Value Based Indicators and Issue Details —
Value Based Indicators drill-down Report. The following details appear in Value Based Indicators:

e Plan Name
e Report

e Schedule

e Date

e Name

e Owner

e Report
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e Cell Reference
e Status

e Status (Last Period)

Business Intelligence search (TR I £ Acvanced Administration Help v

Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | I New ~ | BB Open v | Signed In As weblogic

Value Based Indicators
Plan Name :Quarterly Regulatory Report Report :F120 Schedule :F12001 Date :30-Nov-10

Name Owner Report Cell Reference Status Status(Last Period)
Quality Indicator for 11226 and Editno.isv391.s OFSAD FI20  FI2002R080C010

Qualty Indicator for 112788 and Edit no. is v3136_m OFSAD FI20  FI2004R1900022
Quakty Indicator for 112788 and Edit no. is w4434 s OFSAD FI20  FI2004R190C022

Quality Indicator for 11322 and Edit no. isv3961_s  OFSAD FI20  FI2002R060C010

000600
000600

Quality Indicator for 11325 and Edit no. isv3961s  OFSAD FI20  FI2002R040C020

Anahge - Ed8 - Refresh

The following details appear in Issue Details - Value Based Indicators:
e Issue Name
o Key Indicator
e Cell Reference
e |ssue Owner
e Target Completion Date
e Issue Status
e Action Name
e Action Status
e Action Owner

e Create Action

Issue Details - Value-Based Indicators

Issue Name Key Indicator Cell Reference Issue Owner Target Completion Date Issue Status Action Name Action Status Action Owner Create Action
Threshold value breached for Quality Indicator for 11226 and Edit no. is v3961_s  Quality Indicator for 11226 and Edit no. isv3961_s  FI2002R080C010 OFSAD 3130-2017 Open
Threshold value breached for Quality Indicator for 112788 and Edit no. is v3136_m Quality Indicator for 112788 and Ed no. is v3: FI2004R1900022 OFSAD 31302017 Open

Threshold value breached for Quaity Indicator for 112788 and Edg no Open
Theeshold value breached for Quality Indicator for 11322 and Edt ¥ Open
Theeshold value breached for Quality Indicator for 11325 and Edi no. is v3961_ 31uk-2017 Open
issue100 Quaity Indicator for 11226 and Edit no. FI2002R080C010 OFSAD 319uk-2017 Open

fnahze - Ede - Refresh

11. Click Control Failure associated with each schedule to display Control details and Issue Details
— Value Based Indicators drill-down Report. The following details appear in Control Details:

e Plan Name

e Report

e Schedule

e Date

e Control Name

e Data Quality Checks
e Owner

e Effectiveness
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Cell Reference

Business Intelligence searcr (NN GRS €3 »ioncci Adrinistraton Help = Sign Out

Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | [ New v | BB Open v | Signed In As weblogi

Control Details - Schedule Report
Plan Name : Quarterly Regulatory Report Report : F120 Schedule : F12001 Date: 30-Nov-10

Control Name Data Quality Checks Owner Effectiveness Cell Reference
Product Type in Stage Loan Contracts Faded FI2001R040C010
FI2001R040C020
FI2001R070C010
FI2001R0700020
FI2001R080C010
FI2001R080C020

FI2001R110C010
FI2001R1100020
FI2001R1200010
FI2001R1200020
FI2001R150C010
FI2001R1500020
FI2001R160C010
FI2001R160C020
FI2001R190C010
FI2001R1900020
FI2001R2200010
FI2001R2200020
FI2005R010C010
FI2005R010C022

The following details appear in Issue Details - Controls:

12

Issue Name

Control Name

Cell Reference

Issue Owner

Target Completion Date
Issue Status

Action Name

Action Status

Action Owner

Create Action

Business Intelligence search CINENESD S £ /cvonced Administration Help v Sign Out
Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | [ New v | BB Open v | Signed In As weblogi
Issue Details - Controls
Issue Name Control Name Cell Reference Issue Owner Target Completion Date Issue Status.
Issue in Control Assessment ID- 288396 Product Type in Stage Loan Contracts FI2001R040C010 OFSAD 12-uk-2017 Open
FI2001R0400020 OFSAD 12302017 Open
FI2001R0700010 OFSAD 12302017 Open
FI2001R070C020 OFSAD 1202017 Open
FI2001R080C010 OFSAD 12:30+2017 Open
FI2001R080C020 OFSAD 12-Juk-2017 Open
FI2001R110C010 OFSAD 12-Juk-2017 Open
FI2001R1100020 OFSAD 12302017 Open
FI2001RI200010 OFSAD 12302017 Open
FI2001R1200020 OFSAD 12302017 Open
FI2001R150C010 OFSAD 12-Juk-2017 Open
FI2001R1S0C020 OFSAD 12302017 Open
FI2001R1600010 OFSAD 12302017 Open
FI2001R1600020 OFSAD 12302017 Open
FI2001RIS0C010 OFSAD 1202017 Open
FI2001R190C020 OFSAD 12302017 Open
FI2001R220C010 OFSAD 12-3uk-2017 Open
FI2001R220C020 OFSAD 12-) 17 Open
FI2005R0100010 OFSAD 123uk-2017 Open

Click Data Quality Checks associated with each Control to display the following Data Quality
Details:

ID
DQ Check
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e Type

e Result

o Entity

e Attribute

Business Intelligence search (RS O £) /dvonced Administraton Help v Sign Out C|

Regulatory Report Monitoring Home | Catalog | Favorites v | Dashboards v | I New v | BB Open v | Signed In As weblogic ~

Data Quality Details

10} DQ Check Type Result Entity Attribute
DQCUSTACCT Product type Reference associated with loans should be present in product type Structure Dimension. Referential Integrity Check Failed Stage Loan Contracts Product Type
Betum - Anabgs - Edi - h - Create Bookmark Uink

12.5.2 Create a New Issue

Click the Create a New Issue hyperlink to navigate to the OFSAA Create Issue page where the user
can log a new issue.

™= b3 T g T i3
F102 5 1 0 o
Fi14 2 0 o 2
Fi16 4 ) ‘ 4
118 126 0 o 126
Fi20 48 8 4 3
Be 18 0 e 18
R 103 102 o 0 1
Analyze - Edt - Refresh
Issue and Action Tracking
Issue 1D Issue Name Tssue Owner Target Completion Date Issue Status Action Name Action Owner Action Status
298347 Threshold value breached for Variance of deposits-domestic activities OFSAD 3132017 Open
298390 Threshold value breached for Variance of derivatives-domestic actvities-11320 OFSAD 31302017 Open
298433 Threshold value breached for Variance of derivatives-non-domestic actvities-11326- OFSAD 31-3u-2017 Open
298466 Threshold value breached for Variance of non-current assets and disposal groups dassfied as held for sale-domestic activties-10901  OFSAD 3132017 Open
298509 Threshold value breached for Variance of non-current assets and disposal groups dassfied a5 held for sale-non-domestic activities-10902 OFSAD 31302017 Open
298588 Threshold value breached for Variance of other assets-non-domestic activities-113138 OFSAD 31302017 Open
298645 Threshold value breached for Quality Indicator for 11226 and Edit no. is v3961_s OFSAD 3122017 Open
298707 Threshold value breached for Quality Indicator for 112788 and Edt no. is v3136_m OFSAD 31-3u-2017 Open
298743 Threshold value breached for Quality Indicator for 112788 and Edt no. is v434_s OFSAD 31302017 Open
298810 Threshold value breached for Quality Indicator for 11322 and Edit no. is v3961_5 OFSAD 31-3u-2017 Open
298840 Threshold value breached for Quality Indicator for 11325 and Edit no. is v3961_s OFSAD 31-3uk-2017 Open

12.5.3 Create Action

Click Create Action hyperlink to navigate to the OFSAA Create Action page where the user can create
an action.

| save Draft | [ cancel

Action Name* D 301066
Description
Criticality* V| Owner*
Start Date* 2 Target Date* § 2
Reminder(days)"
Component® 2 [Contral -2 Primary Source 7  Instrume

Comments
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12.6 Scenario Analysis Dashboard

This section contains two dashboard pages:
e Scenario Analysis Dashboard

e Details

12.6.1 Scenario Analysis Dashboard

The Scenario Analysis Dashboard provides data based on the following list of drop-downs:
Legal Entity

Date

Click Apply to generate the reports.

Click Reset to reset the values.

12.6.1.1 Scenario Analysis

In the Choose a Line Item drop-down box, select a line item, and then click Apply to generate the
report.

Click Reset to reset the values.
This grid displays the following data:
e Scenario
e Actual

This report displays the actual and projected amount in millions (dollars) for each scenario in a tabular
format for a selected line item.

The second grid displays the following data:
e BHC Adverse Scenario
e BHC Baseline Scenario

This report displays the same data in a line graph format.
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search D I £) <corced adrinstston e~ Sgnoue O

Home | Catlog | Favorites ~ | Dashboards ~ | [ Mew - | B Open ~ | SionedIn As weblogic ~

Scenario Analysis  Detals

LegalEntity —SelectValue— vl pate 06/30/2016 &

Apply | Reset~

Choose a Line Item ~Select Valu
Aoply | Reset v
Scenario Analysis

Actual and Projected in $Mi

Scenario  Actual PQ1 PQ2 Qs PQ4 PQs5 rQs Q7 P8 ]
BHC 4346136931131.00 4946136931131.00 4346136931131.00 4346136931131.00 4946136931131.00 4546136931131.00 4346136931131.00 4946136931131.00 4946136931131.00 4346136931131.00
Adverse
Scenario
4946136931131.00 4946136931131,00 4346136931131.00 4946136931131.00 4946136931131,00 4346136931131.00 4946136931131.00 4946136931131.00 4946136931131.00 4946136931131.00

Baseline
Scenario
Supervisory 4995136931131.00 4946136931131,00 4946136931131.00 4995136931131.00 4946136931131.00 4946136931131.00 4946136931131.00 4996136931131.00 494613693 113100 4946 136931131.00
Adverse
Scenario
Supervisory 4946136931131.00 4946136931131.00 4846136931131.00 4946136931131.00 4946136931131.00 4846136931151.00 4946136931131.00 4946136931131.00 4846136931131.00 4946136931131.00
Baseline
Scenario
Supervisory 4996136931131.00 4946136931131.00 4546136331131.00 4996136931131.00 4946136931131.00 4546136331131.00 4946136931131.00 4946136931131.00 4946136931131.00 4946136931131.00
Severely
Adverse
Scenario

5,0008

5,0008

BHC Adverse
= Scenario
4,0008

o BHIC Baseline
Scenario

12.6.2 Details Dashboard

In the Choose a Line Item drop-down box, select a line item, and then click Apply to generate the
report.

Click Reset to reset the values.
This grid displays the following data:
e Scenario
e Actual

This report shows the actual and projected amount in millions (dollars) for a scenario in a tabular format
for a selected line item.

Business Intel search TGS I €3 ~cvonced Adrinstaton telp -
Scenario Analysis Home | Catalog | Favorites + | Dashboards v | B New + | BS Open + | SignedIn As weblogic
Scenario Analysis Details
Legal Enity —SelectValue— _ |v| pate 06/30/2015 ) E
Apply Reset v
Choose 3 Scenario —-Select Value— v
Apply Reset ~

Scenario Analysis
Line Item Actual PQL PQ2 PQ3 PQ4 PQS PO5 PQ7 PQ3 PQg
(DEPRECIATION) - NON-DOMESTIC ACTIVITIES - 57013(FI200R 170C020) SHOULD BE 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
GREATER THAN OR EQUAL TO ZERO AND RULE ID IS V3962 S:i:
EDIT NO. IS 510:: IF THE QUARTER MONTH IS JUNE, SEFTEMBER OR DECEMBER, THEN
RIADA251-Q2 GREATER THAN 0 THEN RIADA251-Q1 GREATER THAN 0
EDIT NO. IS 7126:: IF SUM OF RCONBB04 AND RCONBBDS GREATER THAN 0 THEN
RIADB492 GREATER THAN 0
EDIT NO. IS 7126:: IF SUM OF RCONBB04 THROUGH RCONAS91 GREATER THAN §10000K
THEN RIADB492 NOT EQUAL TO 0
EDIT NO. IS 7583:: IN MARCH, IF RIADBS03 GREATER THAN 10 THEN RCONB338 GREATER
THAN O
EDIT NO. IS 1025: PROVISION FOR LOAN AND LEASE LOSSES(RIAD4230) EQUAL TO 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00
PROVISION FOR LOAN AND LEASE LOSSES(RIAD4230):

1AD4230 EQUAL TO RIAD4230: 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00

HCK 4507 SHOULD BE LESS THAN OR EQUAL TO BHCK4080: 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00
EDIT NO. IS 1300: BHCKF228 SHOULD BE LESS THAN OR EQUAL TO BHCK4435: 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00
EDIT NO. IS 215: IF BHCKF552 NOT EQUAL 0 THEN BHCKFS551 NOT EQUAL 0: 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00
EDIT NO. IS 21: IF BHCKFS54 NOT EQUAL D THEN BHCKFS53 NOT EQUAL 0: 255.00 25500 255.00 255.00 255.00 255.00 255.00 255.00 255.00 255.00
EDIT NO. IS 215: FOR JUNE, SEFTEMBER, AND DECEMBER, IF BHCKF 51 (FREVIOUS) IS
NOT EQUAL TO ZERO, THEN THE BHCKFS51 (CLRRENT) SHOLLD NOT B EQUAL TO ZER
EDIT NO. IS 226: FOR JUNE , SEFTEMBER , AND DECEMBER , IF BHCKF 553 ( PREVIOUS ) 15
NOT EQUAL TO ZERO, THEN THE BHCKFS53 (CURRENT ) SHOULD NOT BE EQUAL TO
ZERQ:
EDIT NO. IS 322: RIAD4135 GREATER THAN 0 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00
EDIT NO. IS 322: SALARIES AND EMPLOYEE BENEFITS (RIAD4135) GREATER THAN 0: 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00
EDIT NO. IS 330: RIAD4313 LESS THAN OR EQUAL TO SUM OF RIADB487 AND RIAD4065: 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00 510.00
EDIT NO. IS 350: RIAD4507 LESS THAN OR EQUAL TO RIAD4080: 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 1020.00 Z
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12.7 Validation Checks Dashboard

This section contains two dashboard pages:
e Validation Checks Dashboard

e Cross Report Validation Dashboard

12.7.1 Validation Checks Dashboard

The Validation Checks Dashboard provides data based on selecting the values from the following list of
drop-downs:

e Legal Entity

e Date
e Report
e Schedule

Click Apply to generate the reports.

Click Reset to reset the values.

The generated report contains the following details:

Report: Provides the value that you selected in the Report drop-down box.
Schedule: Provides the value that you selected in the Schedule drop-down box.
Cell Id: Provides the ID of the cell.

Cell Description: Provides a description of the cell.

Validation Check: Provides a validation check on the cell.

Result: Provides the result of the validation, which can be either o Pass or 0 Failed.

Business Intelligence search (XTI B £} :ionc=d Administraton Help v Sgnout O
Validation Checks | catdog | Favorites » | Dastboards » | B New ~ | B Open + | Signedin As wel
Validation Checks  Cross Report Vaiidation =@
LegalEntity | ~Select Vaiue—|v| pate 137312017 [ Report| ~Select valie— (v Schedule. ~Selct Value v

Apply || Reset v

Validation Checks

Report Schedule Cellld  Cell Description Validation Check Result
FRY-194 A.la  CASI3123 CASI3123 MUST NOT BE NULL AND EDITNO. IS 660 CASI3123 nie rul

m

FRY-144 A.la  CASI3196 CASI3196 MUST NOT BE NULL AND EDITNO. I5 665 CASI3136 ne nul
FRY-194 Ala  CASI4320 CASI4320 MUST NOT BE NULL AND EDITNO. I5 668 CAS[4320 ne rul
FRY-144 A.la  CASIC216 CASIC216 MUST NOT BE NULL AND EDIT NO. IS 619 CASIC216 ne nul
FRY-144 A.la  CASIGI03 CASIG103MUST NOT BE NULL AND EDIT NO. IS 669 CASIG103 ne nul
FRY-194 Ala  CASIP420 CASIP420 MUST NOT BE NULL AND EDITNO, I5 586 CASIP420 ne rul

FRY-144 A.la  CASIP428 CASIP428 MUST NOT BE NULL AND EDITNO. IS 587 CASIP428 ne nul

FRY-144 A.la  CASIPS26 CASIPS26 MUST NOT BE NULL AND EDITNO. I5 582 CASIPS25 ne nul

00000000

FRY-194 Ala  CASIPS28 CASIPS28 MUST NOT BE NULL AND EDITNO, I5 583 CASIPS28 ne rul

12.7.2 Cross Report Validation Dashboard

The Validation Checks Dashboard provides data based on selecting the values from the following list of
drop-downs:

e Legal Entity
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e Date
e Reportl
e Report 2
Click Apply to generate the reports.

Click Reset to reset the values.

The generated report contains the following detalils:

Report 1: Provides the value that you selected in the Report 1 drop-down box.

Report 1 Cell Identifier: Provides the ID of the Report 1 cell.

Report 2: Provides the value that you selected in the Report 2 drop-down box.

Report 2 Cell Identifier: Provides the ID of the Report 1 cell.

Report 1 Cell Identifier Value: Provides the identifier value of the Report 1 cell.

Report 2 Cell Identifier Value: Provides the identifier value of the Report 2 cell.

Description: Provides a description of the report

Variance: Provides the value of the variance between the reports.

Variance %: Provides the percentage value of the variance between the reports.

Business Intelligence

Validation Checks

Velidation Checks  Cross Report Validation

Cross Report Validation

FRY-194 CASDS310
FRY-144 CASDBS30
FRY-14A  CASDP742
FRY-194  CASDPE39
FRY-144  CASDPG41
FRY-1494  CASDPG42
FRY-194 CASDPB43
FRY-144 CASDPG44

FFIEC-041 RCOAS310
FFIEC-041 RCOABS30
FFIEC-041 RCOAP742
FFIEC-041 RCOAPE39
FFIEC-041 RCOARS41
FFIEC-041 RCOAPS42
FFIEC-041 RCOAPE43
FFIEC-D41 RCOAPS44
FRY-144 CASDPB4S
FRY-194  CASDPB46
FRY-144  CASDPG4T
FRY-194 CASDPG48
FRY-144 CASDPB49
FRY-144 CASDPGSL
FRY-194 CASDPGST

FFIEC-041 RCOAPBA4S
FFIEC-041 RCOAPB46
FFIEC-041 RCOAPS47
FFIEC-041 RCOAPB48
FFIEC-041 RCOAPB4S
FFIEC-041 RCOAPSS1
FFIEC-041 RCOAPSS7

Legal Entity —Select Value—

69,230,00
25,000.00
102,554,696.35
25,000,00
25,000.00
25,000.00
25,000.00
36,738,395.00
59,923,380,00
47,807,755.00
6,544,500.00
0.00

0.00
64,483,858.75
10,000.00

v Date 03/31/2018

search D I £) <conced adrinsvaton Hep ~ Sgnou O

Home | Catalog | Favorites ~ | Dashboards ~ | [ Mew -~ | BS Open ~ | signedIn As wel

[ Report1 FRY-14A v| Report2 FFIEC-041 v

Apply | Resetv

Report 1 Report 1 Cell Identifier Report 2 Report 2 Cell Identifier Report 1 Cell Identifier Value Report 2 Cell Identifier Value Description

16,635,000,00 If provided, CASD5310 must equal RCOAS310 divided by 1000 within a tolerance and Editno, is 1305
0.00 If provided, CASDB 530 must equal RCOABS30 divided by 1000 within a tolerance and Edit no. is 1279

40,806, 705,00 If provided, CASDP742 must equal RCGAP742 divided by 1000 within a tolerance and Editno, is 1277
0,00 If provided, CASDP839 must equal RCOAPE39 divided by 1000 within a tolerance and Ecit no. is 1280

0.00 If provided, CASDP841 must equal RCOARG<1 divided by 1000 within a tolerance and Edit no. is 1281

0,00 If provided, CASDP842 must equal RCOAPS42 divided by 1000 within  tolerance and Editno, is 1282
77,182,275.00 1f provided, CASDP&43 must equal RCOAPS4S3 divided by 1000 within a tolerance and Edit no. is 1283
0.00 If provided, CASDP844 must equal RCOAPS+4 divided by 1000 within 2 tolerance and Editno. is 1254

0,00 If provided, CASDP845 must equal RCOAP84S divided by 1000 within a tolerance and Edit no. is 1285
77,182,275.00 1f provided, CASDP&46 must equal RCOAP84s divided by 1000 within a tolerance and Edit no. is 1286
652,073, 150.00 I provided, CASDP847 must equal RCOAPS47 divided by 1000 within a tolerance and Editno. is 1257
0,00 If provided, CASDP48 must equal RCOAPS48 divided by 1000 within a tolerance and Edit no. is 1288
77,182,275.00 1f provided, CASDP849 must equal RCOAP849 divided by 1000 within a tolerance and Edit no. is 1289
0.00 If provided, CASDP8S1 must equal RCOAPSS 1 divided by 1000 within a tolerance and Edit no. is 1291
1,334,193,295.00 If provided, CASDP857 must equal ROGAPSS? divided by 1000 within a tolerance and Edit no. is 1296

Variance
163,565,770.00
25,000.00
61,747,991.35
25,000.00
25,000.00
25,000,00
77,207,275.00
36,738,395.00
59,923,380.00
124,990,030.00
645,534,650.00
0.00
77,182,275.00
64,433,858.75
1,334,203,295.00

Variance %
99.96

151.32

100.03

161,04
9.00
100.00
0.00

100,00

12.8 Variance Analysis Dashboard

12.8.1

Prerequisites

a) Account number generation batch for the report FRY9C, FFIEC-031, FFIEC-041 and FDIC370 needs

to be executed. Refer section 13.8.1

b) Kl assessment and the Ki related data needed for the dashboard need to be executed prior. Refer
run chart and execute the batch DGS_KI_BATCH for the date on which the assessment is done.

Note: If the DGS_KI_BATCH is executed earlier for the same date then not needed to execute.

Accounts Details for reports

Perform the following steps for the Variance Analysis dashboard prior to verifying the dashboard.

c. For generating the account details for each cell in the reports (FRY-9C, FFIEC-031,FFIEC-

041), execute the batch:
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d. ##INFODOM## ACCT MAPPER INSERT

For this batch to execute following parameters need to be entered in the taskl of the batch in
the batch maintenance screen

f£. Parameter list "ACCOUNT", "##Report Name##", "##Run_skey##", "##MIS Date##".

P-?"" i
T 20.184.155.80:1552

= ORACLE

&7 10.184.15580:15520/DGSGLAce/Batch/T
@ US-Engish = OFSAD D
Task Definition P
And

Batch Name + Add I view
Batch D &
(OFSDMINFO_1550054602195
(CFSDMINFO_1350034995891
OFSOMINFO_1330035271912

¥ OFSONINFO_ACCT MAPPER INSES
CFSONINFO_ALM
CFSOMENFO_AMHM_STG M DAY
OFSDMENFO_ANACREDIT TMP_DFJ
OFSDMINFO_BLLK KIASSESSMENIl  Datastore Type oW .
CFSOMENFO_CAMPAIGN
OFSOMINFO_COUATERAL
0esonane0_COUECTIONANDRIL 5 4sgeess
OFSOMINFO_CREATE CONTROL
CFSOMINFO_CREATE CONTROL M Aute Name NP ACCT MAPPER INSERT -
CFSOMINFO_CREATE GRANULAR,
OFSOMINFO_CREATE JSSUES

Accourt mapper insert batch
TaskiD  Taski Desaription

TRANSFORM OATA v

Dynamic Parameters List

Froperty Vahst

Datastors Nare OFSDMINFO 2|

10,184.155.50 |

Paramater List ACCOUNTFRY-9C7"2", 20151231

Page 1 of 21(1-15 of 308 eems) Records Per Page 13

Task Details + add ¥ view 4]

7 Oste
% Tk o
3D, db FSAL ! Modficabon Date 235 mar 1 oo
v Tasa [ART
Page 1 of 1011081 kems) K Records Per Page 15

g. For getting the account details of each cell for reports FDIC370, execute the batch:
h. ##INFODOM## ACCT MAPPER INSERT

i. For this batch to execute following parameters need to be entered in the taskl of the batch in
the batch maintenance screen

j. Parameter list "ACCOUNT AND
PARTY", "##Report Name##", "##Run_ skey##", "##MIS Date##".

@ 10.184.155.80:15520/DGSGL/main/heme jsp @ 10.184.155.80:15520/DGSGL fiee/BatchyTaskDefinitionjsp W = e o =
= ORACLE financisl Services Data Gover y ° ofsa0 v @
Task Definition ¥ Expand to view video
Close
Batch Maintenance (2]
Task Definition
>
Account mapper insert batch reh - Reset
Batch ID Like  OFSOMENFO_ TasklD Taski Description
e COmponents  TRAMSFORM DATA
Batch Name + Addli¥ View @] Ed2  Detete Dynamic Parameters List
BatchD & Property Value
] OFSOMINFO_1550054602195 Datastoee Type -
] OFSOMINFO 1550054995501 Datastore Mame OFSDMENFO pe
1 0FSOMINRD 1550055271912 P Addeats 018415580 o
) OFSOMINFO_ACCT_MAPPER INSERT Fule Name: FN_SP_ACCT MAPPER JNSERT
] OFSOMINFO_ALM Parametes List “ACCOUNT AND PARTY" “FOICI70° "3 "20151231"
] OFSOMINFO_AMHIM_STG_DIM_DATA LOAD
1] OFSOMBNFO_ANACREDIT_TMP_DE_RESAVE
. Audit Panel
] OFSOMINFO_BULK_KILASSESSMENT
Crested By OFSAL Creation Date 05 NOV 2015 D6:40:
1 FSOMRNFO_CAN, Crested By: OFSAD eation Date 05 NOV 2015 06:20:14
1 OFSOMINFO_COLLATERAL Last madified by:  GFSAD Last Madification Date 28 mar 2019 090314
] OFSOMINFO_COLLECTION AND_RECOVERY
] OFSOMINFO_CREATE CONTROL
) CREATE CONTROL
7] OFSOMINFO_CREATE_GRANULAR_MAPPER
] OFSOMBNFO_CREATE JSSUES
Page 1 of 21 (115 of 308 items) K ¢ > O erpage 15
Task Details + add W view ¥ edint & Detete
J TaskiD & Task Description o
. '
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12.8.2 Viewing the Variance Analysis Dashboard

The Variance Analysis Dashboard provides data based on selecting the values from the following list of

drop-downs:
e Report
e Schedule
o Cell Identifier
e Measure
e Entity Name
e Reporting Date
13. Click Apply to generate the reports.
14. Click Reset to reset the values.

The generated report contains the following details:

15.

16.

Cell Identifier: Provides the MDRM code of the cell.

Cell Description: Provides the description of the code.
Current Value: Provides the current value of the report.
Previous Value: Provides the previous value of the report
Variance: Provides the value of the variance.

Variance %: Provides the percentage value of the variance.

This drill-down is only available for FRY-9C, FFIEC-031, FFIEC-041, and FDIC370

In the Cell Identifier column, select the link.

Business Intelligence Search [ Advanced Administration Help

Variance Analysis Home | Catolog | Favorites = | Dashboards = | [ New = | BS Open + | Signed I

Report FRY-3C | Schedule —Select Value-- ~|  Cell 1dentifier BHCK1286 || Entity Mame Wells Fargo Bank, N [v| " Reporting Date 12/31/2015 E’Eb Apply | Reset =
AT Schedule Cell Cell Description Entity Name ‘Current Value ETSURRe Variance TR Breached Trend EI Report |
Code Code Identifier Value %

FRY-5C HC-B BHCK1285 AMORTIZED COST OF AVAILABLE-FOR-SALE U.5. TREASURY Wells Fargo Bank, National 280,599,411.00 0.00 280,599,411.00 100.00 ACCOUNT_
SECURITIES Assodation

In the Account Level page, select E to maximize the rows.
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Business Intelligence Search [ Advanced Administration  Help

Account Level Home | Catalog | Favorites v | Dashboards v | [ Mew v | B Open v | Signed1

Current Value Previous Value

280,599,411 0

Account Details

CellID  Account Number Amortized Cost RCY Amortized Cost RCY (Previous Period) Variance%o

BHCK1286 IMVEST11010 5,622,979.93 0.00 100
INVEST11012 6,214,098.76 0.00 100
INVEST11014 5,622,979.93 0.00 100
INVEST11016 6,214,098.76 0.00 100
INVEST11018 5,622,979.93 0.00 100
INVEST11020 6,214,098.78 0.00 100
INVEST11026 6,080,590.23 0.00 100
INVEST11027 6,342,395.73 0.00 100
INVEST11028 5,804,186.23 0.00 100
INVEST11029 6,281,643.33 0.00 100
INVEST11898 6,080,590.23 0.00 100
INVEST11899 6,342,393.73 0.00 100
INVEST11900 5,804,186.23 0.00 100
INVEST11901 6,281,645.33 0.00 100
INVEST12770 6,080,590.23 0.00 100
INVEST12771 6,342,395.73 0.00 100
INVEST12772 5,804,186.23 0.00 100
INVEST12773 6,281,645.33 0.00 100
INVEST13642 6.080.590.23 0.00 100

Variance Analysis: page 1 > Account Level: ACCOUNT_1_DRL_DW

You can also view the Variance analysis Trend:
Click the View Trend link. The Variance Analysis page appears.

This report shows the trend for each MDRM code for the available time duration (ex : 1 year) in a line
graph format.

Business Intelligence search ([T SN €Y /cvanced Administaton Hep -~ Signout O

Variance Analysis Home | Catalog | Faverites » | Dashboards v | [ New v | BSOpen = | Signed n s weblogic +
Cell Identifier BHCS3165 []
Trend
2404
2004
16014
= 2w
E
801
am
]
2017 2018
Year
Return -Analyze -Edit -Refiesh - Create Bookmark Link
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13 Metadata Browser

This section includes the following sections:

e Exporting Metadata Browser Objects to XML

e Registering a Metadata Browser Object

e Publishing a Metadata Browser Business Term

13.1 Exporting Metadata Browser Objects to XML

You can export the Metadata Browser (MDB) objects, in an XML format. This exported XML can be
used directly to import data in the database. By using this XML export functionality you can:

o Export the list of all the objects of a particular object type.
e Export all the details of a particular object.

Based on the requirement, you need to make the respective Webservice call by passing the request
XMLs, with all the fields required to generate the desired output XML.

The WebService class MDBODbjectExportWS holds the two methods. A Webservice call to either of the
methods in this class should be made from the server on which the application is hosted, to the server
on which the Webservice is hosted, such as the OFSAAI server.

1. To generate an XML with a list of all the objects of a particular object type, you need to invoke the
generateXMLODbjectsList(String xml).

2. Use the following format of a request xml with the fields holding non-null values:
3.
<Object>
<infodom>{infodom}</infodom>
<objectType>{Object Type Id}</objectType>
</Object>
4. Below is the format of the corresponding response XML.:
5.
<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<Objects>
<object>
<Id>{object def id}</Id>
<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>
</object>
<object>

<Id>{object def id}</Id>
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<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>
</object>

<object>
<Id>{object def id}</Id>
<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>

</object>

<object>
<Id>{object def id}</Id>
<Name>{object name}</Name>
<MasterId>{master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>
</object>

</Objects>

6. To generate an XML with with all the details of the object, you need to invoke the
generateXMLObjectDetails(String xml).

7. Use the following format of a request xml with the fields holding non-null values:
<object>
<infodom>{infodom}</infodom>
<Id>{Object def id}</Id>
<Name>{object name}</Name>
<MasterId>{Master Id} </MasterId>
<Folder>{Folder name}</Folder>
<Type>{Object Type Id}</Type>
</object>

8. Following is the format of the corresponding response XML.:

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
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<Object>

<Id>{Object def id}</Id>

<Name>{object name}</Name>

<MasterId>{Master id}</MasterId>
<Folder>{folder name}</Folder>
<Type>{object type id}</Type>

<Properties>

<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>
</Property>

<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>

<AttributeValue>{attribute value}</AttributeValue>

<AttributeValue>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>
</Property>

<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>

</Property>

<Property desc="property description">
<AttributeName>{attribute name}</AttributeName>
<AttributeValue>{attribute value}</AttributeValue>
</Property>

</Properties>

<DependentObjects>

<DependsOn>

<Object Id="obj def id" Type="object type id"/>
<Object Id="obj def id" Type="object type id"/>
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<Object Id="obj def id" Type="object type id"/>
</DependsOn>

<UsedIn>

<Object Id="obj def id" Type="object type id"/>
<Object Id="obj def id" Type="object type id"/>

<Object Id="obj def id" Type="object type id"/>
</UsedIn>

</DependentObjects>

</Object>

13.2 Registering a MDB Object

The Mutility registers a new MDB object based on the input XML. You should provide valid entries in this
XML before execution.

1. Provide the path of the input XML file in the MDBObjectRegistration.properties file located in the
FIC_DB/conf folder.

The following is an example of a Sample MDBObjectRegistration.properties file:
file_path:/FIC_HOME/XML Directory/MDBObjectRegistraionSample.xml

o > wN

In the command line execute the ‘MDBODbjectRegistration.sh' shell script available in the
FIC_DB/bin folder. After successful execution you can view the object in the MDB.

6. The XML file has a predefined template. You can only provide values based on this template
structure.

7. The following is the Input XML template:
<OBJECT TYPE ID="">

<INFODOM></INFODOM>

<NAME></NAME>

<TYPE>E</TYPE>

<LOCALE>en US</LOCALE>

<ATTR_GROUP ID="1">
<FORM CODE></FORM CODE>
<GROUP_FORM CTL ID></GROUP FORM CTL ID>
<GROUP_FORM CTL NAME></GROUP FORM CTL NAME>
<LAYOUT TYPE>1</LAYOUT TYPE>
<DISPLAY ORDER>1</DISPLAY ORDER>

<ATTRIBUTE ID="1">
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<TYPE>1</TYPE>
<FORM_CODE></FORM CODE>
<CONTROL_ID></CONTROL_ ID>
<CONTROL_NAME></CONTROL_ NAME>
<OBJECT LINK>1</OBJECT LINK>
<DISPLAY ORDER>1</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>

<MEMBER_CODE></MEMBER_ CODE>
<PARAM VALUE></PARAM VALUE>

</ATTRIBUTE>

<ATTRIBUTE ID="2">
<TYPE>1</TYPE>
<FORM CODE></FORM CODE>
<CONTROL_ID></CONTROL ID>
<CONTROL_NAME></CONTROL NAME>
<OBJECT LINK>1</OBJECT LINK>
<DISPLAY ORDER>2</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>

<MEMBER CODE></MEMBER CODE>
<PARAM VALUE></PARAM VALUE>

</ATTRIBUTE>

<ATTRIBUTE ID="3">
<TYPE>1</TYPE>
<FORM_CODE></FORM_CODE>
<CONTROL_ID></CONTROL ID>
<CONTROL_NAME></CONTROL_ NAME>
<OBJECT LINK>1</OBJECT LINK>

<DISPLAY ORDER>3</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER_ CODE></MEMBER CODE>
<PARAM VALUE></PARAM VALUE>
</ATTRIBUTE>
</ATTR_ GROUP>
<ATTR_GROUP ID="2">
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<FORM_CODE></FORM CODE>

<GROUP_FORM_CTL_ID></GROUP_FORM CTL_ID>

<GROUP_FORM CTL_ NAME>C</GROUP_FORM CTL NAME>

<LAYOUT TYPE>3</LAYOUT TYPE>

<DISPLAY ORDER>2</DISPLAY ORDER>

<ATTRIBUTE ID="1">
<TYPE>1</TYPE>
<FORM_CODE></FORM_ CODE>
<CONTROL_ID></CONTROL_ ID>
<CONTROL_NAME>C</CONTROL NAME>
<OBJECT LINK></OBJECT LINK>
<DISPLAY ORDER>1</DISPLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER CODE></MEMBER CODE>
<PARAM VALUE></PARAM VALUE>
</ATTRIBUTE>
<ATTRIBUTE ID="2">
<TYPE>1</TYPE>
<FORM CODE></FORM CODE>
<CONTROL_ID></CONTROL ID>
<CONTROL_ NAME></CONTROL NAME>
<OBJECT_ LINK></OBJECT LINK>

<DISPLAY ORDER>2< /DIS PLAY ORDER>

<ATTRIBUTE LOCALE PACKAGE></ATTRIBUTE LOCALE PACKAGE>
<MEMBER CODE></MEMBER CODE>
<PARAM VALUE></PARAM VALUE>
</ATTRIBUTE>
</ATTR GROUP>
<MENU ID="">
<MENU TYPE>MDB OBJECT VIEW</MENU TYPE>
<PARENT MENU ID></PARENT MENU ID>
<DEFAULT LABEL></DEFAULT LABEL>
<USER_PRIVILEGES></USER PRIVILEGES>
<GROUPING REQUIRED>N</GROUPING REQUIRED>
</MENU>
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</OBJECT>

13.3 Publishing a MDB Business Term

The execution occurs through the command line by calling the MDBPublishExecution shell script in the
FIC_DB/bin location.

The following are the prerequisites for publishing:

You should make an entry for both MDBGIlossarylmplementation and
MDBSubjectArealmplementation APl in the MDB_POP_IMPL_LIST table . The order of execution
order should be such; first the subject area should be executed, followed by the glossary.

You should create a menu for the Business Term in MDB by using the MDB_MENU_DETAILS
table, before publishing.

An object type of 15001 for Business Term and 15002 for subject area is created in the MDB
table.

After executing the APIs, Subject area objects and Business Term objects are populated in the
MDB tables.

You should specify the attribute layout in the tables MDB_OBJECT_TYPE_LAYOUT and
MDB_OBJECT_TYPE_ATT_LAYOUT. After successful execution, you can view the Business
Term objects in the Meta Data Browser.
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14 Metadata Export Utility

The Metadata Export Utility helps you to export OFSAA metadata into Excel Sheet. This feature helps to get a view of
OFSAA metadata and its dependencies. It is a template based approach where you create templates and select
Metadata Objects that must be extracted. The extraction process is supported only for Excel Sheet. While defining the
template, you are expected to have prior knowledge of the OFSAA Metadata objects that are relevant from this
application point of view.

14.1 Prerequisites

The following executions must be performed before using the Metadata Export Utility:
1.

BEGIN

DBMS STATS.GATHER TABLE STATS (USER,

END;

Before executing MDB Publish and Data Elements Wrapper Batch, ensure the following:

a. Tablespace Requirement:

i. Ensure that the USERS tablespace have minimum 150 GB available

ii. Ensure that the TEMP tablespace is minimum 45 GB available

b. Execute the following Gather Stat command for the mentioned tables:

iii.  Atomic Schema:
FSI_M_CELL_DETAILS
FSI_DE_SEEDED_DIMENSIONS
FSI_DE_TABLE_APPLICATION_MAP
FSI_DE_PP_TABLE_LIST
FSI_DE_METADATA_SEEDED VW_MAP
FSI_DE_PP_TABLE_REPORT_MAP
Config Schema:

AAI_OBJECT B

AAI_OBJECT_TL
AAI_DMT_DEFINITION
AAI_DMT_DEF_SOURCE_ENTITY
AAI_DMT_MAPPING_DETAILS
PR2_RULES B

PR2_RULE_MAP
PR2_RULE_OBJECT
PR2_RULE_OBJECT_MEMBER
PR2_OBJECT TL

'TABLE NAME') ;
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PR2_OBJECT_TRACE
BATCH_MASTER
BATCH_TASK_MASTER
BATCH_PARAMETER_MASTER
METADATA_MASTER
METADATA_ELEMENT_MASTER
METADATA_LOCALE_MASTER
METADATA_TYPE_MASTER
METADATA_ATTRIBUTE_MASTER
2. MDB Publish: Execute the batch, INFODOM_MDB
3. After Executing MDB Publish and Data Element Wrapper Batch, ensure the following:

c. Execute the following Gather Stat command for the mentioned tables:

BEGIN
DBMS STATS.GATHER TABLE STATS (USER, 'TABLE NAME');
END;
iv.  Atomic Schema:

FSI_DE_REPORT_LINEAGE_BASE

FSI_DE_REPORT_LINEAGE_DETL

FS|_DE_METADATA_TGT_MEMBER

FS|_DE_METADATA_SRC_MEMBER

FS|_DE_REPORT TARGET_MEMBER

FS|_DE_REPORT_SOURCE_MEMBER

4. Logs: MDB logs are generated under deployed area /Context_Name/logs/MDB_XXXX.log

Data Elements Wrapper Execution: After MDB Publish is completed succesfully with message
“Metadata publishing is finished.” in the /Context_Name/logs/MDB_XXXX.log, you must execute the
Data Elements Utility with the following seeded batch to get the Data Lineage for each Metadata in
OFSAA:

<INFODOM>_POP_DATA_ELEMENTS_EBA

This execution requires adequate tablespace. Ensure that your Atomic Schema is having enough tablespace in
TEMP and USERS.

d. Parameters used in <INFODOM> POP_DATA_ ELEMENTS_EBA Batch

e. The batch can be executed in different modes according to each requirement. The following
are the parameters used for executing the batch.

The default parameters used in the <INFODOM>_POP_DATA_ELEMENTS_EBA batch are:
Taskl (METADATA PARSER)

Sl. Parameter Description List of Default Value

No. Values
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P_FULL PARSE Full Parser Y/N Y’
Flag

P_INFODOM_NAM | Infodom Name | #INFODOM# | <Value of the Infodom
E # where US FED is installed>.
For example: ‘FSDFINFO’

Task2 (REPORT PARSER)

Description List of Default Value

Values

P_JURISDICTION | Jurisdiction EBA ‘EBA’
Code
P_INFODOM_NAM | Infodom Name | #INFODOM# | <Value of the Infodom
E # where US FED is
installed>.
For example: ‘FSDFINFO’

Execution Types for METADATA Parsing in <INFODOM>_POP_DATA_ELEMENTS_EBA Batch

1.

Full METADATA Parsing [Default Mode] (if the P_FULL_PARSE parameter is ‘Y’, then the
parsing happens for entire METADATA and Run Elements for the Run(s) enabled in
FSI_DE_POP_RUN_LIST table in the Atomic Schema).

Incremental METADATA Parsing [Optional Mode. Batch Parameter to Be Modified] (if the
P_FULL_PARSE parameter is ‘N’, then the parsing happens for changed METADATA and Run
Elements for the Run(s) enabled in FSI_DE_POP_RUN_LIST table in the Atomic Schema).

You can edit the parameters by accessing the Batch Maintainance screen.

a. Login to Oracle Financial Services Analytical Applications interface with your credentails.

b. Navigate to Applications = Financial Services Data Foundation - Operations = Batch
Maintenance

Select Batch Name (<INFODOM>_POP_DATA_ELEMENTS_EBA)

d. (OPTIONAL) Select Taskl and click the Edit button. The Edit Task Definiton Window is
displayed.

e. Modify the Parameter List field as applicable.

The values must be in single quotes and comma separated for each value. Follow the same order as in the table.

Execution Types for REPORT Parsing in <INFODOM>_POP_DATA_ELEMENTS_EBA Batch:

1.

US FED Jurisidciton REPORT Parsing [Default Mode] (if the P_JURISDICTION parameter is
‘EBA’, then the parsing happens for US FED Reports enabled in FSI_DE_POP_REPORT_LIST

table in the Atomic Schema).

NOTE Even if the P_JURISDICTION parameter .
in <INFODOM>_POP_DATA_ELEMENTS_EBA

Batch is loaded, the Dashboards which get

parsed depend on the

FSI_DE_POP_REPORT_LIST table in the

Atomic Schema.
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2. All Jurisdcitions REPORT Parsing [Optional Mode. Batch Parameter to Be Modified] (if the
P_JURISDICTION parameter is NULL, that is, () or two Single Quotes, then the parsing happens
for entire Reports enabled in FSI_DE_POP_REPORT _LIST table in the Atomic Schema).

You can edit the parameters by accessing the Batch Maintainance screen.
a. Login to Oracle Financial Services Analytical Applications interface with your credentails.

b. Navigate to Applications = Financial Services Data Foundation - Operations = Batch
Maintenance

Select Batch Name (<INFODOM>_POP_DATA_ELEMENTS_EBA)

d. (OPTIONAL) Select Task2 and click the Edit button. The Edit Task Definiton Window is
displayed.

e. Modify the Parameter List field as applicable.

NOTE The values must be in single quotes and .
comma separated for each value. Follow the
same order as in the table.

Enabling Run for METADATA Parsing

Every execution for METADATA Parsing requires minimum one Run to be enabled in FSI_DE_POP_RUN_LIST table
in the Atomic Schema. By default, RGRNEBA is enabled.

RUN NAME INCLUDE RUN
RGRNEBA Y

Excluding Irrelevant Data Flows from Lineage Reports

For each Run, some of the Data Mappings can be functionally irrelevant. For these cases with respect to any Run, the
customer can opt for removing these Data Flow from Lineage Reports as an exclusion by inputing the same in the
FSI_DE_RUN_FLOW_REMOVAL table.

Enabling Reports for REPORT Parsing

Every execution for REPORT Parsing requires minimum one Report to be enabled in FSI_DE_POP_REPORT_LIST
table in the Atomic Schema. By default, the following Reports are enabled for US FED Jurisdiction.

Table 1: Dashboard ID Details

JURISDICTION INCLUDE
DASHBOARD ID CODE REPORT CODE REPORT
1 EBA FRY-9C Y
2 EBA FRY-9LP
3 EBA FFIEC-009 Y
4 EBA FFIEC-009a Y
5 EBA FRY-15 Y
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6 EBA FRY-20 Y
7 EBA FRY-12 Y
8 EBA FRY-11 Y
9 EBA FRY-11s Y
10 EBA FR-2314 Y
11 EBA FR-2314s Y
12 EBA FR-2052A Y
13 EBA FRY-14Q Y
14 EBA FRY-14A Y
15 EBA FFIEC-031 Y
16 EBA FR-2886B Y
17 EBA FFIEC-041 Y
18 EBA FRY-7N Y
19 EBA FFIEC101 Y
20 EBA FR-2900 Y
21 EBA FDIC-8020 Y
22 EBA FRY-14M Y
23 EBA FR-2644 Y
24 EBA FRY-7NS Y
25 EBA FFIEC-002 Y
26 EBA FR-2420 Y
27 EBA FFIEC-002S Y
28 EBA FR-2502Q Y
29 EBA FFIEC-030 Y
30 EBA FFIEC-030S Y
31 EBA FR-2835A Y
32 EBA FRY-7Q Y
33 EBA FFIEC-002 Y

By Default All Dashboards are enabled and if you wish to parse particular Dashboards, modify the
FSI_DE_POP_REPORT_LIST table in the Atomic Schema by enabling / disabling the “Include Report Column”.

Executing SELECTED tasks of <INFODOM>_POP_DATA_ELEMENTS_EBA Batch

By Deafult, the <INFODOM>_POP_DATA_ELEMENTS_EBA Batch contains both the tasks, that is, METADATA
Parsing and REPORT Parsing. You can use platform feature of EXCLUDE / INCLUDE Batch Task for Optional
execution of required tasks.
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14.1.1  Verifying Logs

Data Elements logs are generated in Atomic Schema under the FSI_MESSAGE_LOGS table.

Tasks Batch Run ID Indication
Taskl (METADATA REGISTER_ELEMENTS_<Ba | Processes Metadata Parsing.
Parsing) tch_Run_ID> The message “Completed

REISTER_ELEMENTS” indicates
that the Metadata parsing is
completed with Registration.

Task2 (REPORT REPORT_TO_ELEMENTS_ Processes Report Parsing.
Parsing) <Batch_Run_ID > The message “Completed
REPORT_TO_ELEMENTS”
indicates that all the Report parsing
is completed.

14.1.2 Validating Lineage Outputs

In Atomic Schema, you must verify that data is present in the following tables and ensure that the table is populated:
e FSI_DE_RUN_LINEAGE_METADATA
e MDR_LINEAGE_METADATA
e FSI_DE_REPORT_LINEAGE_BASE
e FS| DE_REPORT_LINEAGE_DETL

It is recommended that the following SQL statement must be executed in Config Schema, if this INDEX is not
created:

CREATE INDEX index_mdr_mod_parent_child

CREATE INDEX index_mdr_mod_parent_child

ON mdb_object_dependencies (parent_object_def _id,child_object_def _id)

COMPUTE STATISTICS

/

14.2 User Access

The following user groups are pre-seeded in the component that help you get access to the Metadata Report Extract
screen.
f. MDR View Group: To see Metadata Report Extract with View permissions.

g. MDR Owner Group: To create templates in Metadata Report Extract.

14.3 Create and Export Metadata Report Templates for XML and
Excel

Perform the following steps to create and export the Metadata Report Templates:

1. Navigate to Common Tasks = Metadata Report.
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= ORACLE rinancial Services Data Governance for US Regulatory Reporting

Home >
Search
Template Id
Summary

+add (Fedit [§ View T Delete Exportto Excel Exportto XML Exportto OEMM Download

Template Name

e & | B  UsEngish v  OFSAD v

Qsearch "OReset Refresh

]

Template Id

[ | 208920
[ | 208905
[] | 208904
[ | 208903

Search

Template Id

Summary

[ | Template 1d
[ | 208920
[F] | 208905
[F] | 208904
[ | 208903

+4add Fedit [ View EDelete Export to Excel

Template Name
report OEMM
OEMM_DE
QENIM_Hier

OEMM_Hierarchy

Template Name
report OEMM
OEMM_DE
OEMM_Hier
OEMM_Hierarchy

Export to XML

Sort By v Search =~ & &
Template Description Status. Created Date
Completed 2019-03-14 12:36:34.0
Completed 2019-03-14 11:05:39.0
Completed 2019-03-14 10:59:39.0
Completed 2019-03-14 10:53:480

Click Add icon, in Summary screen, to create a new Metadata Report Template.

9 & [ | US-Englsh

= ORACLE Financial Services Data Governance for US Regulatory Reporting

Template Name

OFSAD ¥ D

Q,Search " Reset Refresh

Export to OEMM  Download Sort By v Search
Template Description Status Created Date

Completed 2019-03-14 12:36:34.0

Completed 2019-03-14 11:05:39.0

Completed 2019-03-14 10:59:39.0

Completed 2019-03-14 10:53:48.0

3. Provide the Name and Description for the new template in Template Definition page.

< Back

Start

Basic Details

Select Metadata ter Objects Lines

Metadata Selection

* Name US FED Lineage

Description US FED Lineage

¥ Return

Q-

4. Select the desired object from the Object Type dropdown to be exported.

Next >
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5. Individual report generates only the basic properties of the object selected, that is, name and
description. Relational report generates detailed information up to the Entities level, if
Dependencies is chosen; and up to the Staging Columns level, if Data Lineage is selected along
with Dependencies.

6. Dependencies: Metadata object is dependent on several other metadata objects. Metadata object
is also used (that is, consumed) in several other metadata objects. Dependency or usage tree
can be of any depth. For example, a rule can be dependent on a hierarchy, business processor,
and dataset. Further, each of these metadata objects can be dependent on other metadata
objects. Metadata Export Utility exports all the dependent or used metadata objects for all paths
in the dependency or usage tree, if this option is selected.

7. Lineage: Data is loaded from source systems to staging and then moved across to processing /
reporting. Lineage traces the data element as it moves across different layers of OFSAA: staging,
processing, and reporting. Metadata Export Utility exports the lineage of each of the reporting
area data element that is identified by dependencies.

8. For Individual Report: In the Export Options, do not select Dependencies or Data Lineage.

Metadata Selection

< Back @ Next »
Start Select Metadata Filter Objects

Metadata

Select | pashboard x

Include

Dependent Objects

Lineage

& save | 7 Retum

9. The exported sample report for Individual is as follows:
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A B & D E F =
1 [CLASSIFICATION RULE DEF ICLASSIFICATION_RULE_NAME CLASSIFICATION_RULE_DESC =
2 1465916940587 RRDF - 14Q FRY 9C Line Re- Classification RRDF - 14Q FRY 9C Line Re- Classification
3
7 =
5
6
[
]
9
10
11 -
H 4 b M| Classification Rule %1 oo | I 0.

10. For Relational Report: In the Export Options, select Dependencies.

Template Definition

L ] Next >
Object Types Filter Objects

< Back

Object Types

Object Types

Choose  Dashboard %

Export Options

Dependencies C

Data Lineage

@ save | 7 Retum

11. The exported sample report for Relational is as follows:

A B G D E E G H J K i
1 [Path Name IDependency =
2 |Path1 Dashboard > Report > View > Hierarchy > Entities >
3 |Path2 Dashboard > Report = View > Derived Entity > Measure > Entities =
4 |Path3 Dashboard = Report = View > Derived Entity > Hierarchy = Entities >
5 |Pathd4 Dashboard = Report = View = Derived Entity > Dataset » Alias > Entities =
6 |Patha Dashboard > Report = View > Derived Entity > Dataset > Entities >
7 |Pathf Dashboard > Report > View > Derived Entity > Business Processor » Measure > Entities >
8 |Path? Dashboard > Report = View > Derived Entity > Business Processor » Dataset > Alias > Entities =
9 Pathd Dashboard > Report = View > Derived Entity » Business Processor » Dataset > Entities »
10 |Path9 Dashboard = Report = View > Reporting Element = Measure > Entities > .|
11 Path10 Dashboard > Report > View > Reporting Element = Hierarchy > Entities > 1
12 Path11 Dashboard > Report > View > Reporting Element = Derived Entity > Measure > Entities >
13 Path12 Dashboard > Report > View > Reporting Element > Derived Entity > Hierarchy > Entities >
14 |Path13 Dashboard > Report > View > Reporting Element = Derived Entity > Dataset > Alias > Entities >
15 Path14 Dashboard > Report = View > Reporting Element = Derived Entity = Dataset > Entities =
16 Path15 Dashboard > Report = View > Reporting Element = Derived Entity > Business Processor > Measure = Entities >
17 |Path16 Dashboard = Report = View > Reporting Element = Derived Entity > Business Processor > Dataset > Alias = Entities »
18 |Path17 Dashboard > Report = View > Reporting Element > Derived Entity > Business Processor > Dataset = Entities >
19 Path18 Dashboard > Report > View > Reporting Element = Business Processor > Measure > Entities >
20 |Path19 Dashboard > Report = View > Reporting Element > Business Processor > Dataset > Alias > Entities > E |
21 |Path20 Dashboard > Report > View > Reporting Element = Business Processor > Dataset > Entities =
22 |5
M 4 » M| Paths -~ Pathl Path2 Path3 Path4 Paths Pathé - Path7 Paths - Path{i [Nl il | B

12. The first sheet shows the different Paths and their Dependencies upto the Entities level. Select
the required Path sheet at the bottom to view the dependencies.

Each path tells how the dependency/usage is derived from dashboard to entity or vice versa involving various OFSAA
object types like Derived Entity, Hierarchies, Datasets, Measures, and so on.

13. These paths are generated by the system using data already published in MDB dependency
tables as part of OFSAA MDB object publish.

14. For every dependent object type displayed in each path sheet, the following columns are
displayed:
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Object type name
Object type description
One or many Object specific properties (optional)

For example: In Pathl, Dashboard is the first Object type, the dependencies generated are
Dashboard Name, Dashboard Description, and Dashboard properties: Dashboard Country,
Dashboard Regulator and so on. Similarly, Report is the next Object type in Pathl and the
dependencies generated are Report Name, Report Description, Views Name, Views Description,
View Display Format and so on. Then followed by Hierarchy Objects name, description and
properties up to the Entities level.

B 3 0 E F G H ] J
1 _NAME _DESC _COUNTRY _REGULATOR [REPORT_NAME JREPORT_DESC VIEWS_NAME VIEWS DESC VIEW_DISPLAY_FORMAT HIERARCHY_NAME B
2 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal Resenve [BS Scheduis BS?Balance Shest FRY-118S  FRY-118S  Tabular IFRS - Reported at fair Value Flag H
3 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS-M Schedule BS-MMemoranda FRY-118S8 FRY-1185M  Tabular Reg delinguency band Hierarchy
4 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Reserve [8S-M Scheduie BS-MMemoranda FRY-11.8SM FRY-11.8SM Tabulsr Sale type code Hierarchy
5 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Faderal Reserve [8S Schedue BS?Balance Sheet FRY-11.65  FRY-1185  Tabular IFRS - Fair Value RCY Hierarchy
6§ FRY-11 Financial Statements of U S. USA Board of Govemors of the Faderal Resanve [iS Schadule 1S7income Stateme FRY-111S  FRY-114S  Tabular Consolidation Code
7 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal Resenve [15-8 [Scheduie 1SB7Changes in AIFRY-114S8  FRY-114S-B  Tabular Repotting Line Code
8 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [8S-M Schedule BS-MIMemoranda FRY-11-8SM  FRY-1185M  Tabular Bands herarchy
9 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [8S Schedute BS7Balance Sheet FRY-1185  FRY-11.85  Tabular Desvative Typs Code Hiecarchy
10 FRY-11 Financial Stataments of U.S. USA Board of Govemors of the Federal Resanve [85-M Schaduie BSMMemaranda FRY-11.6SM FRY-11.8SM Tabular Standard Party Type Hierarchy
11 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Faderal Resenve [BS Schedule BS?Balance Shest FRY-1185  FRY-118S  Tabular Balance Sheet Category Hierarchy
12 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Resenve [85 Scheduie BS?Balance Shest FRY-118S  FRY-1185  Tabular Trading Account Book Type Cade H
13 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [IS-A [Scheduie IS-A7Changes in ECFRY-114SA  FRY-11S-A  Tabular rument Transaction Typd

W4 "paths _ pathy” “Fafhd  Pathi . gathd Paths _Pathe _Pathy Paihd . Patho  Pathi0  Pathil  Pathi2 _pathid  Fathis  patnis M

14 FRY-11 Financial Statements of US USA Board of Govemors of the Federal Reserve |BS [Schedule BS7Balance Sheet FRY-11.8S FRY-118S8 Tabular Non interest beanng depos Hierard
15 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve JBS-M Schedule BS-M?Memoranda FRY-11-BSM FRY-11-8S-M Tabular Accrual Status Code Hierarchy

16 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resene [BS Scheduie BS7Balance Sheet FRY- FRY-118S  Tabular Reporting Line Code

A7 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve IS-A FRY-A14SA  Tabular Instrument type Hierarchy

18 FRY-11 Financial Statements of US USA Board of Govemors of the Federal Reserve JBS-M FRY-11.8S-M  Tabular Regulatory Product Classification H
19 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Resenve [8S-A [Schadule BS-A7Loans and LeFRY-1185A FRY-11.85A Tabular Reg delinquency band Hierarchy
20 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resanve [BS-M [Scheduie BSMMemoranda FRY-11854 FRY-11.85M Tabular Balancs Sheet Category Hierarchy
21 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS-M Schedule BSMMemoranda FRY-118541 FRY-11.85M Tabular Consolidation Code

2 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Reserve [8S-M [Schedue BSMMemoranda FRY-118541 FRY-11.8SM Tabular Holding Type Code Hierarchy

23 FRY11 Financial Statements of U.S. USA Board of Govemors of the Fedoral Reserve [8S Schedule BS7Balance Shest FRY-11.8S  FRY-118S  Tabular Bands hierarchy

24 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS Scheduie BS?Balance Shest FRY-1185  FRY-118S  Tabular Instrument type Hierarchy

25 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resene [8S Scheduie BS?Balance Sheet FRY-1185  FRY-1185  Tabuiar Buy or Sellindicator Hiecarchy

26 FRY-11 Financial Statements of U.S. USA Board of Govemrs of the Federal Resenve [BSA [Schedule BS-A7Loans and LeFRY-11BSA FRY-11BSA Tabuler Troubled Debt Restnuctuse Fiag Hie
21 FRY-11 Financial Statements of U'S. USA Board of Govemrs of the Federal Reserve [BS Schedue BS7Balance Sheet FRY-118S  FRY-11.8S  Tabular Other Real Estate Owned Flag Her
28 FRY-11 Financial Statements of US USA Board of Govemors of the Federal Reserve iIS-B Schedule IS-B7Changes in AIFRY-114S8  FRY-1145-8  Tabular Consohdation Code

29 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS-M [Scheduie BS MMemoranda FRY-118541 FRY-11.8SM Tabular Reg Instrument Classication Hiera,
30 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [S-M [Scheduie BSMMemoranda FRY-118541 FRY-11.85M Tabular Instrument type Hierarchy

31 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Reserve [BS-M Scheduie BS MMemorands FRY-1165M FRY-11.85M Tabular Risk Factor lype code Hierarchy

32 FRY-11 Financial Statements of US. USA Board of Govemors of the Federal Reserve IS A [Schadule IS-A7Changes in ECFRY-114S-A  FRY-114S-A  Tabular Consolidation for Aggregation

33 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [B5-A [Scheduie BS-A7Loans and LeFRY-118S-A FRY-11.8S-A  Tabular Negative Amottization Flag Hierarc
34 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS-M Schedue BSMMemoranda F 41 FRY-11.85M Tabular Customer Country Hierarchy

3 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Resenve [BS-A Schedue BS-A7Loans and LeFRY-118S-A FRY-118SA Tabular Acerual Status Code Flag Hierarchy
36 FRY-11 Financial Statements of US. USA Board of Govemors of the Federal Reserve IS [Schedule ISncome Stateme FRY-11.1S FRY-1148 Tabular Reporting Line Code

37 FRY-11 Financial Statements of US. USA Board of Govemors of the Federal Reserve [BS-M [Schedule BS-M?Memoranda FRY-11-BSM FRY-11-8S-M Tabular Reporting Line Code

A B C D E F G H | J
1 [Path Name lusage
2 Path1 Columns > Hierarchy > View > Report >Dashboard >
3 |Path2 Columns > Measure = Derived Entity > View = Report >Dashboard »
4 Path3 Columns > Hierarchy > Derived Entity > View > Report >Dashboard >
5 |Path4 Columns > Measure > Business Processor > Derived Entity > View > Report >Dashboard >
6 Paths Columns > Measure > Reporting Element > View > Report >Dashboard >
7 |Path6 Columns > Hierarchy > Reporting Element > View > Report >=Dashboard >
§ |Path? Columns > Measure > Derived Entity > Reporting Element > View > Report >Dashboard >
9 Pathg Columns > Hierarchy > Derived Entity > Reporting Element > View > Report >Dashboard >
10 \Pathd Columns > Measure > Business Processor > Derived Entity > Reporting Element > View > Report >Dashboard =
11 |Path10 Columns > Measure = Business Processor > Reporting Element > View = Report >Dashboard >
12
13
14

15
W 4 v M| paths “Pathl “Path2 Path3  Path4 ,“Path5 Path6 . Path7 . Pathg8 . Path{ [l m

NOTE The first sheet shows the different Paths .
and their Usage up to the Dashboard level.

Select the required Path sheet at the bottom to

view the Usage.
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17.

18.

1

A

(CoLUMNS Name ]
Transacton Account F1ag __ Indicates if said account s conside FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy _ Hierarchy for Trans Account FiagBi
Repurchased Or indemnied FlaIndicates if the said account is Rep FCT_LOAN_ACCOUNT_SUMMARY Repurchased of Indemified Flag Repurchased or Indemnified FlagBi
Impairment Amount Under Asc 3 This column stores the impairment FCT_LOAN_ACCOUNT_SUMMARY  Impawr asc31030 Amount Check Impaur asc31030 Amount Check BI
Troubled Debt Restructure Flag  This column indicates if said loan i FCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag  Troubled Debt Restructure Flag 81
Negative Amortization Flag This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY . Negative Amortization Flag Hiera Negative Amorntzation Flag HieraBI
Martgage Broker Surrogate Key This stores unique identiber for the FCT_LOAN_ACCOUNT_SUMMARY  Broker Skey Hierarchy Broker Skey Huerarchy Bl
Cleared Transaction Flag This columns stores if partcular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag HierarcBI
Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc BI
10 Mark To Market Value In Reporti This stores the mark to market valu FCT_REG ACCO\JII’T SUMMARY hMtm Value FRAS Hierarchy Hierarchy Mim Value-FRAS B
11 Broker Surogate key This stores uniqus identiber for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borowi Broker Hierarchy Deposit Borowi BI
12 Callable Degosit Indicator Indicates if said deposit can be call FCT_DEPOSITS_BORROWINGS F_Deposit Option indicator Hierarct Deposit Option Indicator Hierarct BI
13 Impairment Amount Undar Asc 3 This colurm stores the impairment FCT_LOAN_ACCOUNT_SUMMARY impair asc31030 Amount Check Impan asc31030 Amount Check BI
14 Troubled Debt Restructure Flag This column indicates if said loan it FCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag f Troubled Debt Restructure Fiag Bl
15 Troubled Debt Restructure Flag This colum indicates if said loan i< FCT_LOAN_ACCOUNT_SUMMARY . Troubled Debt Restructure Flag t Troubled Debt Restructure Fiag 6l
16 Troubled Debt Restructure Flag This column indicates if said loan is FCT_LOAN_ACCOUNT_SUMMARY . Troubled Delt Restructure Flag t Troubled Debt Restructure Fiag 161
17 Negatie Amortization Flag  This colum stores  loan has negz FCT_LOAN_ACCOUNT_SUMMARY. Negative Amortization Flag Hiera Negative Amortization Flag Hiera Bi
18 Cleaed Transaction Flag This columns stores if partcular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc BI
19 Mark To Market Value In Reporti This stores the mark to market valuFCT_REG_ACCOUNT_SUMMARY hMtm Value-FRAS Hierarchy Hierarchy Mim Value-FRAS Bl
20 Broker Surogate key This stores unique identiber for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borowi Broker Hierarchy Daposit Borow: BI
21 Traubled Debt Restructure Flag This column indicates if said loan isFCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag FTroubled Debt Restructure Flag 81
22 Mortgaga Broker Suogats Key This stores uniqua identiéer for the FCT_LOAN_ACCOUNT_SUMMARY. Broker Skey Hierarchy Broker Skey Hierarchy Bl
23 Mortgage Broker Surrogate Key This stores unique identiier for the FCT_LOAN / ACCOUNT SUMMARY . Broker Skey Hierarchy Broker Skey Hierarchy B8l
24 Claim Local Curency Code Refers 10 the Local currency code f FCT, ﬂEG ACEO\JI" SUMMARY Currency Code Companson Hier: Currency Code Comparison Heer: BI
25 Cross Border Claim indicator  Indicates if said claim is cross brod FCT_REG_ACCOUNT_SUMMARY F Cross Border Claim Hisrarchy  Cross Bordar Claim Hierarchy Bl
26 Transaction Account Flag _ Indicates f said account is conside FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account Flag8I
27 Deposit Call Exercised Indicator This Column Steres the Depostt CaFCT_DEPOSITS_BORROWINGS. F Next Option Flag Deposit Borrow Next Option Flag Deposit Bomow BI
28 Troubled Dabt Restructure Flag This colum indicates if said loan i< FCT_LOAN_ACCOUNT_SUMMARY Troubled Dett Restructur Flag F Troubled Debt Restructure Flag 1B
29 Troubled Debt Restructurs Flag This colum indicates if said loan i<FCT_LOAN_ACCOUNT_SUMMARY . Troubled Db Restructure Flag F Troubled Debt Restructure Flag 81
30 Negative Amortization Flag  This colurmn stores i loan has negz FCT_LOAN_ACCOUNT_SUMMARY  Negative Amontization Flag Hiera Negative Amortization Flag Hiera B
31 Recourse to General Credit  This stores the recourse to general FCT_REG_ACCOUNT_SUMMARY F Recourse To General Credi Indic Recourse To Gensral Credit Indx Bl
32 Contractual Maturty in Days  This column stores the ongnal mati FCT_REG_ACCOUNT_SUMMARY  Contractual Maturity Term Hierar Contractual Maturty Term Hierar BI
33 Nettable Poal Surogate Key  This colurmn stores the reference toFCT_REG_ACCOUNT_SUMMARY I Nettable Pool Surragate Key Hie Nettable Pool Surrogate Key He BI
34 Broker Sumogate key This stores uniqua identiéer for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borow Broker Hierarchy Deposit Borow BI
35 Broker Sumogate key This stores unique identifer for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borowi Broker Hierarchy Deposit Borow BI
36 Deposit Call Exercised Indicator This Column Stores the Deposit CaFCT_DEPOSITS_BORROWINGS F_ Next Option Flag Deposit Borron Next Oplon Flag Deposd BorrowBI
37 Dewsn Lxs(lng Service Prowder ! ms Column Stores the unique ider FCT DEPOSITS_BORROWINGS N_Deposit List Sksy Hierarchy  Deposit List Skey Hierarchy B
o Licoon, N o

\rohana Cnta 1. AT

O Faths | atha - patha Taa T hatid L Bath . Batht o pathy . b

B i D E
ICOLUMNS_DESC COLUMNS_PHYSICAL_COL_ID  HIERARCHY_NAME HIERARCHY_DESC HIER TYPE Nlﬂl MULTI_E Dm PROPERTY HIER vouL _REQD VIEWS_NAME

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

FFIEC031RC.E
FFIECA31RCP |
FRY.9CHCC |
FFIEC-041-RC-0 |
FFIEC031-RC-C |
FFIEC031-RC-P
FFIEC31RCR Part
FRY-150 |
FRY-158 |
FFIEC31RCE |
FFIEC031RCE 13
FFIEC031-RC-C
FRY-9CHCH
FFIEC41RC-C |
FFIECA31.RC-0 |
FFIEC-M41RC-C |
FFECO41RCRPatl |
FRY-15F

FFIEC-041-RC-E
FRY-9CHCC |
FFIEC-041-RC-P
FFIEC-009C, Pan I
FFIEC005C. Part I
FRY-SCHCE
FFIECO31RC-E
FRYTN-BS-A
FR2314-BS-A
FRY-11.8SA
FFIEC-041-RC-V
FFIEC41.RCR Part
FRY-9CHCM
FRY-9CHC-E
FFIEC31RC-0
FFIEC041RCE
FFIEC-041-RC-E

Select Data Lineage in Template Definition > Choose Object Type to export the lineage details

up to the Staging Columns level.

NOTE Data Lineage can be selected only if
Dependencies is opted.

The minimum memory settings to run lineage
reports should be

export JAVA_OPTS="-Xms1024m -Xmx8192m"

Template Definition

< Back O o
Definition Object Types
Object Types
Object Types

Choose  Dashboard x

EXport Options

Dependencies (:)
Data Lineage D

& Save ¥ Retum

lter Objects Lineage Properties

Next »

Data Lineage is generated as a separate sheet in the generated Relational report along with the
Dependencies. Select the Lineage sheet to view the Data Lineage (up to Staging column level).
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Home Insert Page Layout Formulas Data Review View o X
Tl Cut == = o = Crbe PR E AutoSum v

icow Arial -l -|[ATa | | SiwepTed General 13 ﬁd (= L:—_| i % )
GoL F Format panter || /B L1 Lo |5 -|[&- A || EdMerge & Center - | | $ - % ¢ || %8 5% Fc:r""‘da‘g;”;‘v E:“T;'sf;_sélz‘;v dnsertgpeletegromal O Clear~ ;‘ft';fj ;’“ff_

Clipboard 5 Font & Alignment 5 Number 5 Styles cells Editing
AL - £ | scHEDULE v
B C D E F G X

1 [SCHEDULE Iview CELL 1D DERIVED ENTITY CODE METADATA CODE RESULT AREA TABLE RESULT AREA COLUMN
2 HCE FRY-9C-HC-E BHOD6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
3 HCE FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
4 HC-E FRY-9C-HC-E BHOD6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
5 HC-E FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
6 HC-E FRY-9C-HC-E BHOD2604 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
7 HCE FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
8 HC-E FRY-9C-HC-E BHOD6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
9 HC-E FRY-9C-HC-E BHCB2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
10 |HC-E FRY-9C-HC-E BHCB2210 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
11|HC-E FRY-9C-HC-E BHDMA164 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
12 |HC-E FRY-9C-HC-E BHCB2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
13 |HC-E FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
14 [HC-E FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
15 |HC-E FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
16 [HC-E FRY-9CHC-E BHDMA242 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
17 |HC-E FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
18 |HC-E FRY-9CHC-E BHOD2604 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
19 |HC-E FRY-9C-HC-E BHDMA242 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
20 HC-E FRY-9CHC-E BHFNA245 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
21 HC-E FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
22 HC-E FRY-9CHC-E BHFNA245 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
23 HC-E FRY-9C-HC-E BHDMA242 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
24 HCE FRY-9CHC-E BHCB2210 DERHCE03 DSRHCE03 FCT_LEGAL_ENTITY_DETAILS N_ENTITY_TYPE_SKEY
25 HC-E FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
26 HC-E FRY-9CHC-E BHFNA245 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
27 HC-E FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
28 HC-E FRY-9CHC-E BHOD2389 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
29 HC-E FRY-9C-HC-E BHODG648 DERHCE03 DSRHCE03 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
30 HCE FRY-8C.HC-F RHCR2349 DFRHCFO3 DSRHCER FCT RFG_ACCOUNT SUMMAFN RFG DFPOSIT TYPF S
W v W] paths Pathl ~Path? . Path3  Path4 ~ Path5  Patht . Path7 | Lineage . ¥J i m
Ready [EEEFT NS U (

19. Select Filter Objects to see the selected objects.

Template Definition

O O L
Definition Object Types Filter Objects

< Back Next

Lineage Properties

Filter Objects

Dashboard

@ save

¥ Return

>

20. Select one Filter Object from the Available Objects and Click

Select one Selected Object from the Available Objects and click

to add a Selected Object.

to remove a Filter Object.
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Dashboard

Available Objects

B FR2314
EFR-2314s
Ei[FR 20524
i FR 2052b
EFRY-14Q
EFRY-14A
B FFIEC-031
i FR-2886B
i FFIEC-041
EFRY7TN
EFRY-9LP

EFFIEC101

Selected Objects

Search...

B FRY-9C

21. When the object list is huge, use the Search option as shown above. Type first three letters of the

Filter Object name and the relevant Filter Objects is displayed.

NOTE You can type the complete Filter Object
name to select and add to the Selected Objects.

Dashboard

Available Objects

EFRY7N
EFRY-OLP
BFRY-14M
EFRY-15
EFRY-20
EFRY-12
EFRY-11
EFRY-11s
EFRY-14Q
EFRY-14A

FRY|

X o

Selected Objects

EFRY-9C

OK

22. Select the Lineage Properties required to be generated.

23. The following Lineage Properties (columns) are available in the Metadata Report Screen.

Table 2: Lineage Properties
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Lineage

Property

Property Description

1 Jurisdiction Stores the Jurisdiction Code of Lineage Report generated.
2 Report Stores the Report Code of the Lineage Report generated.
3 Schedule Stores the Schedule Code of the Lineage Report generated.
4 View Stores the View Code of the Lineage Report generated.
5 Cell ID Stores the Cell ID (MDRM Code) of the Lineage Report generated.
6 Cell Group ID Stores the Cell Group ID of the Lineage Report generated. Each Cell
Group ID represents a decision to populate the cell. Multiple Group
IDs represent multiple OR conditions in decisions.
7 Derived Entity Stores the Derived Entity Code of the Lineage Report generated for
Code the given Cell ID and Cell Group ID.
8 Derived Entity Stores the Derived Entity Description of the Lineage Report
Description generated for the given Cell ID and Cell Group ID.
9 Metadata Code Stores the Metadata Code of the Lineage Report generated for the
given Cell ID, Cell Group ID and Derived Entity.
10 Metadata Stores the Metadata Description of the Lineage Report generated for
Description the given Cell ID, Cell Group ID and Derived Entity.
11 Metadata Type Stores the Metadata Type of the Lineage Report generated for the
given Cell ID, Cell Group ID and Derived Entity.
12 Metadata Sub Stores the Metadata Sub Code of the Lineage Report generated for
Code the given Cell ID, Cell Group ID, Derived Entity, and Metadata Code.
Metadata Sub Code represents either direct Metadata (Metadata Sub
Code will be same Metadata Code) or derived Metadata Code like
Datasets/Expressions.
13 Metadata Sub Stores the Metadata Sub Description of the Lineage Report
Description generated for the given Cell ID, Cell Group ID, Derived Entity, and
Metadata Code. Metadata Sub Code represents either direct
Metadata (Metadata Sub Code will be same Metadata Code) or
derived Metadata Code like Datasets/Expressions.
14 Metadata Sub Stores the Metadata Sub Type of the Lineage Report generated for
Type the given Cell ID, Cell Group ID, Derived Entity, and Metadata Code.
Metadata Sub Code represents either direct Metadata (Metadata Sub
Code will be same Metadata Code) or derived Metadata Code like
Datasets/Expressions.
15 Result Area Stores the Results Area Table Application of the Lineage Report
Table Application | generated for the given Cell ID, Cell Group ID, Derived Entity,
Metadata Code, and Metadata Sub Code. The Results Area Table
application is the responsible OFSAA Application to populate the
table.
16 Result Area Stores the Results Area Table Type of the Lineage Report generated
Table Type for the given Cell ID, Cell Group ID, Derived Entity, Metadata Code,

and Metadata Sub Code. The Results Area Table Type represents
how the table is populated. For example: Data Flow, Seeded Data,
and so on.

OFSAA DOCUMENT TITLE | 178




17 Result Area Stores the Results Area Table the Lineage Report generated for the
Table given Cell ID, Cell Group ID, Derived Entity, Metadata Code, and
Metadata Sub Code. The Results Area Table is the OFSAA data
model table which populates or helps to populate the given Cell
(MDRM) in the Reporting Layer.
18 Result Area Stores the Results Area Column the Lineage Report generated for
Column the given Cell ID, Cell Group ID, Derived Entity, Metadata Code,
Metadata Sub Code and Results Area Table. The Results Area Table
column is the OFSAA data model column which populates or helps to
populate the given Cell (MDRM) in Reporting Layer.
19 Report Filter Stores the Report Filter Operator of the Lineage Report generated for
Operator the given Results Area Column and Member Code. The operator
represents the Agile REPORTER filter condition operator when a
report is retrieved.
20 Report Filter Stores the Report Filter Member of the Lineage Report generated for
Member the given Results Area Column. The operator represents the Agile
REPORTER filter condition member when a report is retrieved.
21 Target Metadata | Stores the Target Metadata Operator of the Lineage Report
Operator generated for the given Results Area Column and Member Code
embedded inside the Metadata like Business Processor, Hierarchy or
Dataset. The operator is derived after a standardization process like:
Reverting all <>, =, IN, NOT IN conditions to equal operator.
22 Target Metadata | Stores the Target Metadata Operator of the Lineage Report
Member generated for the given Results Area Column and Member Code
embedded inside the Metadata like Business Processor, Hierarchy or
Dataset. The Member Code presents its ultimate form through a
standardization process like: Reverting all <>, =, IN, NOT IN
conditions to equal operator and getting the respective Member
Codes.
23 Reporting Run Stores the Regulatory Reporting Run Name for Jurisdiction Code of
Name Lineage Report generated.
24 Lineage Run or Stores the Levell Run Name or Batch Name of Lineage Report
Batch Levell generated for populating the Results Area Table and Column.
25 Lineage Data Stores the Levell Data Flow Name of Lineage Report generated for
Flow Name populating the Results Area Table and Column.
Levell
26 Lineage Data Stores the Levell Data Flow Type of Lineage Report generated for
Flow Type populating the Results Area Table and Column.
Levell
27 Lineage Element | Stores the Levell Source Table of Lineage Report generated for
Table Levell populating the Results Area Table and Column.
28 Lineage Element | Stores the Levell Source Column of Lineage Report generated for
Column Levell populating the Results Area Table and Column.
29 Lineage Run or Stores the Level2 Run Name or Batch Name of Lineage Report
Batch Level2 generated for populating the Levell Source Table and Column.
30 Lineage Data Stores the Level2 Data Flow Name of Lineage Report generated for

Flow Name
Level2

populating the Levell Source Table and Column.
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31 Lineage Data Stores the Level2 Data Flow Type of Lineage Report generated for
Flow Type populating the Levell Source Table and Column.
Level2

32 Lineage Element | Stores the Level2 Source Table of Lineage Report generated for
Table Level2 populating the Levell Source Table and Column.

33 Lineage Element | Stores the Level2 Source Column of Lineage Report generated for
Column Level2 populating the Levell Source Table and Column.

34 Lineage Run or Stores the Level3 Run Name or Batch Name of Lineage Report
Batch Level3 generated for populating the Level2 Source Table and Column.

35 Lineage Data Stores the Level3 Data Flow Name of Lineage Report generated for
Flow Name populating the Level2 Source Table and Column.
Level3

36 Lineage Data Stores the Level3 Data Flow Type of Lineage Report generated for
Flow Type populating the Level2 Source Table and Column.
Level3

37 Lineage Element | Stores the Level3 Source Table of Lineage Report generated for
Table Level3 populating the Level2 Source Table and Column.

38 Lineage Element | Stores the Level3 Source Column of Lineage Report generated for
Column Level3 populating the Level2 Source Table and Column.

39 Lineage Run or Stores the Level4 Run Name or Batch Name of Lineage Report
Batch Level4 generated for populating the Level3 Source Table and Column.

40 Lineage Data Stores the Level4 Data Flow Name of Lineage Report generated for
Flow Name populating the Level3 Source Table and Column.
Leveld

41 Lineage Data Stores the Level4 Data Flow Type of Lineage Report generated for
Flow Type populating the Level3 Source Table and Column.
Leveld

42 Lineage Element | Stores the Level4 Source Table of Lineage Report generated for
Table Leveld populating the Level3 Source Table and Column.

43 Lineage Element | Stores the Level4 Source Column of Lineage Report generated for
Column Level4 populating the Level3 Source Table and Column.

44 Lineage Run or Stores the Level5 Run Name or Batch Name of Lineage Report
Batch Level5 generated for populating the Level4 Source Table and Column.

45 Lineage Data Stores the Level5 Data Flow Name of Lineage Report generated for
Flow Name populating the Level4 Source Table and Column.
Level5

46 Lineage Data Stores the Level5 Data Flow Type of Lineage Report generated for
Flow Type populating the Level4 Source Table and Column.
Level5

a7 Lineage Element | Stores the Level5 Source Table of Lineage Report generated for
Table Level5 populating the Level4 Source Table and Column.

48 Lineage Element | Stores the Level5 Source Column of Lineage Report generated for
Column Level5 populating the Level4 Source Table and Column.

49 Lineage Run or Stores the Level6 Run Name or Batch Name of Lineage Report

Batch Level6

generated for populating the Level5 Source Table and Column.
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50 Lineage Data Stores the Level6 Data Flow Name of Lineage Report generated for
Flow Name populating the Level5 Source Table and Column.
Level6

51 Lineage Data Stores the Level6 Data Flow Type of Lineage Report generated for
Flow Type populating the Level5 Source Table and Column.
Level6

52 Lineage Element | Stores the Level6 Source Table of Lineage Report generated for
Table Level6 populating the Level5 Source Table and Column.

53 Lineage Element | Stores the Level6 Source Column of Lineage Report generated for
Column Level6 populating the Level5 Source Table and Column.

54 Lineage Run or Stores the Level7 Run Name or Batch Name of Lineage Report
Batch Level7 generated for populating the Level6 Source Table and Column.

55 Lineage Data Stores the Level7 Data Flow Name of Lineage Report generated for
Flow Name populating the Level6 Source Table and Column.
Level7

56 Lineage Data Stores the Level7 Data Flow Type of Lineage Report generated for
Flow Type populating the Level6 Source Table and Column.
Level7

57 Lineage Element | Stores the Level7 Source Table of Lineage Report generated for
Table Level7 populating the Level6 Source Table and Column.

58 Lineage Element | Stores the Level7 Source Column of Lineage Report generated for
Column Level7 populating the Level6 Source Table and Column.

59 Lineage Run or Stores the Level8 Run Name or Batch Name of Lineage Report
Batch Level8 generated for populating the Level7 Source Table and Column.

60 Lineage Data Stores the Level8 Data Flow Name of Lineage Report generated for
Flow Name populating the Level7 Source Table and Column.
Level8

61 Lineage Data Stores the Level8 Data Flow Type of Lineage Report generated for
Flow Type populating the Level7 Source Table and Column.
Level8

62 Lineage Element | Stores the Level8 Source Table of Lineage Report generated for
Table Level8 populating the Level7 Source Table and Column.

63 Lineage Element | Stores the Level8 Source Column of Lineage Report generated for
Column Level8 populating the Level7 Source Table and Column.

64 Lineage Run or Stores the Level9 Run Name or Batch Name of Lineage Report
Batch Level9 generated for populating the Level8 Source Table and Column.

65 Lineage Data Stores the Level9 Data Flow Name of Lineage Report generated for
Flow Name populating the Level8 Source Table and Column.
Level9

66 Lineage Data Stores the Level9 Data Flow Type of Lineage Report generated for
Flow Type populating the Level8 Source Table and Column.
Level9

67 Lineage Element | Stores the Level9 Source Table of Lineage Report generated for
Table Level9 populating the Level8 Source Table and Column.

68 Lineage Element | Stores the Level9 Source Column of Lineage Report generated for
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Column Level9

populating the Level8 Source Table and Column.

69 Lineage Run or Stores the Level1l0 Run Name or Batch Name of Lineage Report
Batch Level10 generated for populating the Level9 Source Table and Column.

70 Lineage Data Stores the Levell0 Data Flow Name of Lineage Report generated for
Flow Name populating the Level9 Source Table and Column.

Levell0

71 Lineage Data Stores the Level10 Data Flow Type of Lineage Report generated for
Flow Type populating the Level9 Source Table and Column.

Levell0

72 Lineage Element | Stores the Levell0 Source Table of Lineage Report generated for
Table Levell0 populating the Level9 Source Table and Column.

73 Lineage Element | Stores the Levell0 Source Column of Lineage Report generated for
Column Levell0 | populating the Level9 Source Table and Column.

74 Data Element Stores the Ultimate Source Table Application of Lineage Report
Table Application | generated for populating the Results Area Table and Column. The

application is responsible for sourcing the data.

75 Data Element Stores the Ultimate Source Table Type of Lineage Report generated
Table Type for populating the Results Area Table and Column. This represents

the Type of the Source Table like Download, Mapper Download,
Seeded Data, Run Parameters, and so on.

76 Data Element Stores the Ultimate Source Table of Lineage Report generated for
Table populating the Results Area Table and Column.

77 Data Element Stores the Ultimate Source Column of Lineage Report generated for
Column populating the Results Area Table and Column.

78 Data Element Stores the Ultimate Source Table Column Operator Code of Lineage
Filter Operator Report generated with respect to Report Filter Operator in Results

Area. This is the derived representation of Report Filter Operator in
Results Area.

79 Data Element Stores the Ultimate Source Table Column Member Code of Lineage

Filter Member Report generated with respect to Report Filter Member Code in
Results Area. This is the derived representation of Report Filter
Member Code in Results Area.

80 Data Element Stores the Ultimate Source Table Column Operator Code of Lineage
Metadata Report generated with respect to Target Metadata Operator in
Operator Results Area. This is the derived representation of Target Metadata

Operator in Results Area.
81 Data Element Stores the Ultimate Source Table Column Member Code of Lineage

Metadata
Member

Report generated with respect to Target Metadata Member Code in
Results Area. This is the derived representation of Target Metadata
Member Code in Results Area.
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0] 0] O

< Back
Dedinition Object Types Filter Objects

Lineage Properties

Dashboard

View

Cellld

Cell Group Id

Derived Entity Code

Derived Entity Description

Metadata Code <
Metadata Description

Metadata Type

Metadata Sub Code

Metadata Sub Description

Metadata Sub Type -

& save

¥ Retumn

Template Definition

Lineage Properti Reviev

L4 Next »

B Lineage Element Column Levels
[l Lineage Element Table Level5

[ Lineage Data Flow Type Level5
B Lineage Data Flow Name Level5
E Lineage Run or Batch Level5

[ Lineage Element Column Leveld
B Lineage Element Table Leveld
E Lineage Data Flow Type Leveld
E Lineage Data Flow Name Level4
B Lineage Run or Batch Leveld

I schedule

B Report -

24. Review the Template Definition once and click Save.

Template Definition
< Back O o) ) O ® Next
Definition Object Types Filter Objects Lineage Properties Review
Review
Object Identifier Object Name Object Type
[ 1530631628798 FR-2314 Dashboard
1 1530631628769 FRY-9C Dashboard
Page 1 of1(1-2of2items)
@ Save ¥ Retum

25. Click Return to go to the Summary page.

= ORACLE Financial Services Data Governance for US Regulatory Reporting
Home 2>

Search

Template Id

Summary

+add (Fedit [ View @ Delete Exportto Excel Exportto XML Exportto OEMM  Download

[ | Template I1d Template Name Template Description

[ | 208920 report OEMM

[ | 208905 OEMM_DE

[ | 208904 OEMM_Hier

[ | 208903 OEMM_Hierarchy

US-English  + OFSAD ~

Q Search "DReset Refresh

Template Name

Sort By v Search A
Status Created Date
Completed 2019-03-14 12:36:340
Completed 2019-03-14 11.05:390
Completed 2019-03-14 10:59:39.0
Completed 2019-03-14 10:53:48.0
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26. Select a Template in the Template List in Summary screen and click Export to Excel to export the
desired objects in Excel Sheet format.

NOTE MDB Publish must be triggered before .
executing the Export to Excel option.

27. The Report Generation function is an asynchronous action and to check the status of the export
function, use the Refresh option in Summary screen.

= ORACLE Financial Services Data Governance for US Regulatory Reporting @ & B US-English = OFSAD ~ (o]
Home >

Search Q Search "DReset Refresh

Template Id Template Name

Summary

+4add (FEdit [ View @ Delete Exportto Excel Exportto XML Exportto OEMM  Download Sort By v Search =~ t? _3
[ | Template Id Template Name Template Description Status Created Date

[F] | 208920 report OEMM Completed 2019-03-14 12:36:340

[ | 208905 QEMM_DE Completed 2019-03-14 11:05:39.0

[F] | 208804 OEMM_Hier Completed 2019-03-14 10:59:39.0

[ | 208903 OEMM _Hierarchy Completed 2019-03-14 10:53:48.0

e For Excel Export, the following are the Status values:

= Not Started: The Report Generation is yet to start, but the function has triggered theﬁn in
the background.

= Ongoing: The Report Generation is started and in process.
= Completed: The Report Generation is completed and ready to view or download.

= Failed / Partially Completed / No Path Found: The Report Generation encountered an issue
and the process is partially completed or failed.

h. The export logs are generated and placed in the path /Context_ Name/logs/MDB.log.
Log files give the following information:

a) All Paths query

b) Query for each path and if data present for this path
C) Lineage query

d) Status of excel output creation

e) Exceptions and errors, if any

e For XML Export:
= Not Started

= Check the Metadata Export folder in the server

NOTE This is to distinguidh the XML extract from o
the Excel export. XMLs cannot be downloaded
from the UI.

28. Select a Template in the Template List in Summary screen and click Download to save a copy of
the generated Metadata Report Templates excel sheet, after the export status shows as
completed.
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Home >

Search

Summary
+add (Fedit B Vview @ Delete  Export to Ex

Template Id
208920
208905
20804

208903

User Access

= ORACLE Financial Services Data Governance for US Regulatory Reporting

cel ExporttoXML Exportto OEMM  Download

Template Name Template Description

report OEMM
OEMM_DE
OEMM_Hier
OEMM_Hierarchy

Status

Completed
completed
Completed
Completed

@; [  UsEnglish ~  OFSAD ~

Q search "DReset Refresh

FY
i
(e

Created Date

2019-03-14 12:36:34.0
2019-03-14 11:05:39.0
2019-03-14 10:59:39.0
2019-03-14 10:53:48.0

The following user groups are pre-seeded in the component that help you to get access to the Metadata Report
Extract screen.

i. MDR View Group: To see Metadata Report Extract with View permissions.

j-  MDR Owner Group: To create templates in Metadata Report Extract.

14.4 Create and Export Metadata Report Templates for OEMM

OEMM is a complete metadata management platform that can reverse engineer (harvest)

BEGIN

and catalog metadata from any source: relational, Big Data, ETL, BI, data modelling, etc.
OEMM allows you to perform:

Interactive searching
Data lineage

Impact analysis

The metadata from different sources and applications can be related (stitched)

Metadata can be from different providers (Oracle or/and third-party)

Manages versioning and comparison of metadata models.

Shows the complete path of data from source to report or vice versa.

The OFSAA Metadata lineage can also be viewed through the OEMM tool. DGS metadata extract utility
now supports metadata export in OEMM extract format. OEMM provides XL template to harvest

metadata, DGS export utility updates the template which is then imported in OEMM.

The metadata lineage is supported for following OFSAA objects like Report, Measures, Derived Entities,
Hierarchies, T2T,Datasets, Business Processor.

Prerequisite

a. Execute the following Gather Stat command for the mentioned tables:

DBMS STATS.GATHER TABLE STATS (USER, 'TABLE NAME');

END;

FSI_DE_ACTIVE_TABLE_APP_MAP
FS|_DE_METADATA_ELEMENT_MAP
FSI_DE_METADATA_MASTER
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FS|_DE_METADATA_ULT_TABLE_MAP
FS|_DE_OBJECT_REPOSITORY_B
FS|_DE_REPORT_LINEAGE_BASE
FSI_DE_RUN_FLOW_ULT_STG_MAP

NOTE MDB Publish must be triggered before
executing the Export to OEMM option.

Data element POP USFED batch needs to be
executed. Refer the section of Data element
POP USFED for more details.

1. Navigate to Common Tasks > Metadata Report.

= ORACLE Financial Services Data Governance for US Regulatory Reporting

Search
Template Id

Summary

Zedit [ View W@Delete Export to Excel Exportto XML  Export to OEMM  Download
Template Id Template Name Template Description
208922 OEMM Derived Entity OEMM_Derived_Entity
] | 208921 OEMM-hierarchy 02 HRA1019
[E] | 208920 report_OEMM
[ | 208905 OEMM _DE
] | 208904 OEMM _Hier
[F] | 208903 OEMM_Hierarchy
[E] | 208902 hierarchy_OEMM
[ | 208901 EOP_bal
[F] | 208900 measure
[F] | 208880 European Lineage European Lineage
7] | 208851 template template
7] | 208880 oemm_report oemm_report

i)

Template Name

Sort By v Search

Status

Not Started

Completed

Completed

Completed

Completed

Completed

Check MetadataExport folder in server.
Completed

Completed

Not Started

Completed

Failed/Partially Completed/Na Path Found

M
&

= US-English = QOFSAD v

Qsearch ‘DReset Refresh

Created Date

2019-03-14 13:08:49.0
2019-03-14 13:07:48.0
2019-03-14 12136340
2019-03-14 110539.0
2019-03-14 10:59:39.0
2019-03-14 10:53:48.0
2019-03-14 10:5232.0
2019-03-13 1857500
2019-03-13 18:5317.0
2019-03-11 12:1709.0
2019-03-09 16:1302.0
2019-03-09 16:1136.0

« i

Page 1 ofl(l-120f1Zitems) K < > X

2. Click Add icon, in Summary screen, to create a new Metadata Report Template.

Records Per Page 15
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= ORACLE Financial Services Data Governance for US Regulatory Reporting 9 & [(E US-English ¥ | OFSAD ¥

Home >
Search Q_Search "DReset Refresh
Template Id Template Name

Summary
Zedit [ View HDelete By "y / v v A
@ v port to Excel Exportto XML  Export to OEMM  Download Sort By Search > =

Template Id Template Name Template Description Status Created Date
p P p P

208922 OEMM_Derived Entity OEMM _Derived Entity Not Started 2019-03-14 13:08:49.0

] | 208921 QEMM-hierarchy 02 HRA1019 Completed 2019-03-14 13:07:48.0

] | 208920 report_OEMM Completed 2019-03-14 12:36:34.0

] | 208905 OEMM_DE Completed 2019-03-14 11:05:39.0

[C] | 208904 QEMM_Hier Completed 2019-03-14 10:59:39.0

[ | 208903 QEMM_Hierarchy Completed 2019-03-14 10:53:48.0

] | 208902 hierarchy_OEMM Check MetadataExport folder in server. 2019-03-14 10:52:32.0

] | 208901 EOP_bal Completed 2019-03-13 18:57:50.0

[ | 208900 measure Completed 2019-03-13 18:53:17.0

[ | 208880 European Lineage European Lineage Not Started 2019-03-11 12:1709.0

7] | 208861 template template Completed 2019-03-09 16:13:02.0

[C] | 208860 oemm_report oemm_report Failed/Partially Completed/No Path Found 2019-03-09 16:11:36.0

el I
Page 1 of1(l-120f12items) K < > M Records Per Page | 15

3. Provide the Name and Description for the new template in Template Definition page and then
click Next.

Metadata Selection

< Back L] e} Next >
Start Select Metadata
Basic Details

Wl T T OENIM Derived Entity}

Description OEMM_Derived_Entity|

[} ¥ Return

4. Select the desired object from the Object Type dropdown to be exported.
e Object types supported by OEMM export from metadata reports are

e Reports

e Derived Entities

e Hierarchy

e Measures

o T2T
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e Datasets

e Business Processor

NOTE Only the above types are supported for )
OEMM Extract
5.
Metadata Selection
< Back O L] Next >
Start Select Metadata Filter Objects Lineage Properties Review

Metadata

Select  perived Entities X

Include

Dependent Objects ()
Lineage ()

& save 7 Retun

6. Based on the object type selected move to the filter objects and select a entity.

7. The Lineage Properties section can be skipped

Derived Entities

Available Derived Entities(s) Selected Derived Entities(s)

[l DE - Loan and Lease Financing Receivables - HCC1

DE - Loan and Lease Financing Receivables - HCC1 Q

8. Review the Metadata Selection once, and then click Next.
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Metadata Selection

< Back O O O O L] Next >
Start Select Metadata Fitter OD}EE(S Llneage Peren\ES Review r————
Object Identifier Object Name Object Type
0 1551980473564 DE - Loan and Lease Financing Receivables - HCC1 Derived Entities

Page 1 of1 (10f1items)

@ save 7 Retum

9. Click Return to go to the Summary page.

= ORACLE Financial Services Data Governance for US Regulatory Reporting e & [E US-English ~ ~ = OFSAD ~
Home >

Search QSearch D Reset Refresh

Template Id Template Name
Summary
Zedit K View ® " v » v 5 | A3
@edit [ View @Delete Exportto Fxcel Exportto XML Exportto OEMM  Download Sort By Search > =l
Template Id Template Name Template Description Status Created Date

208922 OEMM Derived Entity OEMM _Derived_Entity Not Started 2019-03-14 13:08:49.0

[ | 208921 OEMM-hierarchy 02 HRA1019 Completed 2019-03-14 1307:48.0

[ | 208920 report OEMM Completed 2010-03-14 12:36:34.0

[ | 208905 OEMM_DE Completed 2019-03-14 1105:39.0

[] | 208904 CEMM _Hier Completed 2019-03-14 10:59:39.0

[ | 208903 OEMM _Hierarchy Completed 2019-03-14 10:53:48.0

[ | 208902 hierarchy OEMM Check MetadataExport folder in server. 2019-03-14 10:5232.0

[ | 208901 EOP_bal Completed 2019-03-13 18:57:50.0

[ | 208900 measure Completed 2019-03-13 18:53:17.0

[ | 208880 European Lineage European Lineage Not started 2019-03-11 12:1709.0

[ | 208851 template template Completed 2019-03-09 16:1302.0

[] | 208850 oemm_report oemm_report Failed/Partially Completed/No Path Found 2019-03-09 16:1136.0

EN i
Page 1 of1(1-120f12items) K < > Records Per Page 15

10. Select a Template in the Template List in Summary screen and click Export to OEMM

11. The Report Generation function is an asynchronous action and to check the status of the export
function, use the Refresh option in Summary screen.
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Export process Nas been triggered! Please use the refresh option to check the status.

e

Home >
~ Search Q.search "D Reset Refresh
Template Id Template Name
~ Summary
Add (Zedit [ View EDelete Exportto Excel Exportto XML Exportto OEMM  Download Sort By ¥ Search g & &
@] | Template Id Template Name Template Description status Created Date
208922 ‘OEMM _Derived Entity OEMM Derived_Entity Ongoing 2019-03-14 13:08:49.0
208921 OEMM-hierarchy 02 HRA1019 Completed 2019-03-14 1307480
208920 report OEMM Completed 2019-03-14 12:36:34.0
208505 OEMM_DE Completed 2019-03-14 11:05:390
208904 OEMM_Hier Completed 2019-03-14 10:59:39.0
208903 OEMM_Hierarchy Completed 2019-03-14 10:53:48.0
208002 hierarchy_OEMM Check MetadataExport folder in server 2019-03-14 10:52:320
208901 EOP_bal Completed 2019-03-13 18:57:500
208900 measure Completed 2019-03-13 1853170
208880 European Lineage European Lineage Not Started 2019-03-11 12:17:09.0
208861 template template Completed 2019-03-09 16:13:020
208860 oemm_report oemm_report Failed/Partially Completed/No Path Found 2019-03-09 16:11:36.0
< i ]
Page 1 ofl(l-120fl2items) K < > Records Per Page 15

OEMM Extract

The following is an example of the Model sheet:
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derived entity-DERHCCO1_OEMM (version 1) xlsh [Autosaved] - Excel

Insert  PageLayout Formulas Data Review  View Developer Q Tell me what you want to £ share
e, Jbcut Avial BTNy B WrapTet General . [F¥ | normal2 Normal 3 = Ex i 2 Autasum - ’E‘Y ,O
Paste E%Capy 3 0 o0 Conditi I Fe Dt - lEElrt IEE\‘et Fo it mFlH' Sort & Find 8
e rormapanter | B T U | Merge & Cener = | § + % » | % g5 Condlona Forms Nommal32 [ Horma o] et Dokt Fomat | 4, Saa e
Clipboard i Font ] Alignment i) MNumber ] Styles Cells Editing ~
P19 - I DERHCCO1 -
A B ® K M P Q IN] AK AL, AN BM| DT [ DW | DX DY Dz EA EB [~
 How to use”
4 [ Models-4.2
2 [Models / Dita Store_ |Package Schema Entity / Table / Record / View] File Attribute / Column / Field ©
Name  |Type Level 1 Name |Name Name Business Name | Description | Name: Business Name | Descriptio ||Positi]ls |Data Type|Length] Scale
n on |0
pti
on
D 0 Financial Senvic|FSDF_Di Lease Financing {DERHCC! DE - Loan ar|BP- Amt based of holding tyjBP- Amt based o/BP- Amt ba [YeqVarchar2 |20
D 0 Financial Senic|FSDF_DI Lease Financing {DERHCC! DE - Loan ar{HIR-GLTypeCd HIR-GLTypeCd_|HIR-GLTypel VelVarchara [[20
D 0 Financial Senvic|FSDF_Di Lease Financing {DERHCC! D Reported at fair value flag HigReported at fair v{Reported at [Ye{Varchar;
D 0 Financial Senvic|FSDF_DI Lease Financing {DERHCC! D BP- Amount based of holdind5P- Amount basqBP- Amount] [Ye{Varchar;
D 0 Financial Servic|FSDF_Di Lease Financing DERHCC! D Holding Type Code HierarchyHolding Type CodHolding Typ: [Ve{Varchar:
D 0 Financial Senic|FSDF_Di Lease Financing {DERHCC D Band Type Hierarch Band Type Hierar|Band Type ] [Ye{Varchar:
D 0 Financial Senvic|FSDF_DI Lease Financing {DERHCC! D Foreclosure Status Foreclosure Stati|Foreclasur [Ve{Varchar,
11DE 0 Financial Senvic|FSDF_DE Lease Financing {DERHCC! D Geography - Branch Country|Geography - Brar{ Gengraphy | [Ye{Varchar;
12 [DE 0 Financial Senic|FSDF_DE Lease Financing DERHCC! D BP- Amount based of holdindBP- Amount basqBP- Amourt] [Ve{Varchar:
13 [DE 0 Financial Senic|FSDF_DE Lease Financing {DERHCC! DE - Loan ar{Reg O Prin Bal _|Reg O Reg Outstan| [Ye{Varchar;
14 DE 0 Financial Senic|FSDF_DE Lease Financing {DERHCC! DE - Loan ar{Pledged Status Pledged Status_|Pledged Stal [Ye{Varchar;
15 [DE 0 Financial Senic|FSDF_DE Lease Financing DERHCC! DE - Loan ar{Fair value - IFRS Account SuFair value - IFRS |Fair value - | [Ye{Varchar? _|[2|
16 [DE Ol Financial Senic|F SDF_DE Lease Financing HDERHCC DE - Loan ar|Standard Party Type Hierarc|Standard Party T{Standard Pl Ve{varcharz_[[20
17 [DE 0 Financial Senic|FSDF_DE Lease Financing {DERHCC! DE - Loan ar|EOP Balance RGY - FRS _|EOP Balance RCIEOP Baland] [Ve{Varchar,
DE 0 Financial Senvic|FSDF_DE Lease Financing {DERHCC! DE - Loan ar|Regulatory Product Classific{Regulatory Produ[Regulatory H 15| Ye{Varchar.
D 0 Financial Servic|FSDF_Di Lease Financing ADERHCC! DE - Loan ar{Troubled Debt B{Troubled Debt Re|Troubled De 6[e{Varchar,
D 0 Financial Senic|FSDF_Di Lease Financing {DERHCC! DE - Loan ar{Country Country Country 7[Ye{Varchar;
D 0 Financial Senic|FSDF_DI Lease Financing {DERHCC! DE - Loan ar|POGI Boolean Flag POCI Boolean FIJPOCI Boole: 8[ve{Varchar,
D 0 Financial Servic|FSDF_Di Lease Financing DERHCC! DE - Loan ar|/Accrual Status Code Flag Hil Acerual Status ClAccrual Stat| 19| Ye{Varchar.
D 0 Financial Senic|FSDF_DI Lease Financing {DERHCC! DE - Loan ar|Reg band HierafReg Reg delinqud 20| Ye{Varchar:
D 0 Financial Senic|FSDF_DE Lease Financing {DERHCC DE - Loan ar|Purchase date Hierarchy __|Purchase date HiPurchase dg| 21| Ye{Varchar2 |20
0 Financial Senic|FSDF_RES __|Account Dimension DIM_ACCOU ummary AdPoint Of Sale Indicator F_POS_FACILM{This column[33__|Ye{CHAR
0 Financial Senic|FSDF_RES _|Account Dimension DIM_ACCOU ummary AdOriginal Combined Loan To \N_ORIG_COMBI This colum{a1 _|Ye{NUMBER |[22 3
0 Financial Senic|FSOF_RES __|Account Dimension DIM_ACCOU ummary AdAccount Attrition Reason ColV_ATT REAS CiThis is the a{12__|Ye{VARCHAR2[10
0 Financial Senic|FSDF_RES __|Account Dimension DIM_ACCOU ummary AdCurrency Code V_CCY_CODE _|Unique identf50 | Ye{VARCHAR2
0 Financial Senic|FSDF_RES __|Account Dimension DIM_ACCOU ummary AdJoining Credit Score Band_|V_JOINING_CRE|The band cof11__|Ye{VARCHAR2[16
i AIM_ACCAL Cod MKTR FONE Thic is tha ofR1 cH -

.3
2 5
[y
z
)
b=}
&
&

Ready Recovered

3/14/2019

derived entity-DERHCCO1_OEMM (version 1) xlsh [Autosaved] - Excel

Insert Page Layout Formulas Data Review View Developer Q Tell me what you want to do. 8 Share
sy Jb Cut Arial 6 Wrap Text General - HY Normal2 Normal 3 gﬂﬂ BX i 2 AutoSum - Q‘Y p
o D 2 o Conditional F =2 =i EE\‘ F T Sort &l Find &
e punter Iu- ElMerge&eCenter ~ | $ + % » | 28 FDD":;;D"";V DT’;E\ESS Normal 3 2 Normal o nsert Delte Fornat FK;V B
Clipboard w Font w Alignment n Number w Styles Cells Editing ~
AQa - fe | DE-Loan and Lease Financing Receivables - HCC1 “
A B R S T U v AP AQ AR AS AT AU AV AW AX[<
1_|Mappings-u-2
2 |Mapping M Source N Target N
Name Description Model Schema Table [Alias [Column Column Table Schema TModel
AP Cell Mapping RES FSDF Fact Mitigants _|FCT_MITIGANTS |Extraction Date Sumogate|BP- Amt based of [DE - Loan and o]
AP Cell Mapping RES FSDF Fact Mitigants __|FCT_MITIGANTS |Mitigant Surrogate Key |BP- Amt based of |DE - Loan an ]
C AP Cell Mapping RES FSDF Holding Type DimgDIM_HOLDING TV|Holding Type Code__1802BP- Amount basedDE - Loan an DI
C AP Cell Mapping RES FSDF g AccoulFCT_REG_ACCOURuN Suragate Ke: BP- Amt based of |DE - Loan an DI
C AP Cell Mapping RES FSDF g AccoulFCT_REG_ACCOURun Surogate Ke: Standard Party Ty|DE - Loan an o]
C AP Cell Mapping RES FSDF g Accou]FCT_REG_ACCOUAccount Surrogate Key | Geography - BrandDE - Loan an DE
C AP Cell Mapping RES FSDF, g AccoulFCT_REG_ACCOUAccount Surogate Key | Troubled Debt Res|DE - Loan an DE
C AP Cell Mapping RES FSDF g AccoulFCT_REG_ACCOUAccount Surrogate Key |Reported at fair val DE - Loan an DE
12 [CELLMAP Cell Mapping RES FSDF q Accou]FCT_REG_ACCOUAccount Surogate Key | Accrual Status Co|DE - Loan an DE
13 [CELLMAP Cell Mapping RES FSDF g Accou]FCT_REG_ACCOUAccount Surrogate Key | Country ~Loan an DE
14 [CELLIMAP Cell Mapping RES FSDF g AccoulFCT_REG_ACCOUAccount Surogate Key |BP- Amount basedDE - Loan an DE
15 [C AP Cell Mapping RES FSDF g AccoulFCT_REG_ACCOUAccount Surogate Key |BP- Amt based of |DE - Loan an DE
16/C AP Cell Mapping RES FSDF g Accou]FCT_REG_ACCOUAccount Sumogate Key |POCI Boolean FladDE - Loan an DE
17[C AP Cell Mapping RES FSDF, g Accou]FCT_REG_ACCOULoad Run Identifier Accrual Status Co|DE - Loan an DE
18 [CELLIMAP Cell Mapping RES FSDF g AccoulFCT_REG_ACCOULoad Run Identifier Geagraphy - BrangDE - Loan an DE
19 [CELLMAP Cell Mapping RES FSDF q Accou]FCT_REG_ACCOULoad Run Identifier Troubled Debt Res|DE - Loan an DE
20 [CELLMAP Cell Mapping RES FSDF g Accou]FCT_REG_ACCOULoad Run Identifier Foreclosure Statu§DE - Loan an DE
21[C AP Cell Mapping RES FSDF, Fact Comman AcqFCT_COMMON_A{Account Surrogate Key |Reg 5DE - Loan an DE
22 [CELLMAF [Cell Mapping RES FSDI Fact Commen AcdFCT_COMMON_A{Account Surrogate Key |Reported at fair val DE - Loan an DE
23[C AP Cell Mapping RES FSDF_RES Fact Common AcdFCT_COMMON_A¢Account Surrogate Key |EOP Balance RCYDE - Loan an DE
24[C AP Cell Mapping RES FSDF_RES Regulatory AccoulFCT_REG_ACCOUExtraction Date Surrogate[HIR-GLTypeCd ~Loan an DE
25 [C AP Cell Mapping RES FSDF_RES Fact Account MitidFCT_ACCOUNT, QEx\racmn Date ~ Amt based of |DE - Loan an DE
26 C AP Cell Mapping RES FSDF_RES Fact Loan SummalFCT_LOAN_ACCO|Extraction Date SurmogatelForeclosure StatugDE - Loan an DE
27[C AP Cell Mapping RES FSDF_RES Fact Common AcdFCT_COMMON_A{Load Run Identifier BP- Amount baseqDE - Loan an DI
28 C AP Cell Mapping RES FSDF_RES Fact Comman AcdFCT_COMMON_A{Load Run Identifier POCI Boolean Fla{DE - Loan an DI
29[C AP Cell Mapping RES FSDF_RES Fact Commen AcdFCT_COMMON_A{Load Run Identifier Foreclosure Statu§DE - Loan an o]
30 [CELLMAP Cell Mapping RES FSDF_RES Fact Commen AcdFCT_COMMON_A{Load Run Identifier Pledged Status ~Loan an DE
31 [CELLMAP Cell Manping RES FSDF RES Fact Comman AcdFCT COMMON AdPurchase Date Purchase date Hie|DE - Loan an E -
| Models | Mappings ® <« »

[

Ready  Recovered
11 PM

3/14/2019

Select a Template in the Template List in Summary screen and click Download to save a copy of
the generated Metadata Report Templates excel sheet, after the export status shows as
completed.
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ORACLE Financial Services Data Governance for US Regulatory Reporting

me >

Search

Summary

Template Id

+add (Fedit [ View @ Delete Exportto Excel Exportto XML Exportto OEMM  Download

[ | Template I1d Template Name Template Description
[ | 208920 report OEMM
[ | 208905 OEMM_DE
[ | 208904 OEMM_Hier
| @ 208503 OEMM_Hierarchy

14.5 View Metadata Report Templates

Perform the following steps to view the Metadata Report Templates:

1. Select a Template in the Template List in Summary screen.

Template Name

Sort By

Status

Completed
completed
Completed
Completed

Us-English +  OFSAD v @

O:no

Q search "DReset Refresh

3
%
&

¥ Search

Created Date

2019-03-14 12:36:34.0
2019-03-14 11:05:39.0
2019-03-14 10:59:39.0
2019-03-14 10:53:48.0

2. Click View icon to view the generated Metadata Report Templates excel report (after the export

status shows as completed).

= ORACL € Financial services Data Governance for US Regulatory Reporting

Home >

US-English  + OFSAD ~

[1:: JES

Q Search "D Reset Refresh

Search
Template Id Template Name
Summary
(# edit | View [0 Delete Exportto Excel Exportto XML Export to OEMM  Download Sort By ¥  Search D v t? "“9‘
[=] Template Id Template Name Template Description Status Created Date Cr
208861 template template Failed/Partially Completed/No Path... 2019-03-09 16:13:02.0 ol
[] | 208860 oemm_report oemm_report Failed/Partially Completed/No Path Fou... 2019-03-09 16:11:36.0 ol
<
Page 1 of1(1-2of2items) k <« > Records Per Page 15
NOTE The Metadata Report Templates excel .

report is opened in view-only mode.

14.6 Modify/Edit Metadata Report Templates

Perform the following steps to edit or modify the Metadata Report Templates:

1. Select a Template in the Template List in Summary screen.

status shows as completed).

2. Click Edit icon to modify the generated Metadata Report Templates excel report (after the export
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= ORACLE Financial Services Data Governance for US Regulatory Reporting @ & [E US-English  + OFSAD v

Home >
Search Q, Search "D Reset Refresh
Template Id Template Name
Summary
(# edit || View [l Delete Exportto Excel Exportto XML Exportto OEMM Download Sort By ¥  Search B A E? “?
[=] Template Id Template Name Template Description Status Created Date Cr
208861 template template Failed/Partially Completed/No Path... 2019-03-09 16:13:02.0 ol
[] | 208860 oemm_report oemm_report Failed/Partially Completed/No Path Fou... 2019-03-09 16:11:36.0 ol
<
Page 1 of1(1-2of2items) gk ¢ > § Records Per Page 15
14.7 Delete Metadata Report Templates
Perform the following steps to delete the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.
2. Click Delete icon to delete the Metadata Report Templates.
= ORACL € Financial services Data Governance for US Regulatory Reporting @ L] Us-English OFSAD =
Home >
Search Q Search "DReset Refresh
Template Id Template Name
Summary
Add ZEdit [ View - Export to Excel ExporttoXML Exportto OEMM  Download Sort By v Search =~ & &
[=] | Template Id Template Name Template Description Status Created Date Cr
208861 template template Failed/Partially Completed/No Path... 2019-03-09 16:13:02.0 ol
[ | 208860 oemm_report oemm_report Failed/Partially Completed/No Path Fou... 2019-03-02 16:11:36.0 ol

<

Page 1 ofi(l-2of2items) gk ¢ » N Records Per Page 15
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15 Appendix A: Setting up the Application and Workflow

Function

This section details the steps involved in configuring an Application and/or its corresponding Workflow
Functions in the Workflow Manager to enable defining the complete workflow for the Application

Workflow function.

This chapter lists the following steps:

Step 1: Application

Step 2: Workflow Function

Step 3: Application Component Mapping

Step 4: Workflow Function Status Mapping

Step 5: Create Workflow Action

Step 6: Associate Workflows to Workflow Functions

Step 7: Conclusion

15.1 Step 1: Application

For the availability of a new application in workflow manager, entries must be made to the

DIM_APP_INFO and DIM_APP_INFO_MLS tables.

TABLE NAME DIM_APP_INFO

SCHEMA NAME | Atomic
DESCRIPTION This table stores basic information regarding the application(s). Like
Application Name, Application Code, and so on.
FIELD NAME DESCRIPTION DATA TYPE SAMPLE MANDATO
VALUE RY
N_APP_KEY A unique number to NUMBER 5 Yes
identify the Application.
V_APP_CODE A unique number to VARCHAR OFS_BANK Yes
identify the Application.
V_APP_NAME Name of the Application. | VARCHAR Banking Yes
Management
V_APP_DESC Brief description about VARCHAR Banking No
the Application. Management
D_RECORD_ST | The application is valid DATE 4/1/2015 Yes
ART_DATE from the start date. 11:00:00AM
D_RECORD_EN | The application is valid DATE 4/1/9999 Yes
D_DATE till the end date. 11:00:00AM
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TABLE NAME DIM_APP_INFO_MLS

SCHEMA Atomic
NAME
DESCRIPTION | This table stores the locale specific entries for the application(s) name.
FIELD NAME DESCRIPTION DATATYPE | SAMPLE MANDATORY
VALUE
N_APP_KEY A unique number to NUMBER 5 Yes
identify the Application.
This key is as specified
in the DIM_APP_INFO
table.
V_APP_NAME | Name of the VARCHAR Banking Yes
Application. Management
DESCLOCALE | Locale (en_US, es ES, | VARCHAR en_US Yes
and so on)

15.2 Step 2: Workflow Function

For the availability of a new workflow function in workflow manager, the entries must be made to the
tables SETUP_COMPONENTS & SETUP_COMPONENTS_MLS.

TABLE NAME SETUP_COMPONENTS

SCHEMA NAME

Atomic

DESCRIPTION This table stores basic information regarding the workflow function(s).
Like Function Name, Function Key, Physical Fact table name, and so on.
FIELD NAME DESCRIPTION DATA SAMPLE MANDATOR
TYPE VALUE Y
N_ENTITY_KEY A unigue number to NUMBE | 200 Yes
identify the Workflow R
Function.
V_ENTITY_NAME | Name of the Workflow VARCH | Credit Banking Yes
Function. AR
V_ENTITY_DESC | Brief description about VARCH | Manage the No
the Workflow Function. AR Credit Banking
facility
V_FCT_TABLENA | The primary FACT table | VARCH | FCT_CREDIT_B | Yes
ME of the Workflow Function | AR ANK
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D_RECORD_STA | The Workflow Function DATE 4/1/2015 Yes
RT_DATE is valid from the start 11:00:00 AM

date.
D_RECORD_END | The Workflow Function DATE 4/1/9999 Yes
_DATE is valid till the end date. 11:00:00 AM

TABLE NAME SETUP_COMPONENTS_MLS

SCHEMA NAME Atomic

DESCRIPTION This table stores the locale specific entries for the workflow function(s)
name.
FIELD NAME DESCRIPTION DATA SAMPLE MANDATOR
TYPE VALUE Y
N_ENTITY_KEY A unique number to NUMBER | 200 Yes
identify the Workflow

Function. This key is as
specified in the
SETUP_COMPONENTS

table.

V_ENTITY_NAME | The name of the VARCHA | Credit Banking | Yes
Workflow Function. R

DESCLOCALE Locale (en_US, es_ES, VARCHA | en_US Yes
and so on) R

15.3 Step 3: Application Component Mapping

To map the new/existing Workflow Function(s) to the new/existing Application, an entry must be made
to the FCT_APP_COMPONENT_MAP table.

TABLE NAME FCT_APP_COMPONENT_MAP

SCHEMA NAME Atomic
DESCRIPTION This table stores the mapping between the application and workflow
function(s).
FIELD NAME DESCRIPTION DATA SAMPLE MANDATORY
TYPE VALUE
N_APP_COMP_KEY | A unique number to NUMBER 1000 Yes
identify the mapping
between Workflow
Function and Application.

OFSAA DOCUMENT TITLE | 196




the Workflow Function.
This key is a specified in
the
SETUP_COMPONENTS
table.

N_APP_KEY Uniqgue key that identifies | NUMBER 5 Yes
the Application. This key
is as specified in the
DIM_APP_INFO table.

N_ENTITY_KEY Unique key that identifies | NUMBER 200 Yes

15.4 Step 4: Workflow Function Status Mapping

To map the component status to the respective workflow function, the following entries must be made to
the table SETUP_COMPONENT_STATUS_MAP.

TABLE NAME SETUP_COMPONENT_STATUS_MAP

SCHEMA NAME

Atomic

DESCRIPTION

This table stores the mapping between workflow functions and their

respective statuses.

FIELD NAME

DESCRIPTION

DATA
TYPE

SAMPLE
VALUE

MANDATORY

N_OR_STATUS_CD

The status of the
component. This key is as
defined in the
DIM_OR_STATUS table.

NUMBER

13

Yes

N_ENTITY_KEY

A unigue key that
identifies the Workflow
Function. This key is
specified in the
SETUP_COMPONENTS
table.

NUMBER

200

Yes

N_SORT_ORDER

The sequence in which
the status needs to be
displayed.

NUMBER

Yes

15.5 Step 5: Create Workflow Action

To enable the creation of a workflow functionality (== Create Workflow ) tor the new Application and
workflow function, the following entries should be made to the following table.

This step is required only when a new application is being included in the workflow manager. It is not necessary to

follow this step if a new workflow function is being added to an existing application.
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TABLE NAME FORMS_VIEW_MAPPING

SCHEMA NAME Configuration

DESCRIPTION This table contains the masking definition for the form control Create
Workflow.

FIELD NAME DESCRIPTION DATA TYPE MANDATORY

FORM_CODE The Name of the Physical File | VARCHAR Yes

that displays the list of
Workflows configured for a
Workflow Function. The form
code is as specified in the
FORMS_MASTER table in
the configuration schema.

FORM_VERSION Identifies if the configuration is | NUMBER Yes
enabled or disabled. (0 —
Enable,
1 - Disable )
DSN_ID The information domain name | VARCHAR Yes
CONTROL_ID The identification number NUMBER Yes

provided to identify a field in
the Ul. This information is
available in the
FORMS_MAP_ITEMS table in
the configuration schema.

VIEW_ID A unique identifier provided NUMBER Yes
for a specific ROLE against a
specific Workflow Function
status.

PARENT_VALUE A computed value that is a NUMBER Yes
product of the Workflow
Function Status and render
mode.

CONTAINER This flag identifies if the above | NUMBER Yes
mentioned CONTROL_ID,
identifies a specific control or
a specific container (0 —
control, 1 — container)

The visibility mode that needs | NUMBER Yes

CONTROL_STATUS | to be applied to the
- control/container.

(1 — Enabled, 2 — Disabled,
3 — Hidden).

The following values must be seeded mandatorily.

FIELD NAME ROW 1 ROW 2 ROW 3 ROW 4
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FORM_CODE FrmWFMaster | FrmWFMaster FrmWFMaster FrmWFMaster
FORM_VERSION 0 0 0 0
DSN_ID OFSINFODOM | OFSINFODOM | OFSINFODOM | OFSINFODOM
CONTROL_ID 2 233 231 3
VIEW_ID 29007 29007 29007 29007
PARENT_VALUE 2005* 2005* 2005* 2005*
CONTAINER 0 0 0 0

1 1 1 1
CONTROL_STATUS

* 2005 is a computed value = (2000 + Application Key)

15.6 Step 6: Associate Workflows to Workflow Functions

To associate the workflows created through Workflow Manager to its appropriate Workflow Function,
make the required following entries.

TABLE NAME WFM_LIST

SCHEMA NAME Atomic

DESCRIPTION This table associates the workflows created through workflow manager to
its respective workflow function.

FIELD NAME DESCRIPTION DATA SAMPLE MANDATOR

TYPE VALUE Y

N_WFM_LIST_ID Unique ldentification NUMBER | 2000 Yes
number to identify the
workflow function within
the Workflow Manager.

V_DSN_ID The Information Domain | VARCHA | OFSINFODOM | Yes
name. R

V_SEGMENT_ID The segment in which VARCHA | OFSSEGMEN | Yes
the solution is installed. R T

N_WFM_FN_ID The Workflow Function NUMBER | 200 Yes
ID as specified in the
SETUP_COMPONENT
S table.

V_WFM_FN_NAM The Name of the VARCHA Credit banking | No

E Workflow Function. R

N_KBD_1 REQD Is Key Business NUMBER |1 Yes
Dimension 1 required?
1-Yes/0-No

N_KBD_2 REQD Is Key Business NUMBER |1 Yes
Dimension 2 required?
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1-Yes/0-No

N_KBD_3_REQD

Is Key Business
Dimension 3 required?

1-Yes/0-No

NUMBER

Yes

N_KBD_4 REQD

Is Key Business
Dimension 4 required?

1-Yes/0-No

NUMBER

Yes

V_KBD_1_LABEL

If KBD 1 is required,
then give the KBD label
name.

(Business Line,
Location, others).

VARCHA
R

Business Line

No

V_KBD_2_LABEL

If KBD 2 is required,
then give the KBD label
name.

(Business Line,
Location, others).

VARCHA
R

Location

No

V_KBD_3 LABEL

If KBD 3 is required,
then give the KBD label
name.

(Business Line,
Location, others).

VARCHA
R

No

V_KBD_4_LABEL

If KBD 4 is required,
then give the KBD label
name.

(Business Line,
Location, others).

VARCHA
R

No

15.7 Step 7: Conclusion

You have successfully completed the setup process to define a workflow for a new application or
workflow function by using the workflow manager.

Log in to the application and started defining the workflow for the new application or workflow function.
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